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1.1

1.1.1

Intended Use and Contraindications

This Philips product is intended to be installed, used and operated only in
accordance with the safety procedures and operating instructions given
in this Instructions for Use for the purpose(s) for which it was designed.
The purpose(s) for which the product is intended is given below.
However, nothing stated in this Instructions for Use reduces users’
responsibilities for sound clinical judgment and best clinical procedure.

Installation, use and operation of this product is subject to the law in the
jurisdiction(s) in which the product is being used. Users must only use
and operate the product in such ways as do not conflict with applicable
laws. or regulations which have the force of law.

Uses of the product for purposes other than those intended and
expressly stated by the manufacturer, as well as incorrect use or
operation, may relieve the manufacturer (or his agent) from all or some
responsibility for resultant non-compliance, damage or injury.

This Philips product should not be used if any of the contraindications
noted in the paragraphs below exist or are thought to exist.

Xper Information Management System Intended Use

The information management system is intended for use under the direct
supervision of a healthcare practitioner for acquiring, displaying,
trending, storing and transmitting various types of data, such as
physiologic/ hemodynamic, clinical, medical image and other related
data. The system is capable of processing/analyzing information, such as
multi-channel ECG signals, and performing other data management
functions, such as creating reports. Data may be acquired from and/or
sent to other devices, such as physiological monitoring systems,
information management systems, image acquisition/storage devices,
and other medical devices.

The system is indicated for use in the following areas: cardiology, cardiac
catheterization, electrophysiology, radiology, invasive radiology, and
surrounding areas where access to the information is needed.

The system consists of modules and may be entirely a software offering
or a hardware/software offering. It is intended for use on standard
computer systems and does not require proprietary hardware. The
solution is available as a single module or combination of modules, or
may function as a standalone system.
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1.2

WARNING

The system is capable of receiving and displaying user-adjustable alarms
(both visual and audible) available in the system, which alert the operator
to anomalous occurrences and facilitate timely responses. Use of the
system is not intended where unattended patient monitoring is desired,
or in situations where arrhythmia detection is required.

The system provides the ability to transmit patient data files for storage,
viewing and analysis at distributed locations via the intranet or internet,
or may function as a stand-alone device.

Compatibility

The products described in this manual should not be used in combination
with other products or components unless such other products or
components are expressly recognized as compatible by Philips
Healthcare. A list of such products and components is available from the
manufacturer.

Do not use the product for any purpose other than those for which it is
intended. Do not use the product with any product other than that which
Philips Healthcare recognizes as compatible. Operation of the product for
unintended purposes, or with an incompatible product, could lead to
fatal or other serious injury, to clinical misdiagnosis, or to clinical
mistreatment.

Changes and/or additions to the product should only be carried out by
Philips Healthcare or by third parties expressly authorized by Philips
Healthcare to do so. Such changes and/or additions must comply with all
applicable laws and regulations that have the force of law within the
jurisdiction(s) concerned, and with best engineering practice.

/N

Changes and/or addjtions to the product that are carried out by persons without the
appropriate training and/or using unapproved spare parts may lead to the PMS
warranty being voided. As with all complex technical products, maintenance by
persons not appropriately qualified and/or using unapproved spare parts carries
serious risks of damage to the product and of personal injury.

Xper Information Management System Release 2-1 1-3



1-4

1.3

1.4

1.5

Device Description

The Xper Information Management System is used for acquiring,
displaying, trending, storing and transmitting various types of data such
as physiologic/hemodynamic, clinical, medical image and other related
data. Its users, responsible to interpret the data provided, will be
professional health care providers, such as physicians, registered nurses,
cardiovascular technicians, radiology technicians, and other clinical
health care providers. The system is capable of processing/analyzing
information such as multi-channel ECG signals, displaying a graphical ST
segment map and performing other data management functions such as
creating reports. Data may be acquired from and/or sent to other devices
such as physiological monitoring systems, information management
systems, image acquisition/storage devices and other medical devices.

The Xper Information Management System also provides optional
ancillary functions, such as scheduling, inventory control, patient billing,
statistical reporting, and other non-clinical modules. Users of the
ancillary functions may be health care providers, but may also be non-
clinical users authorized by the facility.

Installation

Installation of the Xper Information Management system may be
performed on site by Philips Healthcare Service Technicians, or may be
performed by your hospital IT or Biomed department. If you have
received an Xper Information Management installation CD, follow the
instructions provided on the CD for installing the application on your
workstation, or contact Customer Support for assistance.

About These Instructions for Use

These Instructions for Use are intended to assist users in the safe and
effective operation of the products described. Unless otherwise noted in
the documentation, the information herein is valid for the Xper
Information Management system.

Before attempting to operate the product, you must read these
Instructions for Use, noting and strictly observing all WARNINGS and
CAUTION notices.

Pay special attention to all the information given and procedures
described in the SAFETY section.
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1.6

1.7

1.8

A WARNING alerts you to a potential serious outcome, adverse event, or
safety hazard. Failure to observe a warning may result in death or serious
injury to the user or patient.

A CAUTION alerts you to where special care is necessary for the safe and
effective use of the product. Failure to observe a caution may result in
minor or moderate personal injury or damage to the product or other
property, and possibly in a remote risk of more serious injury, and/or
cause environmental pollution.

Notes highlight unusual points as an aid to a user.

These Instructions for Use describe the most extensive configuration of
the product, with the maximum number of options and accessories. Not
every function described may be available on your product.

Printer Compatibility

The Xper Information Management system is compatible with qualified
industry standards HP Laserjet printers and drivers.

Other Manuals

If additional equipment is used with this system (e.g., laser jet printer,
document scanner, etc.), each will have its own manual.

General System Overview

The Xper Information Management system consists of Xper Information
Management software installed on a computer workstation with a flat
panel monitor. Based on the specific configuration, the system could
include an additional flat panel monitor, a printer, and a battery backup.
Optional equipment includes an Xper Flex Cardio physiomonitoring
system in a procedure room or holding area, a file server, and/or hospital
interface broker. The system could be networked through a hub, switch,
or router to the file server.
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2.1

2.2

Important Safety Directions

Philips Healthcare products are designed to meet stringent safety
standards. However, all medical equipment requires proper installation,
operation and maintenance, particularly with regard to human safety.

It is vital that you read, note, and where applicable, strictly observe all
DANGER notices and safety markings on the Xper Information
Management equipment.

It is vital that you follow strictly all safety directions under the heading
SAFETY, and all WARNINGS and CAUTIONS throughout this manual, to
help ensure the safety of both patients and operators.

You should also note the information given in the ‘Introduction’ section
of this manual.

Only qualified and authorized personnel may operate this equipment. In
this context, ‘qualified’ means those legally permitted to operate this
type of medical equipment in the areas in which the equipment will be
used, and ‘authorized’ means those authorized by the user of the
equipment.

Personnel operating the equipment and personnel in the vicinity of the
equipment must observe all laws and regulations which have the force of
law within the environs concerned. If you are in any doubt regarding the
laws and regulations which apply to the operation of this equipment, do
not use it.

Conventions

The following conventions are used in this manual.

WARNING messages indicate a potentially hazardous situation, which, if
not avoided, COULD result in death or serious injury, or could lead to
clinical misdiagnosis and/or loss or damage of patient-related data.

CAUTION messages indicate a potentially hazardous situation, which, if
not avoided, may result in minor or moderate injury, property damage, or

damage to the environment.

NOTE messages provide additional user information or hints for efficient
use.
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2.3

2.3.1

2.3.2

2.3.3

2.3.4

2.3.5

Warnings, Cautions and Notes

Maintenance and Faults

Do not use the product for any application until you are sure that the
user routine-checks have been satisfactorily completed, and that the
periodic maintenance for the product is up to date. If any part of the
product is known (or suspected) to be defective or wrongly adjusted, DO
NOT USE this product until a repair has been made. Operation of the
product with defective or wrongly adjusted components could expose
the user or patient to safety hazards. This could lead to fatal or other
serious injury, to clinical misdiagnosis, or to clinical mistreatment.

Safety Awareness

Do not use the product for any application until you have read,
understood and know all the safety information, safely procedures and
emergency procedures contained in this SAFETY section. Operation of the
product without a proper awareness of how to use it safely could lead to
fatal or other serious personal injury. It could also lead to clinical
misdiagnosis or clinical mistreatment.

Adequate Training

Do not use the product for any application until you have received
adequate and proper training in its safe and effective operation. If you
are unsure of your ability to operate this product safely and effectively,
DO NOT USE IT. Operation of this product without proper and adequate
training could lead to fatal or other serious injury, to clinical misdiagnosis,
or to clinical mistreatment.

Do not operate the product with patients unless you have an adequate
understanding of its capabilities and functions. Using this product
without such an understanding may compromise its effectiveness and/or
reduce the safety of the patient, user and others.

Safety Devices

Never attempt to remove, modify or override or frustrate any safety
device on the product. Interfering with safety devices could lead to fatal
or other serious personal injury.

Symbols and Messages

The following safety symbols and messages may appear in your manual
or on the equipment labels. Please read and obey them carefully:
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Symbol

AV AV AV AV

Rx ONLY

¢

EC

REP

Definition
Indicate voltage range and number of phases,
respectively

Indicate type of current and frequency,
respectively

Indicates power supply

Indicates a functional earth (ground) terminal

Indicates the following, in the order shown:
- Protective earth (ground) terminal
- Functional earth (ground) terminal

Intended to alert the user to the presence of
uninsulated ‘dangerous voltage’ within the
product’s enclosure that poses the risk of
electrical shock

Indicates that U.S. Federal law restricts this
device to sale by or on the order of a licensed
healthcare practitioner

Indicates conformity to European Medical
Device Directive 93/42/EEC

Indicates an authorized representative in the
European Community
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Symbol

Xper Information Management System Release 2-1

Device

SN

CPU

7

Definition
Indicates that the equipment is not to be
disposed of as unsorted municipal waste

Indicates a device or connection that is
sensitive to electrostatic discharge (ESD)

Indicates device type

Indicates the device serial number

Indicates a CPU device

Indicates a reset switch or button

Indicates the manufacturer’s name and address

Indicates the date of manufacture of a device,
The date format is year of manufacture,
followed by month of manufacture (YYYY-MM)

Indicates a computer mouse or connection
port for a mouse
Indicates a computer keyboard or connection

port for a keyboard

2-5
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Symbol

|OIOI

-

>

(i &

Definition

Indicates an RS232 (serial) connection port

Indicates a printer connection port.

Indicates a USB connection port

Indicates a line-in connection port

Indicates a microphone connection port

Indicate an audio out or line-out connection
port

Indicate a video connection port

Indicates a network connection port

Indicates that the user should consult the
product Instructions for Use

Xper Information Management System Release 2-1
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2.4

2.41

WARNING

Symbol Definition

Indicates an operator alert to special
instructions, cautions or warnings given in the
Instructions for Use

Specific Safety Information

Electrical Safety

/N

Do not remove covers or cables from this product unless expressly instructed to do
so in this Instructions for Use. Dangerous electrical voltages are present within this
product. Removing covers or cables could lead to serious or fatal personal injury.

Covers or cables should normally only be removed by qualified and
authorized service personnel. Use this product in rooms or areas that
comply with all applicable law or regulations having the force of law
concerning electrical safety for this type of product.

Electrically isolate this product from the mains electrical supply before
cleaning.

An equipotential ground (earth) connection point is provided. Use this
product in areas meeting local standards for electrical safety in rooms
used for medical purposes.

An additional equipotential ground (earth) connection point is provided
because the product is transportable, and the reliability of the main
equipotential ground connection point might be insufficient.

Do not come in contact with any patient when removing covers,
connectors, etc., during the performance of tasks such as routine
maintenance and calibration. When disconnecting devices from power
lines, remove the plug from the wall outlet first, and then disconnect the
cable from the device. Do not disable the power cord grounding feature.
This device is designed for connection to a grounded (earth) power
outlet. Failure to comply may result in electric shock or device
malfunction.
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2.4.2

CAUTION

2.4.3

Electrostatic Discharge (ESD)

/N

Always wait at least ten (10) seconds after the product is switched OFF before
switching the product back to ON.

Always use proper static procedures, protection and product prior to opening and
auring handling of this product. This product contains components that are
electrostatic-sensitive. Failure to use ESD procedures may cause damage to these
components. Such damage to components is not covered by Philips warranties.

Do not touch non-medical system parts (e.g., printer; keyboard, etc.) and the patient
at the same time. Failure to comply may result in injury.

Electrostatic discharge (ESD) can amount to a significant voltage, which
may cause damage to PCBs or other system components. ESD damage is
cumulative and may not be apparent at first, as indicated by a hard
failure, but can cause degraded performance. Therefore, always use
proper ESD handling procedures. ESD can result from low humidity
conditions, use of electrical equipment on carpeting, linens and clothing.

The equipment may show temporary degradation during discharges.
Within 10 seconds, it will resume normal operation with no loss of
operator settings or recorded data, and shall continue to perform its
intended functions as described in this Instructions for Use.

Electromagnetic Compatibility

This Philips product complies with relevant international and national law
and standards on EMC (electromagnetic compatibility) for this type of
product when used as intended. Such laws and standards define both the
permissible electromagnetic emission levels from product and its
required immunity to electromagnetic interference from external
sources.

Other electronic products exceeding the limits defined in such EMC
standards could, under unusual circumstances, affect the operation of
this product.

» Medical electrical products need special precautions regarding EMC,
and need to be installed and put into service according to EMC
information provided in the accompanying documents.

* The use of accessories and cables other than those specified may
result in increased emission or decreased immunity levels.
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2.4.4

CAUTION

2.4.5

2.4.6

2.4.7

WARNING

* The product should not be used adjacent to or stacked with other
products. If adjacent location or stacked use is necessary, it should be
observed to verify normal operation.

Portable and Mobile Phones

A\

Portable and mobile RF (radio frequency) communications can affect
medical electrical equipment. Use caution when using such
communication devices within the specified range of medical electrical
devices.

Location of Printer

Printers are not considered medical devices and should always be located
outside the patient environment. Additionally, any printer attached via
USB to an Xper Flex Cardio PCC must be connected to an isolation
transformer.

Xper Information Management Workstation

If the Xper Information Management workstation is to be used within the
patient environment (see image above), it must be properly electrically
isolated.

Mechanical Safety

A\

Do not remove covers from this product unless expressly instructed to do so in this
Instructions for Use. Removing covers could lead to serious or fatal personal injury.

Covers should only be removed by qualified and authorized service
personnel. In this context, “qualified” means those legally permitted to
work on this type of medical electrical product in the jurisdiction(s) in
which the product is being used, and “authorized” means those
authorized by the user of the product.
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2.4.8

WARNING

2.4.9

WARNING

2.4.10

EYE CAUTION

Explosion Safety

/N

Do not use this product in the presence of explosive gases or vapors, such as certain
anesthetic gases. Do not use flammable or potentially explosive disinfecting sprays.
Use of this product in an environment for which it is not designed can lead to fire or
explosion.

Fire Safety

Use of an electrical product in an environment for which it was not
designed can lead to fire or explosion. This equipment is not suitable for
use in the presence of a flammable anesthetic mixture with air, with
oxygen or with nitrous oxide. Failure to comply may result in fire, burn
injury, and smoke inhalation injury.

Fire regulations for the type of medical area being used should be fully
applied, observed and enforced. Fire extinguishers should be available for
both electrical and non-electrical fires.

/N

Only use extinguishers on electrical or chemical fires, which are specifically labelled
for those purposes. Using water or other liquids on an electrical fire can lead to fatal
or other personal injury.

If it is safe to do so, attempt to isolate the product from electrical and
other supplies before attempting to fight a fire. This will reduce the risk of
electric shocks.

Eye Protection

A\

Light emitting diode. Do not look into fiber optic cable. Failure to comply may result
in eye injury.

Xper Information Management System Release 2-1

Philips Healthcare 453564527351



Philips Healthcare 453564527351

2.4.11

2.4.12

2.4.13

WARNING!!!

2.4.14

Parts and Accessories

To ensure patient safety, use and/or connect only cables, parts and
accessories specified by Philips Healthcare as part of the Xper
Information Management/Xper Flex Cardio physiomonitoring system and
supplied by or recommended by Philips Healthcare. The use and/or
connection of parts and accessories not specified by Philips Healthcare as
part of the Xper Information Management system and not meeting
Philips Healthcare requirements/specifications may negatively impact
system safety.

Operating Instructions

The Xper Information Management system utilizes components,
including but not limited to monitors, printers, UPS/line conditioners,
etc., whose operation may not be fully described within this User’s Guide.
Complete operating instructions for these components are contained in
the documentation offered by their manufacturer, such documentation
being provided to you at the time each Xper Information Management
system was installed.

Data Accuracy Responsibility

A\

Entering data into the wrong screen may result in erroneous displays.

The Xper Information Management system is comprised of multiple data
entry and system action screens. Many screens support multiple data
input methods via mouse, keyboard and/or bar-code reader. Individual
keyboard keys often support different system functions in different
screens. So as to assure that desired and appropriate system functions
are carried out, operators are responsible to be aware of which system
screen is active before performing keyboard data entry. Likewise, patient
diagnosis should not be based solely on results provided by Xper
Information Management or Flex Cardio. Corroboration of results from a
variety of procedures should be utilized.

Wall Mounts

When a wall mount is used to install/mount a front end or Patient Care
Console, it should be noted that the CPU mount (part of the wall mount)
should be installed at or below the patient cart/bed level. It is also
important to ensure that cables are removed from the patient and moved
away from the cart/bed prior to moving the cart/bed. Failure to follow
this recommendation could result in patient or user injury.
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2.4.16

Computer Virus Protection

The Xper Information Management systems are computer-based medical
products and are therefore subject to attack by computer viruses. The
threat of a computer virus is ever expanding as new viruses are
introduced almost daily. The software required to prevent attack by a
computer virus must therefore be constantly monitored and updated.
McAfee VirusScan Enterprise antivirus software is installed on all Xper
Information Management workstations. After installation, it is the
responsibility of your biomedical department or hospital information
systems staff to update virus definitions regularly and provide upgrades.

Off the Shelf Software

Xper Information Management products may utilize the following off-
the-shelf software products on local computer workstations and file
servers:

» Microsoft” SQL Server® 2005

» Microsoft® SQL Server® 2008

» Microsoft” Windows® XP Professional operating system

* Microsoft” Windows® XP Embedded operating system

» Microsoft” Windows® 2003 Server

* Microsoft” Windows® 2008 Server

* Symantec pcAnyWhere™

* VMware, Inc. VMWare Workstation

¢ VMware ESXi

* McAfee VirusScan Enterprise

These tested and approved third party software products or off-the-shelf
software products are installed and configured by factory trained
technicians on all computers provided by Philips Healthcare. Each
software product is installed and configured using the “typical”
installation method as specified by its manufacturer. Configuration and
setup of these off-the-shelf software products should not be altered

except to install periodic software patches as provided by their
manufacturer.
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2.4.17

2.4.18

With the exception of the above mentioned off-the-shelf products and
third party software products that have been explicitly tested and
validated by Philips Healthcare, Xper Information Management products
have not been tested for proper and safe operation in combination with
any other off-the-shelf software products. Do not load any off-the-shelf
software onto the hard drive. Loading any unauthorized off-the-shelf
software products onto the hard drive may affect the safety and
efficiency of the device, may lead to increased risk to users and patients,
and will void any or all warranties and maintenance plans.

Licensed copies of all off-the-shelf software products used with the Xper
Information Management system are provided to the end user during
shipping and installation. It is the end user’s responsibility to maintain
and protect this licensed software in a safe location.

Customers may provide their own personal computer hardware for Xper
Information Management products that do not have direct patient
contact, such as control room workstations, review stations and file
servers. This hardware must meet or exceed Philips Healthcare’s
minimum published specifications. Off-the-shelf software should be
installed and configured using the manufacturer’s “typical” installation

method.

Perchlorate Material

In compliance with California’s Best Management Practices for
Perchlorate Materials (California Code of Regulations, title 22, division
4.5, chapter 33, article 1), the following warning applies to Xper
Information Management:

Perchlorate Material - special handling may apply. See www.dtsc.ca.gov/
hazardouswaste/perchlorate.

Mercury-Added Product

This product consists of devices which contain mercury, which must be
recycled or disposed of in accordance with local, state or federal laws in
the United States. (Within this system, the backlight lamps in the monitor
display contain mercury.)

Xper Information Management System Release 2-1 2-13



2-14

2.5

Network Safety, Security and Privacy

Customer Role in the Product Security Partnership

We recognize that the security of Philips Healthcare products is an
important part of your facility’s security-indepth strategy. However, these
benefits can only be realized if you implement a comprehensive,
multilayered strategy (including policies, processes and technologies) to
protect information and systems from external and internal threats.

Following industry-standard practice, your strategy should address
physical security, operational security, procedural security, risk
management, security policies, and contingency planning. The practical
implementation of technical security elements varies by site and may
employ a number of technologies, including firewalls, virus-scanning
software, authentication technologies, etc.

As with any computer-based system, protection must be provided such
that firewalls and/or other security devices are in place between the
medical system and any externally accessible systems.

The USA Veterans Administration has developed a widely used Medical
Device Isolation Architecture for this purpose. Such perimeter and
network defenses are essential elements in a comprehensive medical
device security strategy.

For our product security policy statement and additional information, see
the Philips Healthcare product security website at:

http//'www.medical. philips.com/main/productsecurity/
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3.1

3.1.1

3.1.2

Admitting Patients

Admitting a Patient Manually

To admit a patient, click ADMIT > MANUAL. This will open a new Case
Details screen, where you can begin filling in the patient’s demographic,
procedure and lab data. Required fields are Last Name, First Name, and
Medical Record Number. When you are ready to begin recording
hemodynamic data, click START CASE.

The Case Details Screen

The Case Details screen contains a patient’s demographic data,
information about the staff and procedural data, and lab values. The data
may be entered manually, or the fields may be completed by the ADT
interface admission process. You may also build data scrapers to
complete some fields. The specific fields and their functions are listed in
the following table:

Case Information

Field Description

Case Number A system-generated index number

Accession Number A unique procedure identifier

Patient ID Optional ID number for internal departmental use

Procedure(s) The list of procedures performed during a study

Height (cm) Patient’s height in centimeters

Weight (Kg) Patient’s weight in kilograms

Height (In.) Patient’s height in inches

Weight (Lb.) Patient’s weight in pounds

Age Patient’s current age

BSA Patient’s body surface area in meters squared

Admit Date Date of patient’s admission or registration to the
facility

Procedure Date Date procedure was performed

Room Procedure room

Finalized Date Date the study was finalized

Patient In Time the patient arrived in the procedure room

Setup Done Time the patient was ready to undergo a
procedure

Phys Paged Time the attending physician was paged.

Phys Arrived Time the attending physician arrived in the lab

Xper Information Management System Release 2-1

Philips Healthcare 453564527351



Field

Description

Begin Time Time the procedure began

End Time Time the procedure ended

Patient Out Time the patient left the procedure room

Case Read Indicates the study has been read by a physician or
fellow

Legacy Case Indicates the study was imported from an existing

Case Finalized

On Waiting List

Patient Demographics

Calysto database
Indicates the study has been finalized

Checked when a pre-admitted case is opened.

Field Description

Last Name Patient’s last or surname

First Name Patient’s first name

Mi Patient’s middle initial

Suffix Indicates whether patient is a Jr, lll, IV, etc.
Legacy Name Name imported from an existing Calysto database
Address 1 Address field

Address 2 Additional address data

City City in which the patient lives

State State in which the patient lives

Zip Code Zip or postal code

Country Country in which the patient lives

Medical Record Number  Patient medical record number

Social Security Number Patient’s social security number

Date of Birth Patient’s date of birth
Account Number Patient’s account number
Gender Patient’s gender

Race Patient’s race

Phone 1 Patient’s phone number
Phone 2 Additional contact number
Insurance Name Patient’s insurance

Insurance Group Number Patient’s insurance group number

Ins Subscriber ID Patient’s insurance ID number
Allergies Patient’s allergies
EMPI Enterprise Master Patient Index (US only)

Philips Healthcare 453564527351
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Field Description

Resources List of staff, physicians, fellows and referring
physicians associated with the procedure

Adding Resources and Procedures

To add resources to a procedure, click ADD above the Resources list to
open the list of staff. You may sort the list alphabetically or by staff role
(e.g., Circulate, Physician, Scrub, etc.). If a resource in the list has a +
symbol beside the name, you can click the + to display a list of sub-
specialities for that resource (e.g., Diagnostic Physician, Interventionalist,
CRNA, etc.). If you check SHOW WITH ACCESS, the list will be filtered to
display only users who have access to the repository in which you’ve
admitted the case.

To add procedures, click ADD above the Procedures grid and double-click
on the procedures you want to add. You may sort the list alphabetically.

To delete resources or procedures, highlight the entry in the list and click
DELETE. To change the order of resources or procedures, highlight the
entry and use the UP or DOWN arrows to change the order.

Resource Specialities

Resources may have one or more speciality associated (e.g., Diagnostic
Physician, Interventional Physician, Holding Area Nurse, etc.). To assign a
resource with a speciality, expand the list next to the resource you want
to add by clicking on the + symbol, then double click the speciality you
want to assign (see section 4.19.9 ‘Resource Types’).

Assigning procedures to multiple physicians

If you have assigned more than one physician to a case, any procedures
you assign will be automatically attributed to the first physician. To
attribute a procedure to a different physician, click on the physician name
next to the procedure to highlight, then click on the end of the field to
the right of the physician name. This will open a drop-down list
containing all the physicians assigned to the case (there will be a short
delay before the drop-down list appears). You may then select a different
physician to assign to the procedure.

Labs/Procedure Data

The Labs/Procedure Data screen contains lab results for the patient and
procedure information such as contrast used and fluoro time. Lab values
are expressed in standard US units and, where appropriate, in
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international standard units. If values are entered in either field (US or

international), Xper will convert the data and automatically populate the
corresponding fields. For example, if you enter a value in HGB (g/dl), Xper

will automatically calculate and populate the HGB (g/I) field with the
correct value.

The data may be entered manually, or the fields may be completed by the

ADT interface process. You may also build data scrapers to complete

some fields (see section 4.2 ‘Data Scrapers’). The specific fields and their
functions are listed in the following table:

Lab Values

Field

HGB (g/dl)
HGB Date
PTT

PTT Date
HCT

HCT Date
GLU

GLU Date
WBC
WBC Date
K+

K+ Date
PLT

PLT Date
NA+

NA+ Date
PT

PT Date
BUN

BUN Date
INR

INR Date
CREAT
CREAT Date
HGB (g/l)
HGB (mmol/l)

Xper Information Management System Release 2-1

Description

Hemoglobin (standard US units)

Date of HGB lab result

Partial Thromboplastin Time (standard US units)
Date of PTT lab result

Hematocrit (standard US units)

Date of HCT Ilab result

Glucose (standard US units)

Date of GLU lab result

White Blood Cells (standard US units)
Date of WBC lab result

Potassium (standard US units)

Date of K+ lab result

Platelets (standard US units)

Date of PLT lab result

Sodium (standard US units)

Date of NA+ lab result

Prothrombin Time (standard US units)
Date of PT lab result

Blood Urea Nitrogen (standard US units)
Date of BUN lab result

International Normalized Ratio (standard US units)

Date of INR lab result

Creatinine (standard US units)

Date of CREAT lab result

Hemoglobin (international standard units)

Hemoglobin (international standard units)
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Field

HCT (8I)

GLU (mmol/l)
K+ (mmol/l)
NA+ (mmol/l)
BUN (mmol/l)
CREAT (umol/l)

Procedure Data

Field
Contrast Type 1
Contrast Type 2

Contrast Total Max

Contrast Limit

Used #1 (ml)
Used #2 (ml)
Total (ml)

Creat Clearance (ml/min)

Creat Clearance (ml/s)

Fluoro (min)
Fluoro Dose (Gycm?2)
Patient Class

Description

Hematocrit (international standard units)

Glucose (international standard units)

Potassium (international standard units)

Sodium (international standard units)

Blood Urea Nitrogen (international standard units)

Creatinine (international standard units)

Description

First type of contrast used during procedure
Second type of contrast used during procedure
(optional)

Total maximum contrast that may be administered
to the patient

Manufacturer’s suggested contrast limit per kg of
body weight

Total amount of first contrast used
Total amount of second contrast used
Total of Used #1 and Used #2

Indicator of patient’s kidney function (standard US
units)

Indicator of patient’s kidney function (international
standard units)

Fluoro time
Fluoro dose

Indicates whether a patient’s status is Inpatient or
Outpatient

The Status tab is used to send messages to the Whiteboard. For more
information, see section 3.1.9 ‘Whiteboard Viewer’.

The History tab contains a list of all of a patient’s previous Xper
Information Management studies. From the History tab, you can double-
click to open a previous study in read-only mode. When you close the
historical case, the current case will still be open. For information on
establishing historical links, see section 4.24 ‘Patient Historical Links’
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The Links section of the History screen will display links to a patient’s
previous ECG studies when you have an interface with Philips
Tracemaster system. For more information, see section 3.9 ‘Philips
TraceMaster Interface’.

The Documents tab contains a list of signed transcription documents and
case reports that were created during the study. Any scanned documents
saved as a PDF will also be included. You can print a single document
from this screen, or you can select multiple documents to be printed. To
print a single document, click on the document to highlight and then click
PRINT DOCS. Holding down the CRTL key while clicking will allow you to
select documents throughout the list. To select a range of documents,
click on the first document in the range, hold down SHIFT and CTRL, and
click on the last document in the desired range, then click PRINT DOCS.

The Additional Data tab contains several fields in which users can enter
information. The fields and their definitions are listed below:

Field Description

FFR Allows a user to enter a Fractional Flow Reserve
value.
Elapsed Time Displays the amount of time elapsed between Start

and End times of a procedure.

Completion (days) The number of days elapsed between the date on
which a case was added to the Waiting List and the
date on which the procedure was performed.

Date Signed The date on which the most recent electronic
signature was applied to a transcription document.

Signed By The person who last applied an electronic
signature to a transcription document.

Health Insurance Allows user to select an insurance provider, which
will generate patient charges based on information
entered in the Procedures table and in Inventory
for that provider. For more information, see
section 4.21 ‘Insurance Providers'.

Referred for Surgery Can be checked by a user to indicate that the
patient was referred for open heart surgery.

Date Referred Enter the date on which a patient was referred for
open heart surgery.

The MPPS tab displays information from a Multiple Performed Procedure
Steps (MPPS) interface with your DICOM x-ray system, if available. MPPS
requires an Xper Connect interface. For information on configuring MPPS,
see section 4.25 ‘Multiple Performed Procedure Steps (MPPS)’.
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NOTE

3.1.3

3.1.4

If MPPS data has been transferred during a study, you can import the
data into a charting menu. This will enable the data to be scraped to
other fields or to transcription reports. To import the data into a charting
menu, click TRANSFER TO MENU. You may then scrape or query the data
as you would any other menu.

Data can be transferred to a charting menu one time only. Do not perform this
operation until you are sure the data is complete.

Admitting a Patient through an ADT interface

If you have a Connect interface to your facility’s ADT system, you can
admit patients through this interface. To admit a patient using the
interface:

1.  Click ADMIT > ADT. This will open the Search Patient Admissions
screen. You have the option to search for patients based on MRN
(medical record number), SSN (social security number), Account
Number, Accession Number, Last Name, or DOB (date of birth).

2. Select the search method, then enter the data to search for in the
Input Patient Identifier field.

3.  Click SEARCH to begin searching through the current hospital
admissions for your patient. The application will return a list of
matching patients.

4.  Highlight the patient and click ADMIT, which will open a Case Details
screen that will contain as much information as is available from the
ADT interface. You may then complete the remaining fields manually
or by using data scrapers.

5.  Click START CASE to begin recording hemodynamic data.

Admitting a Patient from a DICOM Worklist

If your system is configured for a DICOM Worklist, you may admit
patients from this list. To admit a patient from the DICOM Worklist:

1.  Click ADMIT > WORKLIST ADMIT. This will open the Worklist
Manager screen. You have the option to search for patients based on
name, patient ID, accession number, scheduled station, station AE
title, modality, or start and end date.

2. Enter the data to search for in the appropriate field.

3.  Click QUERY to begin searching the worklist for your patient. The
application will return a list of matching patients.

4.  Double click the patient, which will open a Case Details screen that
will contain as much information as is available from the worklist.
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3.1.5

3.1.6

NOTE

3.1.7

You may then complete the remaining fields manually or by using
data scrapers.

5.  Click START CASE to begin recording hemodynamic data.

Admitting a Patient from the Study Scheduler
You may admit patients from the Study Scheduler. To do so:
1.  Find the patient’s study on the schedule.

2. Right click the study.

3. Select ADMIT to open a Case Details screen that will contain as
much information as is available from the scheduled event (name,
medical record number, procedures, and staff). You may then
complete the remaining fields manually or by using data scrapers.

Admitting from Allura

To admit a patient to the Xper Information Management system from an
Allura X-ray system, you must first create the study on the Allura system.
After entering the patient data on the Allura system, click ADMIT >
ADMIT FROM ALLURA on the Xper Information Management
workstation. A new study will be created with any available data from the
Allura system populating the matching fields.

The Xper Information Management workstation requires configuration in order to
use the Admit from Allura function. For assistance in configuring your workstation,
contact Customer Support

Pre-admission to Waiting List

You can manually pre-admit patients to a Waiting List, or you can pre-
admit patients through your ADT interface. Patients who have been pre-
admitted can be placed on the schedule, or can be admitted directly from
the Waiting List when they arrive for their procedures.

To pre-admit a patient manually,

1.  Click ADMIT > PRE-ADMIT > MANUAL PRE-ADMIT.

2. Ablank Case Details screen will open. Enter any demographic and
lab data (minimum required is first and last names and medical
record number).

3. If known, enter the scheduled Procedure Date.
4. Click PRE-ADMIT CASE.
5. Click CANCEL to abort the operation.

To pre-admit a patient from the ADT interface:
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1. Click ADMIT > PRE-ADMIT > PRE-ADMIT ADT. This will open the
Search Patient Admissions screen. You have the option to search for
patients based on MRN (medical record number), SSN (social
security number), Account Number, Accession Number, Last Name,
or DOB (date of birth).

2. Select the search method, then enter the data to search for in the
Input Patient Identifier field.

3.  Click SEARCH to begin searching through the current hospital
admissions for your patient. The application will return a list of
matching patients.

4.  Double click on the patient you want to pre-admit, which will open a
Case Details screen that will contain as much information as is
available from the ADT interface. You may then complete the
remaining fields manually or by using data scrapers.

5.  Click PRE-ADMIT CASE.
6. Click CANCEL to abort the operation.

After pre-admitting, you may chart the patient’s pertinent history, import
historical arterial trees, add the physician and referring physician, the
scheduled procedures, or enter any other data you may have. You cannot
initiate monitoring, record pressures, vitals or full disclosure.

Pre-admitted patients will be available on the Waiting List tab in the
Study Scheduler (see section 4.1 ‘Scheduling’). There is also a Waiting List
pane that can be incorporated into user roles in the Portal Designer (see
section 4.5.1 ‘User-Centric Navigation’).

When the patient arrives for the procedure, you can double click on the
patient in the Waiting List, or right click on the event in the Study
Scheduler and select ADMIT. When the case opens, click START CASE and
proceed normally.

To pre-admit a patient from the Study Scheduler:

1. Click on the Pre-Admit tab.

2.  Enter the desired search criteria and click Search Now.

3. Double click on the historical case you want to use for pre-
admission. A new Case Details screen, populated with available data
from the historical case, will open.
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3.1.8

After pre-admitting, you may chart the patient’s pertinent history, import
historical arterial trees, add the physician and referring physician, the
scheduled procedures, or enter any other data you may have. You cannot
initiate monitoring, record pressures, vitals or full disclosure. If the
historical case contained any post-procedure arterial trees (see section
3.3.5 Arterial Trees’), the trees will automatically be transferred to the
new study and be marked as Pre-Procedure.

After you have entered data, closing the study will place it on the Waiting
List. Click on the Waiting List tab and then click Refresh to update the list
with the new entry.

If your search returns no results, the Manual Pre-Admit and Pre-Admit
from ADT buttons will become active, allowing you to pre-admit your
study using one of those methods.

Readmit

New studies may be created for patients who were previously admitted
into Xper Information Management by using the Study Readmit function.
This function is most frequently used to create a new interventional study
for a current patient who has undergone a diagnostic procedure, but
whose intervention will be performed by a different physician, but any
study may be readmitted. To readmit a patient:

1. Click HEMODYNAMICS > CASE TOOLS > STUDY READMIT.

2. You will be prompted to close the current case and readmit for a
new procedure.

3. Check INCLUDE LABS and/or INCLUDE STAFF if you want the lab
results and staff from the currently opened case to populate the
new case.

4. If you want to admit the study to the Waiting List (see section 3.1.7
‘Pre-admission to Waiting List’), check PRE-ADMIT.

5.  Click OK to continue, or CANCEL to abort the operation.

6. If you click OK, you will be prompted to print a case report. Select a
report configuration and print option, and click OK to continue, or
click CANCEL to skip printing and proceed with the readmit
procedure.

7. The current case will close, and a new study will open. If you chose
to include labs or staff, that data will be present in the new study. If
any menus were designated as History (see section 4.12.3 ‘Building
and Editing Menus’) will be populated with the charting done in the
previous study.
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8. If you’'ve chose to admit the study to the Waiting List, you can enter
any additional data and close the study, which will then appear on
the Waiting List.

Whiteboard Viewer

The Whiteboard Viewer is an optional feature that displays a patient’s
location and procedure status (to configure status messages, see section
4.15 ‘Case Status’), and can also display optional messages about a
patient or procedure. To update a patient’s status to the Whiteboard,
click the Status tab on the Case Details screen. The controls and their
functions are listed in the following table.

Control Description

Case Status window Displays all posted status messages and the time
each message was sent to the Whiteboard.

Update Case Status To Allows a user to select a procedure status message
to post to the Whiteboard.

Message Board window Enter message text to post to the Whiteboard
message center.

Whiteboard Allows a user to send a message to a specific
Whiteboard location.

Timestamp Allows a user to edit the time stamp of a message
to be sent to the Whiteboard.

Display for The length of time (in seconds) that a message will
be displayed on the selected Whiteboard.

Send Sends the message to the selected Whiteboard.

Clear Clears the message board window.

The Whiteboard contains four sections: Pre-procedure Holding,
Procedure Room, Post-Procedure Holding, and Message Board. You can
update the status of a patient so that family and Holding Area staff can
keep track of where the patient is. To update the status of a procedure,
double-click a status message from the Update Case Status list. The
patient’s status will be displayed in the appropriate window on the
Whiteboard, and in the Current Status window on the screen. The
available status selections are: Patient In, Patient Ready, Procedure Begin,
Procedure End, Patient Out. You can also build scrapers that will
automatically send status messages to the Whiteboard when certain data
is charted. For more information, see section 4.2 ‘Data Scrapers’.

You may also post a message to the Whiteboard (e.g., asking family
members to report to a conference room, requesting the next patient be
brought to the procedure room, etc.).
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3.2

1. Enter the message you wish displayed in the Message Board
window.

2. Select the appropriate Whiteboard on which you want it to display.
3. Select a length of time for the message to be displayed.

4.  Click SEND.

The message will be displayed on the selected Whiteboard for the length
of time you specified. If you wish, you may change the time/date of the
message before sending. If you do not change the time/date of the
message, clicking SEND will set the stamp to the current time and date.
To clear the message window, click CLEAR.

To remove a patient from the Whiteboard, click REMOVE FROM
WHITEBOARD on the Case Status screen.

Document Scanning

Xper Information Management workstations support the scanning of
external documents (history and physical, reports from previous studies,
etc.) into a patient record in PDF format through a USB document
scanner (recommended model: Hewlett Packard Scanjet N6010). To scan
a document:

1.  Ensure that the scanner is attached and powered on;

2. Open the patient study to which the document will be scanned (if
the study is already opened, skip this step);

3. Check SHOW USER INTERFACE to display the scanner interface
dialog. This allows you to set options such as 2-sided, color, paper
size, etc. If you do not want to set any options, skip this step;

4. Click ACQUIRE to scan the document.

You may then save the document in one of two formats, JPEG or PDF. To
save the document as a PDF:

1. Click PDF;

2. If there are multiple pages to be included, hold CTRL and click on
each page to select;

3. Rename the document (if desired);

4.  Click OK. The document will be available for viewing as a PDF under
the Documents tab.
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3.3

3.3.1

To save the document as a JPEG:
1.  Set the desired compression (100 is no compression);

2. Click SAVE AS. The document will then be available under IMAGING
> STILL FRAMES and may be included in transcription reports.

Scanners must be connected to Xper Information Management workstations only.

Entering Procedural Data

Charting a Procedure

The application allows you to quickly and easily chart a procedure.
Because you can create custom menus in the Menu Builder, you can
ensure accuracy and thoroughness of your patient records. Procedural
charting is integrally connected to transcription and statistical reports, as
well as other modules throughout the application. In addition, entries
and modifications to charting are tracked, so that you can perform audits
in the event discrepancies arise.

Once you have a study open, access the charting module by clicking the
Charting button. This will open the Charting Menus screen.

The Charting Menus screen consists of four sections:

1. The available menus: charting is arranged into menus, or categories,
like History and Assessment, Complications, Findings, etc. The menu
selection you see depends on the modality of the study you're
charting.

2. The menu tree: these are the statements from which you chart your
procedure.

3. History: in this section, the actual charting of a procedure is
displayed. As you chart statements, they appear here, along with
information about who charted the information and whether
modifications or deletions were made, when they were made, and
who made them.

4.  Edit Entry: this window allows you to correct errors in charting, as
well as permitting a user to type notes directly, rather than selecting
from the menu entries.
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Charting in Xper Information Management

To chart, you simply select a menu from the list on the left, then point
and click through the menu tree items on the right. Menu items that have
associated sublevel choices will be indicated by a +. As you click on the
item, the sublevels will expand, allowing you to make your selection.
Once you’ve gone through all the levels, the finished statement will
appear in the History window, along with the time and date the line was
charted and the user who charted it. As you switch menus, the History
window will refresh with items charted in the menu you select.

If you think you might make several entries from the same sub-list, hold
the SHIFT key down and click on the level you want to expand. That level
will then be marked with a padlock icon. It will remain expanded,
allowing you to make additional selections without having to constantly
click on the “parent” level in order to chart. When you want to close the
level, hold the SHIFT key down and click on the padlocked item.

Some menu items have a variable entry tag associated with them. What
this means is that, in order to chart an item, keyboard entry is required.
When you click on a variable entry item, the Variable Item window
opens, prompting the user to enter the required data. Some variable
items may have a unit type associated with them. The unit type for a
specific item will be set when the menu is created, but you can select a
different unit type from the Unit Type drop-down list before clicking OK.
Clicking CANCEL will close the window without charting an entry.

Once you’ve entered the required data, you can click OK to save the data
and move on to the next selection, or hit the ENTER key on the keyboard.
You can use the keyboard to chart if you like, by typing the corresponding
letter next to the item you want to chart (A, B, C, D...).

Inventory items are also a special function in charting. Inventory items
are marked with a special icon. When you click on a particular inventory
item, a window will open containing a list of items belonging to that
inventory category. You can select an item from the list, or you can use
the barcode reader to scan the item into your procedure. You can filter
the list by clicking into a field (e.g., ltem Name) and typing a few
characters.

Inventory items may also be entered by scanning their barcodes. To scan
a single barcode, hit CTRL+B on the keyboard. To scan multiple barcodes,
hit CTRL+D. Both methods will open a window that will allow you to scan
the item barcode into your procedure, but if you hit CTRL+B, the window
will close automatically after scanning. If you hit CTRL+D, the window will
remain open until you click the X to close it.
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In addition, if an item has been marked as Implantable (see section 4.6.2
‘Inventory Maintenance’), upon scanning the item barcode, you will be
prompted to enter the lot number, serial number, and expiration date of
the item. If your item has a separate barcode containing these attributes,
you can scan the attribute barcode, and the information will be
automatically charted, as well.

If the expiration date of the implantable item you’ve charted has expired,
you will receive a prompt to verify the expiration date. You will be
prompted to confirm the date. If the item has expired, click Yes to cancel
the charting. If the item has not expired, or if you want to chart it anyway,
click No.

If an inventory item must be credited to the patient’s account, click the
item, then click CREDIT. The item will be marked as credited, and will not
be billed, but will be decremented from inventory. Similarly, if an item
has been wasted, click the item, then click WASTE. The item will be
marked as wasted and will not be billed, but will be decremented from
inventory.

You can duplicate a charted entry by clicking on the entry, then clicking
RECHART. The line will be charted again into the menu, but with the
current date/time. It will also be marked with a RECHARTED icon.If you
rechart an inventory item, it will be marked REUSED, it will not be
deducted from inventory, and no charge will be generated. It is assumed
that the same item is being reused.

Charting kits allow you to chart multiple items with one click (see section
4.9 ‘Kit Builder’ and section 4.12 ‘Menu Builder’). To chart a kit, simply
click on the kit name in your menu. The items associated with the kit will
be inserted into the procedure record. Any inventory items included in a
kit will be automatically decremented, and if there are charges associated
with them, the patient will be billed. Procedures associated with a kit will
appear on the Case Details screen.

Once entries have been charted, you may find it necessary to make
changes or additions to the text, or you may want to enter a note (free
text) into the procedure log. The Edit Entry section lets you do both.

To edit a previously charted item, simply double click on the line in the
History section, make the necessary changes, and click CONFIRM. The
newly edited line will appear in the History section. The previously
charted item will remain in the History section, but it will be struck
through and marked “Modified.” The edited item will have the same time
and date stamp as the modified item to preserve the procedural flow, but
a notation will appear with the time and date of modification, along with
the user who performed the modification.
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To enter a free text item, click FREETEXT. Click into the Edit Entry window,
type your note, and click the CHART button to enter the note into the
procedure log. Free text entries will be marked with a AFreeText” tag at
the end of the line.

The Given By marker enables you to mark any line with the name of a
staff person or physician who participated in the procedure. Its intended
use is for medication administration, but you can mark any charted item
with the Given By tag. It is important to remember that only staff and
physicians who appear on the Case Details screen will be available in the
drop-down list, so if you do not see the person whose name you are
searching for, you will have to add it in the Resources list.

You may hide deleted and modified entries in the charting history by
checking the “Hide Deleted Entries” or “Hide Modified Entries.”

Charting in the Patient Care Console

The Patient Care Console is a single display system, which means that
physiomonitoring and procedural charting are displayed side by side on
the same monitor. When you click on a menu, you will see the same tree
view and chart and edit the procedure just as you would on a
Physiomonitoring 5 system.

Lesion Markers

Lesion markers (L1 - L9) are indicators that flag a charted entry for use by
scrapers to transfer data from charting to the ACC and ICD data collection
screens, or to a transcription report. You may manually mark any charted
entry by right clicking on the entry and selecting the desired lesion
number from the marker list. The marker will appear in French brackets
at the end of the charted item (e.g., {L1}, {L2}, etc.).

You may apply multiple lesion markers to a charted entry, or remove a
marker from an entry in the same way. To add additional markers, right
click the entry, then select the additional marker to be added. To remove
a marker, right click the entry and select the marker you want to remove.

You may also activate a function in any menu called Auto Lesion
Numbering, which will automatically attach a lesion marker automatically
to each entry as you chart. To activate Auto Lesion Numbering in any
menu:

1. Click AUTO LESION #.
2. Select the marker you want to use (L1 thru L9).

3. Click OK.
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NOTE

As you chart, each entry in the menu will be marked with the designated
lesion number. If you change to a different menu, lesion marking will
remain in effect. The button label will indicate the selected marker (e.g.,
AUTO LESION {L1}). To disable lesion marking, click the button, select OFF,
and click OK.

Procedure Log

The procedure log is the chronological report of your charted items from
all menus. As you add, modify and delete entries in charting, the log is
automatically updated so that you have a concise report that you can
refer to at any time. To view the procedure log during a study, click
HEMODYNAMICS > PROCEDURE LOG.

The procedure log is the chronological report of your charted items from
all menus. As you add, modify and delete entries in charting, the log is
automatically updated so that you have a concise report that you can
refer to at any time. The Procedure Log can help you move quickly to a
charted item you need to modify or delete. Simply double-click the entry
in the log, and the application will open the menu in which that item was
charted. You can choose to display any recorded vitals in the log by
clicking the Show Vitals check box.

The procedure log can be digitally signed at the end of a procedure. To
sigh a procedure log:

1. Click SIGN.
2. Enter your user name and signature password.

3. Click OK.

When the procedure log is printed, the name and title of the person
signing will appear at the end of the log, as well as the time and date the
signature was applied.

The procedure log may be sjgned by up to ten (10) users. The digital signature will
appear in the log at the time the signature was applied, and at the end of the printed
report

You have the option to include the Given By and Entered By information
on the Procedure Log printout. For assistance with activating these
features, please contact Customer Support.
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3.3.2

3.3.3

3.3.4

Changing Users During a Procedure

During a procedure, it is possible that the person recording the study may
be relieved by another staff member. To change the logged in user during
a procedure, click on the user name in the lower right corner of the
screen. A Change User window will appear, allowing the next user to
enter a username and password without closing the case. Monitoring,
vitals capture and full disclosure recording continue without interruption.
You may change users during a procedure as often as is necessary.

Locking a Case

A case may be temporarily locked to protect case data integrity, in the
event that a user must step away from the computer. To lock a case, click
on the user name in the lower right corner of the screen and click LOCK.
The case will be locked. No charting or editing may be performed while a
case is locked, although monitoring, vitals capture and full disclosure
recording will continue. To unlock a case, enter your user name and
password and click UNLOCK. You will then be able to proceed normally.
You may also use this process to change users during a procedure, if you
are relieving a fellow staff member.

Hemodynamics Screen

The Hemodynamics screen contains all the invasive pressure and cardiac
output data that is collected during a procedure. The collected data is
used to perform calculations, such as vascular resistance, intracardiac
shunting, and valve stenosis. The calculations are performed
automatically as samples are captured, and is recalculated when you edit
samples using the Waveform Review screen. You will also enter oxygen
saturation data into the Hemodynamics screen.

Hemodynamics screens correspond to monitoring conditions. When you
record an initial pressure sample in a condition on the monitoring screen,
a hemodynamics screen is created to match that condition. Any data
from subsequent samples taken in that condition is recorded on the
corresponding hemodynamics screen.

The hemodynamics screen is divided into several sections to organize the
data:

1. General controls,

2. Ventricular data,

3. Valve data table,

4.  Cardiac outputs,

5.  Oxygen uptake data,

6. Heart diagrams and oxygen saturations,
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7.  Hemodynamic data tables and controls,

8.  Vascular resistance data, and

9. Oxygen content data.

The fields and their functions are specified in the following tables:

Ventricular Data

Field
LV Dias

LV Syst

LV EF%
LV RF%
RV Dias

RV Syst

RV EF%

Description

Left ventricular diastolic volume calculated by image
analysis.

Left ventricular systolic volume calculated by image
analysis.

Left ventricular ejection fraction.
Left ventricular regurgitant fraction.

Right ventricular diastolic volume calculated by image
analysis.

Right ventricular systolic volume calculated by image
analysis.

Right ventricular ejection fraction.

Note: See section 9.1 ‘Hemodynamic and Lab Value Conversion Calculations’
for formulas used in calculations.

Valve Data
Field
Aortic p-p
Aortic mn
Aortic ms
Aortic b/m
Aortic cm2
Aortic ind
Aortic note
Mitral p-p
Mitral mn
Mitral ms
Mitral b/m
Mitral cm2
Mitral ind
Mitral note

Pulmonic p-p

Description

Peak to peak aortic valve gradient.

Mean aortic valve gradient.

Interval in milliseconds that the aortic valve was open.
Heart rate used in calculating aortic valve data.

Aortic valve area (in cm?).

Aortic valve index.

Accepts limited user entry.

Peak to peak mitral valve gradient.

Mean mitral valve gradient.

Interval in milliseconds that the mitral valve was open.
Heart rate used in calculating mitral valve data.

Mitral valve area (in cm?).

Mitral valve index.

Accepts limited user entry.

Peak to peak pulmonic valve gradient.
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NOTE

Valve Data
Field
Pulmonic mn
Pulmonic ms
Pulmonic b/m
Pulmonic cm2
Pulmonic ind
Pulmonic note
Tricuspid p-p
Tricuspid mn
Tricuspid ms
Tricuspid b/m
Tricuspid cm2
Tricuspid ind
Tricuspid note
Other p-p*
Other mn
Other ms
Other b/m
Other cm2
Other ind
Other note

Description

Mean pulmonic valve gradient.

Interval in milliseconds that the pulmonic valve was open.

Heart rate used in calculating pulmonic valve data.
Pulmonic valve area (in cm?).

Pulmonic valve index.

Accepts limited user entry.

Peak to peak tricuspid valve gradient.

Mean tricuspid valve gradient.

Interval in milliseconds that the tricuspid valve was open.

Heart rate used in calculating tricuspid valve data.
Tricuspid valve area (in cm?).

Tricuspid valve index.

Accepts limited user entry.

Peak to peak other gradient.

Mean other gradient.

Interval in milliseconds.

Heart rate used in calculating other gradients.
Other area (in cm?).

Other index.

Accepts limited user entry.

Note: See section 9.1 ‘Hemodynamic and Lab Value Conversion Calculations’
for formulas used in calculations.

“Other” refers to gradients calculated from sites other than valves, such as femoral

compensation. Some fields may not be completed if data is not appropriate.

Cardiac Outputs

Field

Fick SV

Fick CO
Fick Cl
Thermal SV
Thermal CO
Thermal Cl
Angio SV
Angio CO

Xper Information Management System Release 2-1

Description

Stroke volume calculated using the Fick method.
Cardiac output calculated using the Fick method.
Cardiac index calculated using the Fick method.
Stroke volume calculated using thermodilution.
Cardiac output calculated using thermodilution.
Cardiac index calculated using thermodilution.
Stroke volume calculated from angiography.

Cardiac output calculated from angiography.
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Cardiac Outputs

Field Description

Angio CI Cardiac index calculated from angiography.

(blank) Cardiac output calculation method may be entered by the
operator.

sV Stroke volume may be entered by the operator.

co Cardiac output may be entered by the operator.

Cl Cardiac index may be entered by the operator.

Note: See section 9.1 Hemodynamic and Lab Value Conversion Calculations’
for formulas used in calculations.

Oxygen Uptake Data
Field Description

LOAD button Used to load a constant value from the LaFarge table
based on heart rate, age and gender of the patient.

KO2 A constant used to calculate estimated oxygen
consumption. The default value is 133.

BSA Body surface area, populated from the Case Details
screen.

Hgb (g/dl) Hemoglobin, populated from the Labs/Procedure Data
screen.

Hgb (g/) Hemoglobin in standard international units.

Est O2 Estimated oxygen consumption of the patient.

Act O2 Actual oxygen consumption of the patient.

SA-SV (AV) Systemic O, difference (ml/min).

PV-PA (VA) Pulmonary O, difference (ml/min).

PV-SV (W) Venous O, difference (ml/min).

Qs Systemic flow (ml/L).

Qp Pulmonary flow (ml/L).

Qe Effective flow (ml/L).

Qp/Qs Pulmonary/systemic flow ratio.

Qsi Systemic flow index.

Qpi Pulmonary flow index.

Qei Effective flow index.

LR Threshold Operator-defined L>R shunt threshold

RL Threshold Operator-defined R>L shunt threshold

L>R Shunt Left to right shunt flow (L/min).

L>R Shunt % Left to right shunt flow percentage.

R>L Shunt Right to left shunt flow (L/min).
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Oxygen Uptake Data

Field

R>L Shunt %

Description

Right to left shunt flow percentage.

Note: See section 9.1 Hemodynamic and Lab Value Conversion Calculations’
for formulas used in calculations.

Vascular Resistance Data

Field
Use HRU

SAm Site
SAm Mean
SVm Site
SVm Mean
PAm Site
PAm Mean
PVm Site
PVm Mean
TSVR
TSVRI
SVR

SVRI
TPVR
TPVRI
PVR

PVRI
PVR/SVR
TPVR/TSVR

Description

When checked, calculates vascular resistance values in

Woods hybrid resistance units. The default is Dynes units.

Pressure sample used as systemic arterial pressure site.
The mean pressure used as systemic arterial pressure.
Pressure sample used as systemic venous pressure site.

The mean pressure used as systemic venous pressure.

Pressure sample used as pulmonary arterial pressure site.

The mean pressure used as pulmonary arterial pressure.

Pressure sample used as pulmonary venous pressure site.

The mean pressure used as pulmonary venous pressure.
Total systemic vascular resistance

Total systemic vascular resistance index

Systemic vascular resistance

Systemic vascular resistance index

Total pulmonary vascular resistance

Total pulmonary vascular resistance index

Pulmonary vascular resistance

Pulmonary vascular resistance index
Pulmonary/systemic vascular resistance ratio

Total pulmonary/total systemic vascular resistance ratio

Note: See section 9.1 ‘Hemodynamic and Lab Value Conversion Calculations’
for formulas used in calculations.

Oxygen Content Data

Field
SA_O2 Site
SA_O2 Sat

SA_O2 Hgb g/dI
SA_O2 Hgb g/l

SA_02 PO2

Xper Information Management System Release 2-1

Description

Site used for systemic arterial oxygen content calculation.

Systemic arterial saturation value.
Hemoglobin, populated from the Case Details screen.
Hemoglobin in standard international units.

Partial pressure oxygen, entered by the operator
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Oxygen Content Data

Field Description

SA_02 02 Systemic arterial oxygen content.

SV_02 Site Site used for systemic venous oxygen content calculation.
SV_02 Sat Systemic venous saturation value.

SV_02 Hgb g/dI Hemoglobin, populated from the Case Details screen.

SV_0O2 Hgb g/l Hemoglobin in standard international units.

SvV_02 PO2 Partial pressure oxygen, entered by the operator

Sv_02 02 Systemic venous oxygen content.

PA_O2 Site Site used for pulmonary arterial oxygen content
calculation.

PA_O2 Sat Pulmonary arterial saturation value.

PA_O2 Hgb g/d| Hemoglobin, populated from the Case Details screen.

PA_O2 Hgb g/l Hemoglobin in standard international units.

PA_O2 PO2 Partial pressure oxygen, entered by the operator

PA_O2 O2 Pulmonary arterial oxygen content.

PV_02 Site Site used for pulmonary venous oxygen content
calculation.

PV_O2 Sat Pulmonary venous saturation value.

PV_O2 Hgb g/di Hemoglobin, populated from the Case Details screen.

PV_O2 Hgb g/l Hemoglobin in standard international units.

PV_O2 PO2 Partial pressure oxygen, entered by the operator
PV_0O2 O2 Pulmonary venous oxygen content.

Use Flamm'’s for When checked, uses the Flamm formula for systemic
systemic venous venous calculation.

Note: See section 9.1 Hemodynamic and Lab Value Conversion Calculations’
for formulas used in calculations.

The Heart Diagram

In the center of the page is a heart diagram with data boxes located in
each of the major vessels and chambers. There are 68 congenital
anomaly diagrams in addition to the Normal Heart. You can display any
anomaly by selecting it from the drop-down menu immediately above
the heart diagram.

The data boxes display either pressure data (mean/edp) or oxygen
saturations. To control which type of data is displayed, click either the
SATURATION or PRESSURE tab located to the top right of the heart
diagram. Pressure data are automatically populated from samples
obtained during the case.
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Oxygen saturation data must be entered manually. To enter saturation
data, click the box that represents the site from which the sample was
obtained, enter the value with the keyboard and press Enter. You can also
select sites from the drop-down list at the bottom left corner of the heart
diagram. You can save multiple saturation values for each site by typing
them in the (F4) Other Sat boxes located just below the heart diagram.
You can average the values by affixing a number to each site to
differentiate it from the others. For example:

1. Type RAl in the first box, type a value of 50 in the second box, then
press Enter.

2. Do the same for RA2 (value 70) and RA3 (value 75).

3. Notice that each site and value is inserted in the Sample Display
Window as soon as you press the Enter key, and an average value is
calculated and placed at the top of the list.

4. The average value is also inserted in the appropriate site box in the
heart diagram.

You can also identify multiple sites in other ways (e.g., by location). If you
took readings at the upper, middle, and lower portions of the right
atrium, for example, you might identify the readings as high RA (HRA),
mid RA (MRA), and low RA (LRA), As you enter them, the sites and values
are inserted into the Sample Display Window, but they won’t be
averaged. To average your values, you must use numbers. You must select
a value to use for the main saturation value and enter it into the heart
diagram site box.

Blood Gases Worksheet

The blood gases worksheet is used to enter complete blood gas data in
addition to oxygen saturations. Open the worksheet by clicking the Blood
Gases tab at the very bottom left corner of the Hemodynamics screen.
Click in the indicated place to create a new row. Choose the desired site
from the drop-down list, and manually enter the data in the remaining
fields. If desired, you may dock the Blood Gases screen by clicking the
pushpin icon in the upper right corner.

Sample Display Window

This window displays all manually entered oxygen saturation data, and all
data obtained from the patient (pressures, thermal cardiac outputs, valve
gradients, etc.). Only one data parameter is displayed at a time. Toggle
between the data elements by clicking one of the tabs labelled
Saturation, Pressure, Therm, or Grads located above the data window.
Each element is described in detail below.
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NOTE

Definitions for all site abbreviations used with Xper Information Management are

listed in Chapter 12: Appendices.

Oxygen Saturation Data

View data by clicking the tab labelled Saturation.
Saturations are entered manually as described above.
To delete specific saturation values, click DEL, then select the value.

To exclude specific saturation values from calculations click X, then
select the value. A dash will replace site labels with excluded values.

For calculation purposes, Xper Information Management assigns
specific saturation data to represent systemic arterial, systemic
venous, pulmonary arterial, and pulmonary venous values. Algorithms
are in place to ensure that the best match is made for each of the
variables. You can override the assigned selections by clicking SA, SV,
PA, or PV, then clicking on the sample you wish to assign to that
variable.

Invasive Pressure Data

View data by clicking the tab labelled Pressure.

To view the waveforms used to derive pressure data, click the desired
sample. This opens the waveform review screen on a separate tab.

To delete specific pressure samples, click DEL, then select the value.

To exclude specific pressure values from calculations click X, then
select the value. A dash will replace site labels with excluded values.

For calculation purposes, Xper Information Management assigns
specific saturation data to represent systemic arterial, systemic
venous, pulmonary arterial, and pulmonary venous values. Algorithms
are in place to ensure that the best match is made for each of the
variables. You can override the assigned selections by clicking SA, SV,
PA, or PV, then clicking on the sample you wish to assign to that
variable.

Thermal Cardiac Output Data

View data by clicking the tab labelled Therm.

To view the waveforms used to derive thermal cardiac output data,
click the desired sample. This opens the waveform review screen on a
separate tab.

To delete specific thermal cardiac output samples, click DEL, then
select the value.
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Valve Gradient Data

View data by clicking the tab labelled Grad.

To view the waveforms used to derive valve gradient data, click the
desired sample. This opens the waveform review screen on a different
tab.

To delete a specific valve gradient, click the DEL button, then select the
item.

By default, the first gradient of each valve will print on the case report.
To select a different valve gradient for the printed report, click the
VALVE button, then select the gradient. The data will be printed in the
valve gradients section of the Hemodynamic Page.

FFR Data

View data by clicking the tab labelled FFR.

To view the waveforms used to derive FFR data, click the desired
sample. This opens the waveform review screen on a separate tab.

To delete specific FFR samples, click DEL, then select the value.

Sample Display Window Function Controls

With the nine controls located at the top right corner of the
Hemodynamics page, you can select samples in the display window for
various operations. The controls and their functions are listed in the
following table.

Control Description

SA Designates a selected pressure or oxygen saturation as a
Systemic Arterial value to be used in calculations.

N Designates a selected pressure or oxygen saturation as a
Systemic Venous value to be used in calculations.

PA Designates a selected pressure or oxygen saturation as a
Pulmonary Arterial value to be used in calculations.

PV Designates a selected pressure or oxygen saturation as a

Pulmonary Venous value to be used in calculations.

Valve Allows a user to select a valve gradient to be used as the
reported value (default is first calculated).

DEL Deletes a selected hemodynamic value.
™ Allows a user to edit the time stamp of a selected sample.
X Allows a user to select a hemodynamic value to be

excluded from calculations.
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Control Description

T Indicates a hemodynamic value to be included in
transcription (default is first recorded).

Vascular Resistance

The vascular resistance section is located below the sample display
window. It contains resistance values that are automatically populated as
necessary data are entered or sampled during procedures (see section
9.1 ‘Hemodynamic and Lab Value Conversion Calculations’ for calculation
formulas). Site and mean pressure data are displayed for each of the
variables (SA, SV, PA, and PV). For patients whose cardiac output data
(thermal or Fick) are available, total resistance values are displayed in
either Dynes (D/S, D/S/cm-5) or hybrid resistance (Woods) units. Check
the HRU box if you want to use hybrid resistance. Leave it unchecked if
you want to use D/S.

02 Content

The 02 content section is located at the bottom right of the screen. It
contains oxygen-related values that are automatically populated as
necessary data are entered or sampled during procedures (see section
9.1 ‘Hemodynamic and Lab Value Conversion Calculations’ for calculation
formulas). For each of the variables (SA, SV, PA, and PV), the following
information is displayed: site, saturation, hemoglobin, and oxygen
content. PO2 data (from blood gas results) can be entered manually for
each variable. If you'd rather not use the automatically posted data
assigned by CALYSTO Series IV, delete them by clicking X under the
respective item. Click the checkbox at the bottom of the section to
calculate systemic venous from IVC and SVC samples using Flamm’s
equation.

To enter specific values, click the appropriate label across the top (SA, SV,
PA, or PV), and click the desired value.

O2 Uptake, Differences, Flows, and Shunts

This section is located at the lower left portion of the screen. It contains
several variables that are automatically populated as necessary data are
entered or sampled during procedures (see section 9.1 ‘Hemodynamic
and Lab Value Conversion Calculations’ for calculation formulas). The
variables are described below.
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K Variable

K is used to calculate estimated oxygen consumption. 133 is the default
value. Users can override this value manually if desired, or use the
LaFarge table to estimate K factors. This table bases the estimated oxygen
consumption on the gender, age, and heart rate of the patient (see
section 9.1 ‘Hemodynamic and Lab Value Conversion Calculations’ for
calculation formulas). To select a value from the LaFarge table, click LOAD
in the O2 Uptake section of the page and select the value appropriate for
the patient. Specify the 02 consumption field (Act or Est) used for
calculations by clicking the appropriate box at the top right of the section.
If the facility uses an oxygen consumption monitor, you can manually
enter the actual oxygen consumption data into the Act O2 box.

BSA and Hgb Variables

BSA and Hgb are populated from the Case Details and Labs/Procedure
Data screens.

SA-SV, PV-PA, and PV-SV Variables

These variables for 02 difference data are automatically populated (see
section 9.1 ‘Hemodynamic and Lab Value Conversion Calculations’ for
calculation formulas).

Qs, Qsi, Qp, Qpi, Qe, Qei, and Qp/Qs Variables

These variables for flow data are automatically populated (see section 9.1
‘Hemodynamic and Lab Value Conversion Calculations’ for calculation
formulas). The values will differ depending on whether estimated or
actual oxygen consumption data are used, and whether Fick or thermal
cardiac output data are used.

Shunt L>R and R>L Variables

Variables for shunts are automatically calculated only if Fick cardiac
output data are available and a significant oxygen saturation step-up is
present (see section 9.1 ‘Hemodynamic and Lab Value Conversion
Calculations’ for calculation formulas). Shunt type (L>R and R>L) is
defined. Blood flow across the shunt in liters per minute, as well as the
total percentage of cardiac output, is displayed.
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Cardiac Outputs

Located at the lower left-hand side of the screen, this section contains
cardiac output values that are automatically populated as necessary data
are entered or sampled during procedures (see section 9.1
‘Hemodynamic and Lab Value Conversion Calculations’ for calculation
formulas). For each of the variables (Fick, Thermal, Angiographic, and
User-defined), stroke volume, cardiac output, and cardiac index data are
displayed. Data displayed in other sections of the page are often
influenced by the cardiac output data used during calculations. You can
control which calculation data are used by clicking the radio button next
to the desired cardiac output value. The four cardiac output variables are
described below.

Fick Variables

Fick cardiac output is calculated only if proper oxygen saturation data
have been entered into the system. The Fick variable may be estimated or
actual, based on which oxygen consumption field is activated.

Thermal Variables

Thermal cardiac output is a calculated average from all thermal samples
performed during a procedure. As samples are added or deleted, the
average will change accordingly.

Angiographic Variables

Angiographic cardiac output is calculated from ejection fraction functions
in the Image Analysis module. It can also be calculated by manually
entering diastolic and systolic volumes.

User-Defined Variables

User-defined cardiac output may contain data from devices such as green
dye monitors. The data must be entered manually.

Valves

Located at the mid-left-hand side of the screen, this section contains
valve-related values that are automatically populated as necessary data
are entered or sampled during procedures (see section 9.1
‘Hemodynamic and Lab Value Conversion Calculations’ for calculation
formulas). For each of the valves (Aortic, Mitral, Pulmonic, Tricuspid, and
Other) the following information is displayed: peak and mean gradient,
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filling period, heart rate, valve area, and valve index data. Valve area and
index data will be populated only if cardiac output data are present. You
can enter free text comments regarding each valve into the box labelled
Note. If you’d rather not use the automatically posted data for particular
valves, delete them by clicking X under the respective item.

Ventricles

Located at the top left of the screen, this section contains ejection
fraction-related values that are automatically populated as analysis
functions are carried out in the Image Analysis module (see section 9.1
‘Hemodynamic and Lab Value Conversion Calculations’ for calculation
formulas). For each ventricle, the system displays diastolic and systolic
volumes, ejection fraction percentages, and regurgitant fraction
percentages.

Miscellaneous Controls

Miscellaneous controls and their functions are listed in the following

table.
Control Description
< (Prev Condition) Navigates to the previous hemodynamic condition

screen.

Condition drop-down list  Allows a user to select a hemodynamic condition
to display on screen.

> (Next Condition) Navigates to the next available hemodynamic
condition screen.

+ Add Allows a user to create a new hemodynamic
condition.

- Delete Allows a user to delete a hemodynamic condition.

Print Prints the current hemodynamic condition screen.

Update Refreshes the hemodynamic condition data.

3.3.5 Arterial Trees

The Arterial Trees module allows a physician to create a graphic
representation of a patient’s cardiac or peripheral arterial anatomy. The
arterial trees allow you to indicate areas of disease, collaterals and bypass
grafts, interventions performed, and other diagnostic data, such as
anatomical aberrations. The data from the tree is automatically placed in
the appropriate charting menu and can be included in a report or queried
at a later time. Operators may use the provided templates or replace any
or all of them with a preferred set. The templates include:

* Right dominant coronary anatomy,
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» Left dominant coronary anatomy,

e Co-dominant coronary anatomy,

e Upper peripheral arterial anatomy,

» Lower peripheral arterial anatomy,

» Brachial arterial anatomy,

e Pulmonary arterial anatomy,

« Renal anatomy, including the abdominal aorta and kidneys,
» Carotid arterial anatomy,

« Cranial arterial anatomy,

e Hepatic arterial anatomy, and

» Cardiac mapping for electrophysiology studies.

Creating an Arterial Tree

To create an arterial tree for a procedure, click on HEMODYNAMICS >
CORONARY TREE > NEW, and select a template from the list. The selected
template will be displayed. The Functions tab on the right contains the
tools you will use to customize your tree.

If you place the mouse cursor over a vessel on the tree, you will notice
that the vessel and segment labels (e.g., LAD Mid) appears at the top
right of the screen. If you move the mouse cursor around the tree, the
label will change as you pass over the different vessels and segments.

To enter a lesion on the tree, simply click on the proximal starting point in
the target vessel, then click again at the distal point, defining the length
of the lesion within the vessel. You will then be prompted to define the
primary type of lesion and select a secondary type, if desired:

* Generic,

» Diffuse,

e Luminal irregularity,
e Tubular,

» Discrete,

e Complex,

e Thrombus,
 Calcified,

e Eccentric,
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¢ Aneurysmal,
¢ [n-stent restenosis,

e Ectasia.

There are also Unvisualized, Visualized, <A>, <B> and <C>. These are
special types that will be described later.

Once you have selected a primary lesion type, and a secondary type, if
desired, click OK. A graphical representation of the lesion will appear at
the point you selected. You will be prompted to adjust the amount of
stenosis using the scrollbar on the Functions tab. Scroll up to increase the
percentage of stenosis, or down to decrease. The inner set of arrows will
increase or decrease by increments of one (1). The outer arrows will
increase or decrease by increments of five (5). If you set the stenosis to
100%, the vessel and any branches distal to the lesion will collapse. Click
into the black area around the tree to set the lesion. Repeat the process
as many times as is necessary.

The Unvisualized type is used to collapse a section of vessel when the
type of lesion cannot be determined. The Visualized type is used to open
a segment of vessel within a collapsed area. <A>, <B>, and <C> are lesion
type designations required by the American College of Cardiology.

Once you have entered a lesion, you can indicate whether an

intervention was performed or add notes using the Annotation
Functions.

Annotation Functions

Control Description

Scrollbar Allows the operator to adjust the percentage of
stenosis, or the diameter of a vessel (see Change
Vessel Size).

WNL Marks a vessel as being within normal limits.

PTCA Indicates a percutaneous transluminal coronary

angioplasty performed on a lesion.

STENT Indicates a stent placement in a vessel.

DA Indicates directional atherectomy performed on a
lesion.

PTA Indicates a percutaneous transluminal angioplasty

performed in a peripheral vessel.
ROTA Indicates a rotablation performed in a vessel.

Note Used to create and place notes on a tree.
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Annotation Functions

Control Description
Arrow Used to draw directional arrows from one point to
another.

To indicate that a vessel has no disease, click WNL and then click to
position the WNL (within normal limits) marker on the tree.

To indicate that an angioplasty was performed on a lesion, click PTCA. You
will be prompted first to click to position the note on the tree near the
lesion. Next, use the scrollbar to adjust the residual stenosis (the default
value is 0%). Last, you will be prompted to click into the area of stenosis
to position an indicator arrow. Be sure that you click into the lesion, not
into the area around it.

You will use the same process for the other types of intervention (DA,
PTA, ROTA). If you are indicating a stent placement, you will be prompted
to indicate the proximal and distal points of the stented segment after
you have placed the arrow. When drawing overlapping stents, click the
distal end of the second (and any subsequent stents) first, then click on
the proximal end.

You may also want to place additional notes or arrows on a tree. To place
a note, click NOTE. A window will open to allow you to enter text, then
click OK. You will then be prompted to click into the tree to position the
text. Be careful not to place the text where it will obscure vessels or other
notes.

To create a directional arrow, click ARROW. Click in the tree to indicate
the starting point, then click to indicate where you want the arrow to
point.

Editing an Arterial Tree

There are a number of tools that can be used to edit an arterial tree so
that you can more closely approximate a patient’s anatomy. You can add
vessels, delete vessels, change the diameter or location, or redraw
existing vessels to demonstrate length or tortuosity. The editing controls
and their functions are listed in the following table:

Procedure Status

Control Description
None Default status for arterial trees.
Pre-Procedure Designates an arterial tree as pre-procedure.
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Procedure Status
Control

Copy

Post-Procedure

Tree Editing Functions

Control
Artery Label

Vessel Size

Cusp Structure

Termination

Lesion Side

ACC Lesion #

Undo

Delete

Move Functions
Control

Move Artery

Move Note

Move Lesion

Vessel Functions
Control

Vessel Artery
Graft

Y Graft

Position

Sequential Graft

Xper Information Management System Release 2-1

Description

Allows the operator to copy the pre-procedure tree
to post-procedure status.

Designates an arterial tree as post-procedure.

Description

Allows the operator to change the display label (top
right corner) of a vessel.

Allows the operator to adjust the diameter of a
vessel.

Used when creating new templates to draw non-
artery structures, such as the aortic cusp or kidneys.

Used when creating an arterial template.

Allows the operator to switch an eccentric lesion
from one side of a vessel to another.

Allows the operator to assign a number to a lesion
when reporting to the American College of
Cardiology.

Allows the operator to undo the previous ten (10)
operations.

Used to delete vessels, grafts, collaterals, and notes.

Description

Allows the operator to change the location of a
vessel.

Allows the operator to change the location of a note.

Allows the operator to change the location of a
lesion.

Description

Used to insert arteries into a template or tree.
Used to draw bypass grafts on a tree.

Used to draw Y grafts on a tree.

Used to change the position markers (proximal, mid,
or distal) within a vessel.

Used to draw sequential grafts on a tree.
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NOTE

NOTE

Vessel Functions
Control Description

Collateral Used to draw collateral vessels on a tree.

Tree Functions

Control Description

Print Tree Prints the displayed tree.

Export Not currently in use.

Menu Opens the designated coronary or peripheral menu

(see section 4.12.3 ‘Building and Editing Menus’)

To add a vessel, click VESSEL ARTERY. You will be presented with a list of
vessels appropriate to the type of arterial tree you selected. Coronary
trees will have a list of coronary vessels, while the peripheral trees will
have the appropriate list of vessels for that system. Choose the type of
vessel you wish to draw, or type in your own label and hit ENTER on the
keyboard. You will then be prompted to click on the point of origin of the
new vessel. Draw the path of the new vessel, then click on the end point
to complete the drawing.

When drawing any object (i.e., vessel, graft, arrow, etc.), do not hold down the mouse
button. Click once and release, draw the path of the vessel or object, and click a
second time to complete the process.

To delete a vessel, lesion or note, click DELETE, then click on the object
you wish to delete. If you wish to delete a note, click on the first character
of the text.

The UNDO control will reverse up to ten (10) previously performed
functions, such as drawing lesions or grafts, moving vessels, or adding
notes.

You may increase or decrease the diameter of a vessel by clicking VESSEL
SIZE. You will be prompted to select the vessel you wish to change, then
use the scrollbar to increase or decrease the diameter.

If you wish to change the length or tortuosity of a vessel, you must delete it before
redrawing it

An eccentric lesion extends from the right or left side of a vessel. If you
draw an eccentric lesion in a vessel and wish to switch it to the opposite
side, click ECCENTRIC LESION SIDE, then click on the lesion you wish to
change.
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NOTE

You may move an artery, note or lesion to a different location on the tree.
To move an artery, click MOVE ARTERY. Click on the artery you wish to
move, then click on the position from which the vessel should originate.
To move a lesion, click MOVE LESION, select the lesion, and click on the
new location within a vessel or graft.

Notes are the white text on a tree. They can be vessel labels or
annotation added by a physician. To move a note, click MOVE NOTE. Click
on the first character of the note you wish to move, then click on the new
location. Be careful not to move a note to a location that obscures a
vessel or lesion, or another note.

The vessel label is the green text that appears in the top right corner
when you move your mouse cursor over the tree. You may change the
vessel label by clicking ARTERY LABEL. Click the vessel you wish to relabel,
then select from the list or type in a new description and click the vessel.
Move your mouse cursor over the vessel to confirm the change.

You may indicate bypass grafts and collaterals on the tree. To add a graft,
click GRAFT on the Functions tab. Click once at the start of the graft (do
NOT hold down the mouse button), drag the mouse to the other end of
the graft, and click a second time. The starting point determines the type
of graft drawn. If you begin drawing your graft inside the aortic structure,
Xper will label it as a saphenous vein graft (SVG). If you begin drawing
your graft in the black area to the right of the aorta, you will get a LIMA
(left internal mammary artery) graft, and if you begin drawing to the left
of the aorta, you will get a RIMA (right internal mammary artery graft). If
you are using a template other than the coronary anatomy, the graft will
be labelled simply as “Graft.” Once you have placed a graft, you can pass
your mouse cursor over it to see the label.

There are two other types of grafts you may include on an arterial tree,
sequential grafts, and Y-grafts. To draw a sequential graft, click
SEQUENTIAL GRAFT and draw the first segment from the aorta to the
target vessel. Click SEQUENTIAL GRAFT a second time, and draw the
second segment from the exact point of termination of the first segment
to the second target vessel.

To draw a Y graft, click Y GRAFT and draw the first segment from the aorta
to the target vessel. Click Y GRAFT a second time and draw the second
segment from any point on the first segment to the second target vessel.

Always make sure that any graft terminates inside the lines of a vessel.
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3.3.6

Drawing collaterals is similar to drawing a graft. Click COLLATERAL, then
click at the starting point within a vessel. Draw a line in the direction of
the flow to the end point and click a second time. Collaterals must begin
and, like grafts, terminate within the lines of a vessel.

Pre- and Post-Procedure Trees

You may choose to show your pre-procedure findings and post-procedure
results as separate trees. To create a pre-procedure tree, select a
template as usual. When the diagram opens, select PRE-PROCEDURE
from the upper right, then proceed to place lesions and other findings.

When you are ready to create your post-procedure tree, click COPY. You
will be prompted to copy the pre-procedure tree to a new diagram. Click
YES to continue. A new copy of the tree will appear, designated POST-
PROCEDURE, containing all the data you had already inserted onto the
pre-procedure tree. You may now indicate intervention results, such as
stent or directional atherectomy, on the post-procedure diagram.

Historical Tree

The Historical Tree function allows a user to import an arterial tree from a
previous study in Xper Information Management. Click HEMODYNAMICS
> ARTERIAL TREE > HISTORICAL. A list of trees created in the patient’s
previous studies will be presented. The user may select from the list and
import, then proceed to update the tree with new findings.

Copy Tree

If desired, a user may copy an existing tree and make changes within the
same case. For example, a physician may want to create a pre-
intervention tree, and then show the results of the intervention on a
second tree. Rather than redrawing the existing tree, he can click
HEMODYNAMICS > ARTERIAL TREE > COPY, and select the original tree.
This will create a second instance of the same tree, on which the
physician can then make changes to indicate results.

Custom Forms

To utilize custom forms during a study, click the SCREENS button and
select the form you wish to complete (see section 4.14 ‘Custom Forms’
for information on creating and deploying custom form). You may enter
the data manually, or you may create scrapers (see section 4.2 ‘Data
Scrapers’) that will populate the fields automatically as you chart.
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3.3.7

NOTE

NOTE

During review of a custom form, you may chart additional data that can
be scraped to the form. In order to activate the scrapers, click REFRESH at
the top of the custom forms screen to pull additional data or to update
the form with any changes you’ve made in charting.

To print the actual custom form as it appears on the screen, click PRINT

FORM. Clicking {PRINT DATA will print the fields and data that appear on
the form. The data format can be included in case report configurations
(see section 4.22 ‘Case Report Configuration’).

Transcription

To access the Transcription module, click HEMODYNAMICS >
TRANSCRIPTION. To create a report, select the template from the
Templates drop-down list on the Transcription toolbar and click ADD. The
new template will be completed, as well, using data elements from
charting and hemodynamic sampling.

You may create multiple revisions of any report. After you have selected a
template and the available data has been filled in, you may make changes
to the report, then click SAVE to update the revision. The most current
revision will then be available on the History tab for review and
corrections by you or another user. To update a saved draft, click the EDIT
link next to the current revision on the History tab, make changes on the
Editor tab and click SAVE.

To review a report, select the Preview/Print tab.

To cancel a draft, click CANCEL DRAFT on the Transcription toolbar while
on the Editor or Preview/Print screen.

You can only cancel a draft. After a report has been sjgned, it cannot be cancelled and
must be amended.

To electronically sign a report, click SIGN on the Transcription toolbar,
then enter your username and signature password. This will create a PDF
of the report that will be available for viewing and printing on the
Documents tab, and will be sent through the Results interface, if you
have one. If your interface requires a transcription type, select the
appropriate type from the Transcription Type drop-down menu. After a
report has been signed, you may create an amended report by clicking
the AMEND link next to the signed report on the History tab.

A user must be assigned as a resource on a study in order to sign a document or
finalize a study; unless the user account is set for Transcription Signature Override.
See section 4.5.3 ‘User Administration’ for more information.
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When all reports are complete, you can change the status of the case to
Finalized and lock the signed transcription documents. Click
HEMODYNAMICS > CASE TOOLS > FINALIZE STUDY. You will be prompted
to enter your username and signature password. If there are
transcription drafts that have not been signed, Xper will display a
message requesting that you sign all unsigned documents prior to
finalizing. After clicking OK, the Case Finalized flag will be set on the Case
Details screen. The study will no longer appear in the Unread Studies
pane, but will be listed under Finalized Studies.

Image Acquisition and Review

Xper Information Management uses Calysto Image IV for cine acquisition,
image review and frame capture, or Philips Xcelera for image review and
frame capture. Xcelera is a standalone program with a separate user’s
guide. Likewise, Calysto Image IV is a standalone application with a
separate user’s guide. Consequently this chapter will describe only the
procedures needed to initiate Image IV cine acquisition, open cases in the
imaging program and to capture still frames for inclusion in transcription
reports. For other cine review functions, such as quantitative coronary
analysis or left ventricular analysis, you must refer to the imaging product
user’s guide.

To activate Image IV cine acquisition, click HEMODYNAMICS > IMAGING >
CINE ON. The selected study will open in image capture mode on the
Image IV acquisition station. When the study is complete, click
HEMODYNAMICS > IMAGING > CINE OFF. The study will close on the
Image IV acquisition station, and the cine runs will be uploaded to the
network for review.

To display the cine runs for a study, click HEMODYNAMICS > IMAGING
>VIEW IMAGES. Image IV will open and display the available images for
the study. You may capture still frames by pausing the cine run and hitting
F1 or clicking (F1) SNAP. The still frames may then be included in the final
transcription report (see section 4.3 ‘Structured Reports’). Image review
is not available on physiomonitoring stations, but may be available on
Patient Care Consoles, Nurse Stations, and Personal Assistants.

To display cine runs in Xcelera, click HEMODYNAMICS > IMAGING >VIEW
IMAGES. Xcelera will open and display the available images for the study.
To capture still frames, pause the cine run, then click and drag the image
to the folder in the lower left hand corner of the screen. Right click on
each image and select “Make available to CIS.” When you are finished,
click the X icon to close Xcelera. As with Image IV, the still frames may be
included in a transcription report.
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3.5

NOTE

To view still frames for a study, click HEMODYNAMICS > IMAGING > STILL
FRAMES. Any stills captured in Image IV or Xcelera will be displayed.

Studies from other modalities, such as ultrasound, nuclear medicine, or
magnetic resonance imaging (MRI) will appear in the list of patients in
this system, but image review is performed in Image IV or Xcelera. To
review these studies, click on the patient in the Unread Studies list. The
imaging application will open and display the available images for the
study. Still frame capture and reporting will be performed in the imaging
application.

Still Frame Capture

If an Xper Information Management host is equipped with a video
capture card, you can select and store frames from a patient’s
cineangiograms. The still frames can be printed as part of the case report,
or they can be included in a transcription report.

To capture still frames:

1. On your x-ray equipment, loop a cine run from the patient’s study.

2. Click HEMODYNAMICS > IMAGING > FRAME CAPTURE (if you host is
not equipped, this option will be disabled in the menu).

3.  Click PLAY. After a short time, the cine run selected on the x-ray
equipment will appear on the Xper screen.

4.  On the x-ray equipment, advance to the frame you want to capture
and pause the playback.

5.  Click CAPTURE FRAME to acquire and store the still frame in the
patient’s study.

6. Repeat as necessary to capture additional frames.

7.  Click STOP to clear the image from the screen.

It is not necessary to click STOP between runs or to close the module.

If you have a dual-monitor system, you can display the image full screen
on either monitor. Select Monitor 1 or Monitor 2, then click FULL
SCREEN. Hit the ESC key to return to normal viewing.

You may crop the image by checking Enable Cropping. Set the desired
level of cropping for left, right, top and/or bottom, then click REFRESH.
The cine run will be redisplayed in cropped format. To return to normal
mode, uncheck Enable Cropping and click REFRESH.
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3.7

NOTE

Printing a Case Report

To print a case report, click PREVIEW on the Case Details screen. You will
be prompted to select a report format (see section 4.22 ‘Case Report
Configuration’). Choose the desired format and printing option:

» Print: will send the selected case report format to the printer.
» Archive: will create a PDF of the selected case report format.

» Print & Archive: will send the selected case report format to the
printer and create a PDF file, as well.

 Print & Close Case: will send the selected case report format to the
printer and close the case when printing is complete.

» Preview: allows you to review the case report before printing. The
preview screen will open, and you can scroll through the various pages
of the report. When you are ready to print, click the Printer icon at the
top left corner. The selected report format will print to your default
printer. To select a different report format, close the Preview and
repeat the process, selecting a different format when prompted.

Finalizing a Case

Once a procedure is over and all required documentation has been
completed (case notes, transcription reports, etc.), you may finalize the
case so that no changes can be made to the case data. To finalize a case:

1.  Click LOCK STUDY.

2. Enter your username and signature password (see section 4.5.3
‘User Administration’).

3. Click OK. The CASE FINALIZED box on the ID screen will be checked,
and the Finalized Date will be populated with the date on which you
locked the case.

After a case has been locked, users will be able to open the case and
review the data, but will not be able to make any changes, additions or
deletions to the data.

Locked cases may be unlocked, in the event that changes do need to be
made. The process is basically the same as locking a case. The button will
now read UNLOCK STUDY. Click UNLOCK STUDY, enter your username and
signature password, and click OK. You may then make the necessary
changes and lock the case when you are finished.

Users must have Lock and/or Unlock privileges in order to lock or unlock a case. For
more information, see section 4.5.3 ‘User Administration’.
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3.8

NOTE

NOTE

NOTE

3.9

Electrophysiology

Regquires an Xper Connect interface to import the EP data.

Xper Information Management can display data collected during
electrophysiology studies performed on an EP-Workmate, Cardiolab, or
Bard system. The data can also be included in transcription reports. To
view EP data:

1. Open the case.

2. Click HEMODYNAMICS > CASE TOOLS > EP and select the
appropriate system (EP-Workmate, Cardiolab, or Bard). The data
screens will open, populated with the data that was sent from the
EP system.

3. To add data, click ADD. A blank line will appear at the bottom of the
selected tab, allowing you to add information.

4. To delete data, highlight the line you want to remove and click
DELETE.

5. To save changes, click SAVE.

6. To export the data from the selected tab to an Excel spreadsheet,
click EXPORT.

7. To import the data into a charting menu, click TRANSFER TO MENU.
You may then scrape or query the data as you would any other
menu.

Data can be transferred to a charting menu one time only. Do not perform this
operation until you are sure the data is complete.

If you have created transcription templates for EP studies, the report will
begin to auto-populate as soon as you have assigned a procedure on the
Case Details screen and selected a template.

Arterial trees cannot be created for EP studies.

Philips TraceMaster Interface

This system supports a view-only interface with Philips TraceMaster ECG
carts. Through the Xper Connect interface, a TraceMaster patient will be
placed in the Unread Studies or Patient Locator window. To view the ECG:

1. Open the case from the Unread Studies or Patient Locator list;
2. Click the History tab;
3. Inthe LINKS section, click on the link provided for the ECG;
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The ECG will be displayed in an embedded browser window.

3.10 GE MaclLab Interface

NOTE Requires an Xper Connect interface to import the Maclab data.

This system can display hemodynamic data collected during cardiac
catheterization studies performed on a GE MacLab system. The data can
also be included in transcription reports. To view the data:

1.  Open the case.

2. Click HEMODYNAMICS > CASE TOOLS > HEMO INTERFACES > GE
MACLAB. The data screens will open, populated with the data that
was sent from the MaclLab system.

3. To add data, click ADD. A blank line will appear at the bottom of the
selected tab, allowing you to add information.

4. To delete data, highlight the line you want to remove and click
DELETE.

5. To save changes, click SAVE.

6. To export the data from the selected tab to an Excel spreadsheet,
click EXPORT.

7. To import the data into a charting menu, click TRANSFER TO MENU.
You may then scrape or query the data as you would any other
menu.

NOTE Data can be transferred to a charting menu one time only. Do not perform this

operation until you are sure the data is complete.

If you have created transcription templates for MaclLab studies, the
report will begin to auto-populate as soon as you have assigned a
procedure on the Case Details screen and selected a template.
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4.1.1

Scheduling

This system includes a scheduling system that allows you to enter both
procedures and staff. In addition, the Work Hours scheduler allows you to
manage staff working hours and vacation, and the Room Staffing module
gives you the ability to better manage resources by ensuring that
procedure rooms are fully staffed to meet your department needs.

Study Scheduler

The Study Scheduler module allows you to manage your procedure room
utilization effectively. You can display all your procedure rooms at once,
or narrow the view to a single room. In addition, you can display
scheduled procedures for a single day, a week or month, or even an
entire year at a time. To access the Study Scheduler, click MODULES >
SCHEDULER > STUDY SCHEDULER.

To set up the Study Scheduler, you must first add rooms. To add a room:
1. Click ROOMS to open the Rooms Configuration window.

2. Click NEW ROOM

3. Enter the room name

4.  Click APPLY.

To display a room, place a check in the box next to the room name. If you

wish to turn off the display for a room, uncheck the box. To delete a room
from the list, highlight the room name and click DELETE.

After you have configured your rooms, you can begin to schedule
procedures. To schedule a procedure:

1. Double click on the desired time slot in the appropriate room.

2. Enter the type of procedure (Subject)

3. Seta Start and End time

4.  If you wish, enter notes on the patient or procedure.

5.  Click OK to save the procedure, or click CANCEL to discard it.

You may also change the procedure room, or even schedule an event in

all rooms by using the Resources drop-down list. To save an event, click
OK, or click CANCEL to discard the event.

To add patient data (name and medical record number), CPT codes and
staff:
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1. Click on the newly scheduled event. The Event Information window
will open on the bottom right side of the screen

2. Drag staff names to the event and drop them to assign them to the
procedure.

3.  Hover over the event to view all the data.

You may also place pre-admitted patients from the Waiting List into
schedule time slots. Simply drag the patient from the Waiting List tab to
the desired slot on the schedule. Patients assigned to the schedule from
the Waiting List will appear in green. You may then assign additional
resources and procedures.

To move a study to a different room:
1.  Click on the study

2. Drag it to the room and time slot to which you want to move it.

To move a study to a different day:

1.  Click and drag the study to the desired day in the calendar view at
the top right. This will move the study to that day, placing it in the
same room and time slot.

2. Click on the new day in the calendar to move the study to a different
room and time.

To save all changes and additions, click APPLY. If you do not remember,
you will be prompted to save your modifications when you close the
Scheduler.

You can admit from the Scheduler, if you have entered the patient’s first
and last names and medical record number. To admit from the Scheduler,
right click on the scheduled study and click ADMIT. A new Case Details
screen will open with the patient’s data. If you have assigned resources,
they will be present, as well.

Staff Schedule

The Staff Schedule is directly tied to the Study Scheduler. To access staff
scheduling, click MODULES > SCHEDULER > STAFF SCHEDULER.

Double click on the desired time slot for the staff member you wish to
schedule. You may then enter the type of procedure (Subject), a Start and
End time. To save an event, click OK, or click CANCEL to discard the event.
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4.1.4

Staff Work Hours

The Staff Work Hours module allows you to manage work schedules for
all members of your staff, including physicians. You can enter work times
for each individual for a number of time periods, daily, weekly, monthly,
and so on. Access the Work Hours module by clicking MODULES >
SCHEDULER > STAFF WORK HOURS.

To create a work schedule for a staff member:

1.  Select the individual from the drop-down list. Any existing hours
scheduled for the person selected will be displayed in the Available
Work Hours list below.

2. Click ADD WORK HOURS to activate the Staff Work Hours Editor
window at the bottom left.

3. Select a start and end date for the period you wish to schedule.
When you click on the drop-down list, a calendar will appear,
allowing you to specify the start date and end date of the time
period.

4.  Once you’'ve specified the dates, you can click into each day of that
week, highlight a time block, and right click to create a scheduled
time block.

5. Continue creating as many blocks as necessary. To save time, you
may click on a block, right click and copy it, then click and paste it
into a new time slot. You can copy multiple blocks at once by holding
down the CTRL key, clicking on each block, then right clicking and
selecting COPY.

6. Click SAVE to schedule the time. Click CANCEL to discard the
changes.

7. To delete a time block, right click on it and select DELETE.

8. To delete an entire work period, highlight the date range in the list
and click DELETE in the Editor window.

Room Staffing

Once you have created work hours schedules for your staff, you may then
assign them to procedure rooms and roles using the Room Staffing
module. To access Room Staffing, click MODULES > SCHEDULER > ROOM
STAFFING.

To assign staff to rooms:

1.  Use the calendar at the top right to select a day. Staff members who
are scheduled to work on that day will be available in the list on the
bottom right.
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4.2.1

2. You can click on a name and drag it to the procedure room in which
you wish to place the person.

3. Right click on the time blocks for that individual to assign a
procedure role: Nurse, Scrub, Circulate, Record, or X-ray Tech. Staff
members whose names appear in dark gray windows are not
scheduled to work on that day.

4. Asinthe other scheduling modules, you can click and drag a block to
a different room or date, but you cannot schedule a staff member on
a day on which he or she is not scheduled to work. Click APPLY to
save changes.

Data Scrapers

The data scrapers are powerful tools that enable you to collect data more
efficiently, and eliminate duplication of work and errors in data entry. The
functionality of the data scrapers has been expanded to allow you to
copy data from one field to another, as well as copying data from charting
to related fields in the patient demographics screen, registry screens, and
to transcription reports. Further, you can create separate scraper sets for
different modalities, such as cine, echo, or ECG.

To access the data scraper utility, you must have a case open. We suggest
creating a test case that you can use to build and test your data scrapers.
Before creating any scraper line, you can chart the pertinent data into the
case, so that you can see the results of your scraper as you build, and
make adjustments so that you can collect data in the correct format. To
access the Scraper module, click HEMODYNAMICS > CASE TOOLS >
SCRAPERS.

Scraper Types

There are three types of data scrapers you can create: Direct Copy, Label,
or Data Mining. The Scraper Administration screen displays a short
description of the different types:

Direct Copy: A direct copy scraper copies the contents of one data field to
another data field, usually on a different screen. For example, you can
create a direct copy scraper that will copy the contents of the ALLERGIES
field on the Demographics screen to the PERTINENT HISTORY field on the
Sedation Flowsheet.
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Data Mining: Data mining scrapers pull data from information which has
been charted in a case and places it in data fields or in transcription
reports. For example, you can create a data mining scraper that pulls a
patient’s allergies from the charting in the History & Assessment menu
and places the data into the ALLERGIES field on the Demographics
screen.

Label: A label field is used primarily in transcription. If data is present in a
case, a label, or tag, will be entered in the indicated point in your
transcription report. For example, you may want an “ALLERGIES:” label in
a particular place in your transcription report. You can decide when
creating the scraper whether you want the label to appear only when
data is present in the patient’s case, or whether you always want the
label to be inserted.

The Scraper Administration screen consists of several sections. At the top
is the Scraper Entries list. This is a list of all the scraper fields you have
created, along with data about each entry, such as type, modality, the
scraper field name (Destination) and other information about the items.
You can use the Modality drop-down list to access scraper sets for the
different modalities.

The controls for creating, editing, deleting and testing items are located
on the scraper toolbar in the center of the screen. The bottom of the
screen is a quick-view information section which will display all pertinent
data about any scraper field you have selected in the Scraper Entries list
at the top.

Scraper Creation

Direct Copy

Direct copy scraper fields are relatively easy to build. You begin by
identifying the destination field; that is, the field in which you want to
place data. To begin, click ADD. This will open the Scraper Creation
Wizard.

The Scraper Creation Wizard helps you create the scraper items you need
to collect your data and direct it to fields on various screens. The LIVE
SCRAPER section shows you the results of your scraper line as you build
it, so that you can make adjustments to get exactly the data you want in
the format you want. The only thing you have to do is to chart menu
entries or fill in source fields ahead of time, which you can easily do in a
test case without affecting actual patient data.
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Click “Direct Copy” to set the scraper type and open the Destination Field
dialogue. There are two tabs on the Destination Field screen, Fixed and
Transcription Value. A fixed field has a name that has been specified by
the application and cannot be changed. A transcription value will be a
field that you create and assign a name. The fields and their functions are
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listed in the following table:

Destination Field -
Fixed

Screen

Condition

Field Name
Merge Name

Description

Destination Field -
Transcription

Transcription Field
Name

Merge Name

Description

Description

Select the screen that you are scraping TO

Used only for the Hemodynamic Data screen, indicates
hemodynamic condition to scrape to.

Select the field that you want the data to scrape to

The system-assigned scraper field name. These names are
set automatically by the application.

Enter a short description of the scraper field, if desired.

Description

Enter the desired field name.

The system-assigned scraper field name. These names are
set automatically by the application.

Enter a short description of the scraper field, if desired.

The following is an example of how to create a direct copy, fixed
destination field, NOTES, on the Sedation Flowsheet screen that pulls
data from a field on the patient demographics screen, ALLERGIES:

1. Click ADD.

2. Select DIRECT COPY in the Type section.
3. Inthe Screen drop-down list, select “SEDATION FLOWSHEET".

4. Inthe Field Name drop-down list, select “NOTES”. You will now have

a system-assigned Merge Name “F.Sedation FlowSheet.Notes”.

5.  Click NEXT >. This will open the Source Field dialogue window.

The Source Field contains information that tells the application where to
find the data you are looking for. The fields and their functions are listed

in the following table:

Source Field -
Fixed

Screen
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Source Field -
Fixed

Condition

Occurrence

Field Name

Merge Name

Source Field -

Transcription Value

Transcription Field
Name

Merge Name

Description

Used only for the Hemodynamic Data screen, indicates
hemodynamic condition to scrape from. You can have the
scraper check ALL conditions, you can specify a condition
from 1 — 5, or you can select the condition name.

Refers to the index of a value in a table (e.g., Procedures,
Resources, hemodynamic data, etc.)

Select the fie/d that you want the data to scrape from.
The system-assigned scraper field name. In a direct copy
scraper, the names are set automatically.

Description

Select the existing Transcription field from which you
want to copy data.

The system-assigned scraper field name. These names are
set automatically by the application.

To continue building our scraper:

6. Inthe Screen drop-down list, select “DEMO”. This will tell the
scraper to look for a field on the patient demographics screen.

7. Inthe Field Name drop-down list, select “ALLERGIES”. The resulting
merge name is the system-level field name for the ALLERGIES field
on the demographics screen.

8.  Click FINISH.

Your line is now complete and should appear in the Scraper Entries list at
the top of the screen. You can check the results by highlighting the field
F.Sedation FlowSheet.Notes in the list and clicking TEST MATCH. The test
match function applies the scraper to your test case and displays the
resulting data. In this case, however, unless you have filled in the
ALLERGIES field on the patient demographics screen, the scraper result
returned is “No data returned from source field.”

4-8

Xper Information Management System Release 2-1

Philips Healthcare 453564527351



Philips Healthcare 453564527351

Data Mining

Of course, you can go to the patient demographics screen and manually
type in an entry in the ALLERGIES field, but there is another way to fill in
that field. You can use a Data Mining scraper to pull data from the
charting menus and place it in any field on any screen. If you need the
data to go to more than one location, you can create a Data Mining
scraper to fill in one field (in this case, ALLERGIES), and then use Direct
Copy to duplicate the data in other locations. To create a Data Mining
field:

1.  Click ADD.

2. Select DATA MINING in the Type section. The drop-down list will
become active.

3.  From the drop-down list, select the menu in which the data will be
charted. If the same data might be charted in more than one menu,
select “ALL".

4. Select “DEMOQ” in the Screen drop-down list.

5. Select “ALLERGIES” in the Field Name drop-down list. You should
now have a Merge Field name “F.DEMO.Allergies”.

6. Click NEXT >.

The next step in creating a Data Mining scraper is to identify the “key”
words and/or phrases that will indicate what data you want to scrape. A
key can be a single line, or it can be a string of words or phrases. What a
data mining scraper basically does is tell the application to go to a certain
menu, look for a certain phrase or phrases that have been charted, and if
it finds the key(s), to apply a set of instructions to that line in the menu.
You can also tell it what to do if it does not find the key(s).

To create a key, you will be presented with the menu you selected in step
3 above. If you selected “ALL,” you will have a drop-down list of all menus
from which to select. The next step is to “chart” the key into the Virtual
Charting window by clicking through the menu selections. Then, highlight
the word (or words) you want to use as a key. In this case, “Allergies:” is
highlighted. In our example, the word “Allergies:” (with punctuation
included) is the phrase that will identify the target data to be scraped. |
may chart more than one entry (X-ray contrast, latex, strawberries), but
they will all be prefaced with the word “Allergies:”. The most important
thing to remember about a key is that it will always be present in the
charting, and therefore can always be used by the scraper to identify the
target.
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Now that the key has been identified, click and drag it to the Criteria
window. If you need to identify more than one key, chart the next line
and highlight and drag the next key to the window. You may need to
adjust the condition of the key. By default, the condition of a key is set to
AND and EXISTS. If you have more than one key, and the condition is set
to AND and EXISTS for all of them, you are basically telling the scraper to
look for Key 1 and Key 2 and Key 3 and if it finds all of them, apply its
instructions. If you set the condition to AND and NOT EXISTS for a key,
you are telling the scraper to apply its instructions in a case where Key 1
is present and Key 2 is not present. In this case, if Key 2 is present, the
scraper will not apply its instructions, because the conditions for applying
them are not met.

If you have multiple keys that may exist, use the condition modifier OR.
This tells the scraper to look for Key 1 or Key 2 or Key 3, and if it finds
either of them, apply the instructions. OR can also be used with NOT
EXISTS.

When you do have more than one key, you must group them into a string
in order to use them correctly in a data mining scraper. To do this,
highlight the first key in the group, hold down the CTRL key, and click the
last key you want to include in a group, then click the GROUP key.

By grouping the different keys, you have created a key string. The scraper
treats a key string as a single key, even though the string may contain
many words or phrases.

You can create multiple groups of keys to create more than one key
string. Just highlight and group the first set, then repeat the operation for
any subsequent sets. If you need to ungroup a set, highlight the first key
in the set, hold down the CTRL key and click on the last key in the set,
then click UNGROUP. UNGROUP ALL will delete the grouping for any and
all sets in your Criteria window.

You can delete a key by highlighting it in the list and clicking DELETE.
CLEAR ALL will delete all the keys in the Criteria window.

Once you have identified your keys, you are ready to create the
instructions that will allow the scraper to operate. The first element is
OUTPUT TYPE. There are three types:
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Type Description

Label Yes/No Selecting this type will instruct the scraper to
insert a particular phrase in the target field if the
conditions of the scraper are met. You may also
instruct the scraper to insert a different phrase if
the conditions are not met, or you can do both in
the same line.

Data Mining selecting this type will open up the Data Mining
criteria window, where you can give the scraper
more elaborate instructions on what to scrape and
how to format it.

Time Stamp Selecting this type will instruct the scraper to pull
the time/date stamp (that is, the time and date on
which a line was charted) and insert it in the target
field.

The SEARCH PATTERN tells the scraper to search for data in a single menu
or in all available menus.

If you select Label Yes/No, the Yes default and No default windows will
activate. You can then type in the phrase the scraper will output if it finds
the key, and if desired, the phrase the scraper will output if it does not
find the key.

If you select Data Mining as your scraper type, the Data Mining window
will be activated. A data mining type scraper will search through the
charting for the keys, then apply a set of instructions that you create
here. You can also tell it what to do if it does not find the keys by giving it
a NO default phrase, if necessary. In the example below, if the scraper
does not find the key “Allergies:” charted in a menu, it will insert the
phrase “NKDA” in the destination field.

The Prefix and Suffix fields allow you to enter a phrase of up to five
hundred (500) characters that will appear before (Prefix) the scraper
results, or after (Suffix) the scraper results in a transcription document.
These fields are available only with Data Mining scrapers.

You can configure your system to add the prefix and/or suffix to each line of a group,
or to add the prefix only to the first line, and suffix only to the last line of a group. For
assistance in configuring your Xper Information System, contact Customer Support
or your local Philips Healthcare representative.

The POSITION section tells the scraper where the target data is located in
relation to the key:
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Before

After
Between

Scrapes data that occurs in the charted line before the
key.
Scrapes data that occurs in the charted line afterthe key.

Scrapes data that occurs between two keys.

The OUTPUT section tells the scraper how much of the target data to

output:

Line

All

Word

Outputs data from any line in which it finds the key, using

the position setting to identify which data will be scraped.

Outputs all data in the menu that occurs before, after or
between the keys, depending on the position setting.
Outputs a single word either before, after or between the
keys, depending on the selected position setting.

Once you have set the position and output settings, you can select the
key(s) from the drop-down lists below. If you have chosen between as the
position setting, both lists will be active. After selecting the keys, position
and output, you must tell the scraper the format in which you want the
data output. Output formats are described in the following table:

Format

Single Line

Group Comma

Group Period

Group

List

Quantity

Description

The default output format, outputs scraped data from
a single line

When multiple lines are identified, the scraper
outputs the results in a string with commas between
each entry (e.g., X-ray contrast, lodine, Latex,)

When multiple lines are identified, the scraper
outputs the results in a string with periods between
each entry (e.g., X-ray contrast. lodine. Latex.)

When multiple lines are identified, the scraper
outputs the results in a string with no additional
punctuation between each entry (e.g., X-ray contrast
lodine Latex)

When multiple lines are identified, the scraper
outputs the results in a list format:

X-ray contrast

lodine

Latex

When multiple lines are identified, the scraper
outputs the total number of results found (e.g., 3)
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You can also tell the scraper to look for only the numeric characters in a
line, and to output them in a particular data format:

Format Description

Alpha Numeric The default data format, includes letters, numbers and
other characters.

Numeric Scrapes numbers to a field as a numeric value that can
be used in calculations.

Date Scrapes numbers to a field and applies a date format
(mm/dd/yyyy).

Time Scrapes numbers to a field and applies a time format
(hh:mm:ss).

Include Keyword Includes the keywords with the scraper results.

Include Time Includes the time stamp with the scraper results.

The date and time formats are applied to data within a charted line. The TimeStamp
output type refers to the time and date when the line was charted.

Label

Label scrapers are used primarily in transcription templates, but can be
used for other fields, as well. The most common use is to insert a label for
hemodynamic data, such as AO pressure, Heart Rate, etc. However, you
can also use a label scraper to insert data into a fixed field, based on
certain criteria you set when building the scraper.

You begin creating a label scraper in the same manner as the other types,
by selecting a destination field. In the case of a Fixed field, the field
names already exist. In the case of a Transcription field, you have to
assign a name to the field.

The following is an example of a Label scraper that will insert the phrase
“Allergies:” into a transcription template. To begin:
1. Click ADD and select the LABEL scraper type.

2. Inthe Transcription Field Name box, type ALLERGIES. The Merge
Name will read “L.ALLERGIES”.

3. Enter a description, if desired.
4.  Click NEXT > to open the Reference Field screen.

5. Inthis case, we are looking for allergy data on the patient
demographics screen:

6. Inthe Screen drop-down list, select DEMO.
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7. Inthe Field Name drop-down list, select ALLERGIES. The Merge
Name should now read “F.DEMO.Allergies.”

8.  Click NEXT > to display the CRITERIA screen.

The Criteria screen allows you to set specific conditions that must be met
in order for the scraper to operate. The fields and their functions are
specified in the following table:

Data Present button Select this if the only criterion for scraper function is
that data be present in the reference field.

Value button Select this if you want to set a value criterion for
scraper function.

Condition (Value) Specify the condition for the value (e.g., equal to,
greater than, less than, etc.).

Value Specify a value, or the lower limit of a range.

Upper Value Specify the upper limit of a range.

Field Length button Select this if you want to set a field length criterion for
scraper function

Condition (Field Specify the condition for the value (e.g., equal to,

Length) greater than, less than, etc.).

Value Specify a field length, or the lower limit of a range

Upper Value Specify the upper limit of a range.

Yes: The default response if scraper criteria are met.

No: The default response if scraper criteria are not met.

In our example, we are simply checking the Allergies field on the patient
demographics screen to see whether data is present, so we will select the
DATA PRESENT option. Now we can set a Yes default response, and if
desired, a No default response. In the YES: field, enter ALLERGIES:.

You do not have to specify both a Yes and a No default response. You only
need a No default if you want the label to appear on a report even when
there is no data in the reference field. In the case of the ALLERGIES field
on the demographics screen, we created a Data Mining scraper that will
insert the phrase “NKDA” if it does not find any allergies charted in the
case; therefore, the ALLERGIES field will always contain data, so we do
not need a No default response. Click FINISH to complete the new Label
scraper.
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You can use the Label type for fixed fields, too. For example, say you want
to insert the word “True” in the Diabetes field on the ACC registry screen
if a patient’s glucose is between 110 -199. In this case, your destination
field would be the ACC Core field “Diabetes,” your reference field would
be GLU on the demographics screen, and you would set a Value condition
of between, a value of 110, and an upper value of 199.

Sedation/Reversal Agent Scrapers

Sedation and Reversal Agent scrapers, which scrape data to the Sedation
Agents and Reversal Agents sections of the Sedation Flowsheet, have a
specific structure that must be followed in order for them to work. Since
both types of scraper are built in the same way, we will use the Sedation
Agent scraper as an example. To create a sedation scraper:

1. In the Menu Builder, highlight the word or phrase to be used as the
scraper key and check the SEDATION (or REVERSAL) attribute, then
apply changes (see section 4.12.3 ‘Building and Editing Menus’).

2. InScraper Administration, click ADD.

3. Select Data Mining and choose the menu in which the keys are
charted from the drop-down menu.

4. Select Sedation Flowsheet as the destination screen, and Sedation
Agent as the destination field. Click NEXT.

5. Chart the line containing the key (e.g., {Narcotics/Sedation} Versed 2
mg V).

6. Highlight the key (previously identified in the Menu Builder; in the
example above, {Narcotics/Sedation} is the key) and drag it to the
Criteria list. Click NEXT.

7.  Select Output Type of Data Mining.

8. Select Data Mining position as AFTER and select the key from the
drop-down menu.

9. Set Output to LINE and Output Format to LIST.
10. Set Data Format to ALPHA NUMERIC. Click SAVE.

Case Status Scrapers

Case status scrapers will automatically send a designated status message
to update the Whiteboard Viewer (see section 3.1.9 ‘Whiteboard
Viewer’). To create a case status scraper:

1. Click NEW.
2. Select the Data Mining type.
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3. Select the appropriate menu from the Data Mining drop-down
menu.

4. Set the designation screen to DEMO.
5. Set the Field Name to Case Status.

6. Click NEXT.

7. Chart and drag keys to the Criteria list.
8.  Click NEXT.

9. In Output Type, select Case Status to activate the Case Status drop-
down menu.

10. Select the desired case status message from the list.

11. Click FINISH.

During a procedure, when you chart the keys and click SCRAPE, the status
message will be sent to the designated Whiteboard.

You can see how data scrapers give you the ability to maximize data
collection while minimizing workload. You can eliminate the need for
staff to duplicate their efforts by charting in the menus, and then
manually entering the same data on multiple screens. In the case of the
transcription fields, you can create many different transcription reports,
from physician reports to nursing notes, to custom forms for data
submission to state agencies, and many more. The possibilities are
limitless!

Structured Reports

This system gives you the ability to create structured report templates
that may be used to generate transcription reports for procedures. You
can create as many report templates as you desire per modality. Once
you have created your templates, you can assign them to a modality and
procedure, designating one template as the default for each procedure
type. When a study is opened and the procedure type indicated, the
default template will open. As the study progresses, the template will be
completed automatically (see section 3.3.7 ‘Transcription’).

Transcription Builder

To access the structured reporting module, click TOOLS >
TRANSCRIPTION, then select TRANSCRIPTION BUILDER. Several tabs
appear on the left side of the screen. Click the Templates tab to view the
list of available report templates or to create a new template.
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The Transcription Builder is a fully functional word processor with all the
commands and capabilities of other word processing applications. The
template builder controls and their functions are listed in the following

table.

Control

File Menu

Edit Menu

View Menu

Insert Menu

Format Menu

Tools Menu

Table Menu

New Document

Open

Save

Print

Print Preview

Spell Check
Cut

Copy
Paste

Undo
Redo
Insert Hyperlink

Insert Table

Show Paragraph
Codes

Xper Information Management System Release 2-1

Description

Contains commands for working with files
(New, Open, Save, etc.).

Contains commands for editing documents.

Contains commands for viewing different
elements of the editor (rulers, headers/footers,
etc.).

Contains commands for inserting elements
into a document.

Contains formatting commands.

Contains tool commands (spell checker,
macros, etc.).

Contains commands for creating and editing
tables.

Creates a new, blank document.

Opens an existing document in the user’s My
Documents folder.

Saves the open document to the user’s My
Documents folder.

Prints the open document.

Displays the document as it will appear when
printed.

Checks the spelling in the document.

Cuts selected text from the document and
places it on the clipboard.

Copies selected text to the clipboard.

Pastes selection from the clipboard to the
document.

Undoes the last performed action.
Repeats an action that was cancelled by Undo.

Inserts a hyperlink to a file or URL into the
document.

Inserts a table into the document.

Displays paragraph and text formatting codes
on an open document.
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Control Description

Zoom Level drop- Allows a user to select a zoom level.

down

Style drop-down Allows a user to apply a style to selected text.
Font drop-down Allows a user to select font types for selected

text or the entire document.

Font Size drop-down Allows a user to specify a font size.
Bold k| Displays and prints selected text in bold type.
Italic it Displays and prints selected text in italic type.
Underline u|  Underlines selected text in display and printing.
Left Justify =| Aligns text to the left margin.
Center Justify : Aligns text along the center point of the

= document.
Right Justify =| Aligns text to the right margin.
Full Justify =| Aligns text to both left and right margins.
Bullets and Numbering I Allows a user to format bulleted or numbered

lists or paragraphs.

Decrease Indent Decreases the amount of indentation of

1§l

selected text.

Increase Indent Increases the amount of indentation of

H

selected text.

Templates

The Templates tab contains a list of available report templates that have
been created or loaded to the system. To view a template, click on the
name in the list. The selected template will load to the editing screen,
where you can make changes or preview the printed document. You can
save changes to a template by clicking SAVE TEMPLATE.

If you want to save a template under a different name, click SAVE
TEMPLATE AS and type in a new name. If you want to replace an existing
template, select the name of the template you want to replace in the list
and click OK. You will be asked if you want to overwrite the existing
template.

To delete a template, highlight it in the list and click DELETE. You will be

asked to confirm the deletion. Click OK to delete or CANCEL to cancel the
operation.
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NOTE

Certain characters (| * ~ | & ) cannot be used in transcription templates if you have a
results interface. If these characters are included in your template, the transfer of
reports across the interface will fail.

Sections

The Sections tab contains a list of report sections that may be inserted
into templates. Sections include such items as headers, footers, or tables.
To create a section, start with a blank document and create the section in
the same way you create a new report template. Click SAVE SECTION to
save your work.

If you want to save a section under a different name, click SAVE SECTION
AS and type in a new name. If you want to replace an existing section,
select the name of the section you want to replace in the list and click OK.
You will be asked if you want to overwrite the existing section.

To delete a section, highlight it in the list and click DELETE. You will be
asked to confirm the deletion. Click OK to delete or CANCEL to cancel the
operation.

Tables

The Tables tab contains a list of data tables that may be included in a
template. These tables, when placed in a template, will be automatically
populated with the appropriate data from a procedure. The tables
include:

« Case Procedures: list of all procedures from the Case Details screen.

« Case Resources: list of all resources (staff) from the Case Details
screen.

» Patient Vitals: list of vitals signs recorded during a procedure.

+ Hemo Saturation: list of any oxygen saturation results recorded during
a procedure.

+ Hemo Pressure: list of invasive pressures recorded during a procedure.

« Hemo Cardiac Output: list of thermal cardiac outputs recorded during
a procedure.

+ Hemo Gradients: list of valve gradient data recorded during a
procedure.

* Hemo FFR: list of FFR samples recorded during a procedure.

* Sedation Agents: list of sedation agents administered during a
procedure.
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» Sedation Reversing Agents: list of reversal agents administered during
a procedure.

« Charges: list of patient charges generated during a procedure.

» Procedure Log: list of all charting entries performed during a
procedure.

Names

The Names tab allows you to place specific entries from the Procedures
and Resources tables from the Case Details screen into a template. To add
a name field to a template, position the cursor in the template and then
double click the field.

Signatures

The Signatures tab allows you to insert up to five (5) digital signature
markers for resources assigned to a case. To add a signature marker to a
template, select the resource type, position the cursor in the template
and double click the field (e.g., Physician 1). When the user applies a
digital signature to a report, a signature stamp containing the name of
the person signing, and date and time that the signature was applied will
appear in the report. If a signature bitmap has been assigned to the user,
it will also appear in the report (see section 4.5.3 ‘User Administration’).
If more than one signature marker has been placed in a template,
signatures for each resource must be applied before the report will be
finalized and converted to a PDF.

Addresses

The Addresses tab allows you to insert markers for resources assigned to
a case. When the report is executed, the name and address of the
designated resource will appear in the report.

User demographics must be entered in the user account. See section 4.5.3 User
Administration’.

Scrapers
The Scrapers tab contains a list of available scraper fields, which can be

included in a template. To add a scraper field to a template, position the
cursor in the template and then double click the field.
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Custom Fields

The Custom Fields tab contains a list of all custom forms and their
associated fields, which can be included in a template. To add a custom
field to a template, select the form on which the field appears, position
the cursor in the template and double click the field. To add a charting
menu to a template, position the cursor in the template and then double
click the menu.

Charting

The Charting tab contains a list of current charting menus, which can be
included in a template. If placed in a template, the report will populate
with any charting done during a procedure in the specified menu.

Images

The Images tab contains markers for up to ten (10) still frames, arterial
trees, and waveforms, which can be included in a template. To add an
image to a template, select the type of image to be inserted, position the
cursor in the template and then double click the field. The number
corresponds to the order in which the images were acquired during the
procedure (e.g., Wave 1 would be an image of the first waveform sample
acquired during a procedure, Wave 2 would be an image of the second,
etc.). When a template containing images is selected for a study, any
markers that do not have corresponding images in the study will be
removed from the report.

Data Fields

The Fields tab contains lists of all available database fields, which can be
included in a template. To add a database field to a template, position the
cursor in the template and then double click the field.

Conditional Markers

Conditional markers allow you to designate sections of a template to
appear in a report only when a certain condition is met. For example, you
may have one section of the template that you want to use only when a
right heart catheterization is performed.

GE MaclLab

The GE Maclab tab contains a list of all fields for electrophysiology cases
imported from a GE MacLab system.
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4.3.2

4.3.3

EP Workmate

The EP Workmate tab contains a list of all fields for electrophysiology
cases imported from an EP Workmate system.

Cardiolab

The Cardiolab tab contains a list of all fields for electrophysiology cases
imported from a Cardiolab system.

Bard

The Bard tab contains a list of all fields for electrophysiology cases
imported from a Bard system.

EP tabs will be available only if you have an EP interface.

Transcription Configuration

In order to utilize transcription templates during a procedure, you must
associate the templates with the type of procedure. To access the
Transcription Configuration module, click TOOLS > TRANSCRIPTION >
TRANSCRIPTION CONFIGURATION.

The Transcription Configuration screen is divided into two sections. On
the left is a list of study modalities and their associated procedures (see
section 4.18 ‘Coding’). On the right is the list of transcription templates.

To associate a template with a procedure, click on the template in the list
on the right and drag it to the desired procedure on the left. You may
drag and drop as many templates to a procedure as you want. Once
templates have been associated with a procedure, you may designate
one as the default template by clicking with the right mouse button on
the template name, then selecting Make Default from the list. The

default template for a procedure will be indicated by a green check mark.

To remove a template from a procedure, click with the right mouse
button and select Delete Document. This will not delete the template,
but it will no longer be associated with the procedure and cannot be
accessed during a study (see section 3.3.7 ‘Transcription’).

Transcription Types

Transcription types are used to identify the type of document being sent
across the Xper Connect interface to a facility’s results interface.
To add a transcription type:

1. Enter a description.

Xper Information Management System Release 2-1

Philips Healthcare 453564527351



Philips Healthcare 453564527351

4.4

4.5

4.5.1

2. Select a modality (currently, only X-Ray Angiography is supported).
3. Click ADD.

To edit a type, select it from the list, make the necessary changes, and
click UPDATE.

To hide a type, select the type from the list and click HIDE. If a type is
already hidden, you may redisplay it by selecting it and clicking SHOW.

Registries

This system includes a data collection module for the American College of
Cardiology (ACC) registry, and the Implantable Cardiac Defibrillator (ICD)
registry. The module contains all the fields required by the various bodies
for reporting. You can elect to enter data manually in both registries, or
build data scrapers to complete the fields for ACC and ICD as a study is
charted.

To access any registry, open a study and click REGISTRIES, then select the
appropriate registry from the list. The screens will open, and you can
begin filling in the data, or, if you have built scrapers, the data will be
populated.

Security

User-Centric Navigation

This system stands out from other applications by utilizing user-centric
navigation. That is, the user interface will configure itself to the assigned
role of a user’s account, instead of the traditional “patient-centric” focus
that forces most users into a screen configuration that they do not need
or that presents them with information or functions not applicable to
their job. By having a user-centric focus, this system will help you work
more efficiently by giving you only the tools you need to perform your job
and avoid information overload. User-centric navigation also increases
the security of your system by allowing you to restrict user access to
certain functions by removing them from the user interface when not
appropriate for the user role. To access the Portal Designer, click SYSTEM
> SECURITY > PORTAL DESIGNER.
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User Roles

User roles are the heart of user-centric navigation. This system provides
you with a wide variety of preconfigured user roles which you can fine-
tune for your needs, or you can create your own. Once you have created
and defined a role, you can assign it to users in the User Administration
module (see section 4.5.3 ‘User Administration’). Keep in mind that
creating user roles is not the same as adding users to the system. You
must create your user roles prior to adding users, or use the roles
provided when adding new users.

To create a user role:

1.  Click the ADD button at the bottom right of the screen, below the
User Roles list.

2. You will be prompted to enter a description for the new role, then
click OK to save the new role or CANCEL to discard it.

3. Once you’ve saved the new role, it will appear in the User Roles list,
and you will be prompted to create a Portal Layout.

4. To delete an existing role, highlight it in the list and click DELETE.

Portal Designer

The Portal Designer is the next step toward designing a user-centric
system. You can use the Portal Designer to create custom user roles,
define the functions that will be assigned to these roles, and determine
the layout of the workspace a user sees when logged in to the system, as
well as the functions available on the user’s toolbar.

The first step in creating a Portal Layout is to determine how the
workspace should look. Use the Pane Layout drop-down list to select the
number and configuration of panes (or windows) appropriate to the role,
then use the Pane Contents drop-down list to determine what the
contents of each pane will be. For example, users assigned as Scheduler
may need to see the Schedule viewer, the Basic Search screen, and Room
Usage information, while an IT role might need only System Status or
Users Logged On.

If you would like to designate the Study Scheduler as read-only for a
particular role, check SCHEDULER VIEW ONLY. Any user assigned a role
with this setting will be able to view the Study Scheduler, but will not be
able to make changes.

To assign content to a pane, select the item in the Pane Contents drop-

down list, then click and drag the selected item to the pane in which you
want it to appear. Click SAVE to save the layout, or CLEAR to start over.
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Some of the pane contents items contain columns. You can choose to
hide or display particular columns within a pane. Clicking the COLUMN
SELECTOR button will open a list of the available columns for the selected
content. To hide a column, uncheck the box next to the column title. To
display a column, mark the box with a check. You can adjust column
order by clicking on a column header and dragging and dropping it in its
new location.

You can duplicate an existing user role’s settings under a new name, and
adjust the settings for the new, similar role. To do this, click DUPLICATE,
then give the “new” role a name and click SAVE. You can then adjust the
layout and contents as needed, and save again when you're ready.

Menu Bar Builder

Once you’ve determined how the workspace will look for a role, you
must create a toolbar layout to match. A user toolbar contains navigation
tools, such as LOGOUT, and permits access to the other modules within
Xper, such as Inventory, Transcription utilities, System tools, or
Scheduling.

To create toolbars, highlight the desired user role and click the MENU
BAR BUILDER tab. You’ll notice several toolbar type selections at the top
of the screen: MAIN, CASES, and CASES (QUERY). The Main toolbar is the
one a user will see when first logging into the system. The Cases toolbar
is what a user will see when he has opened a case.

Underneath the toolbar types is the toolbar functions tree. This is where
you decide which buttons will be available on a given toolbar for the user
role. Functions marked with a green check will be available on the
toolbar, while functions marked with a red “X” will not appear.

You can restrict user access within a given module to individual functions
within the module. For example, the Scheduler module has four main
functions, Study Scheduler, Staff Scheduler, Staff Work Hours and Room
Staffing. You can restrict a user to accessing only the Study Scheduler by
marking it with a green check, and marking the other three screens with
ared “X”. When the user clicks the Scheduler button on the main toolbar,
the only associated function he can select will be Study Scheduler.

The SAMPLE LAYOUT section will show you how the toolbars you create
will appear to a user assigned to the selected role. When the main
toolbar and any appropriate modality toolbars are arranged to your
liking, click the SAVE button to save your toolbar configurations.
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Password Management

The Password Management module allows you to perform operations
such as setting username and password lengths and characteristics,
specify how long a password history will be kept, and set user lockout
limits. This module is closely related to the User Administration module.
To access password management, click SYSTEM > SECURITY > PASSWORD
ADMINISTRATION.

User Name Settings

On this screen, you set the minimum and maximum character lengths for
usernames. The minimum length has a range of 3 — 10. The maximum
length has a range of 3 — 20.

System Password Settings

On this screen, you maintain various settings for system login passwords.

The fields and their functions are specified in the following tables:

Field
Minimum Length

Maximum Length

Minimum Digits

Minimum Letters

Passwords are Case
Sensitive

Minimum Upper Case
Letters

Minimum Lower Case
Letters

Force Password
Expiration

Passwords Expire Every
(Days)

Definition

Specifies the minimum number of characters
(letters, numbers, and symbols) for a system login
password. The range is 3 — 15.

Specifies the maximum number of characters for a
system login password. The range is 3 — 20

Specifies a minimum number of digits that must be
included in a system login password. The range is 0
- 4.

Specifies 2 minimum number of letters that must

be included in a system login password. The range
is 0 — 20.

Check if you want passwords to be case sensitive.

Specifies the minimum number of upper case
letters for a case-sensitive system login password.
The range is 1 - 20.

Specifies the minimum number of lower case
letters for a case-sensitive system login password.
The range is 1 - 20.

When checked, forces password expiration of a
set interval for all users in the system.

Sets the interval for system-wide password
expiration. The limit is 30 — 90 days.
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Field
Enable Password History

Password History is Kept

for (Months)

Enable User Lockout

Lock out users after
(failed login attempts)

Do not allow login for

Lock out all users now

Enable User Password
Clues

Definition

When checked, keeps a history of user passwords
for a specified interval.

Sets the interval for retention of password history.
The limit is 1 — 60 months.

Activates the user lockout feature. Users who
attempt to log in with an incorrect password will

be locked out after a specified number of attempts.

Specifies the number of attempts a user can make
with an incorrect password before the user
account is locked.

Sets the amount of time (in minutes) that a user
account will be locked after a specified number of
failed attempts.

When checked, initiates a system-wide lockout.
No users may log in while this is active.

When checked, activates the “Forgot Password”
function. Users who have forgotten their
passwords will be prompted to answer the System
Password Clue Question entered in their user
profile (see section 4.5.3 User Administration).

Signature Password Settings

On this screen, you maintain various settings for signature passwords.
The fields and their functions are specified in the following tables:

Field
Minimum Length

Maximum Length

Minimum Digits

Minimum Letters

Passwords are Case
Sensitive

Xper Information Management System Release 2-1

Definition

Specifies the minimum number of characters
(letters, numbers, and symbols) for a signature
password. The range is 3 — 15.

Specifies the maximum number of characters for a
signature password. The range is 3 — 20

Specifies 2 minimum number of digits that must be

included in a signature password. The range is 0 —
4.

Specifies a minimum number of letters that must
be included in a signature password. The range is 0
- 20.

Check if you want passwords to be case sensitive.
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Field Definition

Minimum Upper Case Specifies the minimum number of upper case

Letters letters for a case-sensitive signature password. The
range is 1 - 20.

Minimum Lower Case Specifies the minimum number of lower case

Letters letters for a case-sensitive signature password. The
range is 1 - 20.

Force Password When checked, forces password expiration of a

Expiration set interval for all users in the system.

Passwords Expire Every Sets the interval for system-wide password

(Days) expiration. The limit is 30 — 90 days.
Enable Signature Password VWhen checked, keeps a history of user passwords
History for a specified interval.

Password History is Kept ~ Sets the interval for retention of password history.
for (Months) The limit is 1 — 60 months.

Enable Signature Password When checked, activates the “Forgot Password”

Clues function. Users who have forgotten their
passwords will be prompted to answer the
Signature Password Clue Question entered in
their user profile (see section 4.5.3 User
Administration)).

After changes to any of the screens, click SAVE to accept the changes. If
you make changes and forget to click SAVE, you will be prompted to save
or discard changes when you close the Password Management module.

User Administration

The User Administration module allows system administrators to create
and maintain the security settings for individual users in the system. User
Administration is closely tied to the other security modules, Portal
Designer and Password Management. It also allows an administrator to
see security settings for any user at a glance and to create and maintain
physician groups. To access User Administration, click SYSTEM > SECURITY
> USER ADMINISTRATION.

User Settings

The list of current users appears on the left. At the bottom of the list are
several filter tools that can be helpful when maintaining users. There are
alphabetical tabs and an ALL tab, which will display the entire list of
users. The FILTER LIST BY section allows you to filter the user lists by user
type. You can also click on the title of any column to sort the list in
ascending or descending order for that column.
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To the right, the User Settings screen is used to enter information about

the user and to set passwords. At the top right are the controls for adding
and deleting users. To create a new user, click ADD USER. This will clear

the User Settings screen and assign a new User ID number. Fill in the rest
of the user data and click SAVE to save the changes. If you forget to click
SAVE, you will be asked to save changes when you close the User
Administration module. The fields and their functions are specified in the

following tables:

User Settings
User ID

User Name
Login Allowed

Allow System
Configuration

Last Name
Mi

First Name
Title

User Type
Physician ID

Physician UPIN
Show Only Patients

Transcription Signature
Override

Physician Groups

Assigned Groups

>ADD
< REMOVE

Xper Information Management System Release 2-1

Description

This number is automatically assigned by the
application when you click ADD USER.

Enter the user’s login name here.
Enables login for the user account.

Gives the user access to the Configuration Screens
module.

The user’s last name

The user’s middle initial (optional)

The user’s first name

The user’s professional title, if any (optional)
Assigns a user resource type

This field can be used to enter a physician’s license
number or other identifier (optional)

Unique Physician Identification Number field

When checked, the physician will see only his/her
patients

When checked, allows a physician to sign a
transcription report as proxy for another
physician.

A list of groups to which a physician can be
assigned (see section 4.5.3 User Administration).
When physicians are assigned to a group, only
patients belonging to the group will be visible
when the physician logs in to Xper Information
Management.

Displays the group to which a physician is currently
assigned

Adds a group to the Assigned Groups list

Removes a group from the Assigned Groups list
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System Password Settings

System Password Change
Next Login

Validate Macro Security

System Password
Expiration

System Password

System Password (Verify)

System Password
Expiration Days

System Password Clue
Question

System Password Clue
Answer

Signature Password
Settings

Use Signature Password

Signature Password
Expiration

Signature Password
Lock Study

Unlock Study

Signature Password
Expiration Days

Signature Password Clue
Question

Signature Password Clue
Answer

Definition

When checked, prompts the user to change his/
her system password on the next attempt to log in

Gives the user privileges to create, edit and delete
recording macros

When checked, user’s password will expire after a
designated interval

Enter the user’s system password

Re-enter the user’s system password for
confirmation

Sets the interval for the system password
expiration period (30 - 180 days)

Enter a question that the user must answer when

resetting a lost or forgotten system password

Enter the response the user must provide to the
System Password Clue Question

Definition

Check this box if you want to assign a unique
password for applying digital signatures.

Check this box if you wish to set an expiration
limit on a signature password.

Enter the user’s signature password here.

When checked, gives the user rights to lock a
study so that no changes can be made to the
patient data, and sets the Case Finalized flag and
date

When checked, gives the user rights to unlock a
study that has been locked

The interval (in days) after which a user will be
asked to enter a new signature password. The
interval can be set from 30 to 180 days.

Enter a question that the user must answer when
resetting a lost or forgotten signature password.
Enter the response the user must provide to the
Signature Password Clue Question.
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To delete a user account, highlight it in the list on the left and click
DELETE USER. You will be prompted to click YES to delete the user
account or NO to cancel the deletion.

User Demographics

The User Demographics screen stores data such as mailing address,
telephone and cell phone number, fax and pager numbers, and e-mail
address. Enter any desired data and click SAVE to record the information.

A signature bitmap may be attached on this screen to a user account. If
you have a bitmap of a physician’s or other staff member’s signature,
right click on the Signature field, click LOAD, browse to the location of the
bitmap, and double click the file. The image will appear in the Signature
field. When the user applies a digital signature to a transcription report,
the image will be inserted at the place in the template where a signature
marker has been inserted (see section 4.3.1 ‘Transcription Builder’).

User Roles

On this screen, you assign the roles created in the Portal Designer to the
individual users. You can assign just one role, or a user could have
multiple roles. Whatever the number of roles assigned to a user, you
must specify a Primary User Role. This is the default role the user will see
when he logs in to the system. If a user is assigned more than one role,
he can switch roles after logging on by using the User Roles drop-down
list at the bottom of the main screen.

The available user roles appear in the list on the right. To assign a role,
highlight it in the Available Roles list and click < ADD. If you want to create
a “super user” who is assigned to all available roles, click the << ADD ALL
button. Once you have assigned at least one role to a user, it will appear
in the Primary User Role list. If a user has been assigned more than one
role, use the Primary User Role drop-down to choose which of the
assigned roles will be the user default. If you want to remove an assigned
role, highlight it in the Assigned Roles list on the left and click > REMOVE.
Once you are satisfied with the list of assigned roles, click APPLY. Use
CANCEL to start over.

Checking the box next to ALLOW CASE HISTORY CRITERIA CHANGE will
allow the user to set criteria for linking historical cases (see section 4.24
‘Patient Historical Links’).
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NOTE

Repositories

The Repositories section allows you to assign user access to specific data
repositories within the Xper Information Management database. To grant
access, place a check next to the repository name. When the user logs in
to Xper Information Management, only the designated repositories will
be available. Checking GLOBAL USER gives the user access to all available
repositories. When a user logs in, the repository will default
automatically to the last repository the user had accessed. If a user is
given access to multiple repositories, he can access a different repository
after logging on by using the Repositories drop-down list at the bottom
of the main screen.

LDAP Settings

The LDAP Settings tab allows you to associate an Xper Information
Management user account with the user’s LDAP (Light Directory Access
Protocol) account. If your system is configured to use LDAP
authentication, enter a valid domain and username in the LDAP
Username field, typing a slash between (e.g., domain\username). When
you log in to Xper Information Management, you then may enter your
Windows username and password.

Macro Validation Security

Xper Information Management workstations that are paired with Xper
Flex Cardio Physiomonitoring systems may be configured to require the
entry of a username and password to save or delete monitoring macros.
In order to enable macro validation security, you must activate the
function for each user, and also enable the security check on each
workstation:

1. In User Administration, for each user to whom you want to assign
macro privileges, check Validate Macro Security on the User
Settings tab.

2. On each workstation where macro security will be required, check
Validate Macro Security on the System Setup tab of the
Configuration Settings screen.

After enabling macro security on a workstation, any user who attempts
to save or delete a monitoring macro will be prompted for a username
and password. If the user has not been assigned the privilege in User
Administration, the user will not be permitted to save or delete the
macro.

Macro security must be enabled on the workstation. If macro security is not enabled
on a workstation, any user may save or delete macros without being prompted for
username and password, regardless of the user account settings.
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4.5.5

NOTE

4.5.6

Physician Group Administration

Physician groups give an additional layer of security to patient
information. When physicians are assigned to a group, only studies
performed by physicians assigned to the same group will be available in
the patient lists.

If no group is assigned, a user will be able to access any patient unless additional
security is applied (see section 4.5.3 ‘User Administration’, for information on
applying the Show Only Patients filter).

Use this screen to maintain the list of physician groups (see section 4.5.3
‘User Administration’). A physician group can be a professional group, a
departmental group, or a group you create. To create a group, enter a
name or other identifier in the GROUP field. Enter an optional description
in the GROUP DESCRIPTION field. Click SAVE to add the group to the list.
If you want to clear the fields without saving, click the CANCEL button.
You can edit existing groups by double clicking on the Group name in the
list. Make the desired changes and click SAVE.

To delete a group, highlight the item in the list and click DELETE. You will
be prompted to click YES to delete the group, or NO to cancel the
deletion.

System Password Reset (Forgot Password)

The application has a “Forgot Password” function that will allow a user to
create a new system password if necessary. To reset a lost or forgotten
system password:

1. Onthe login screen, enter your user name and click FORGOT
PASSWORD.

2. You will be prompted to enter the answer to your system security
guestion. Enter the response and click SUBMIT.

3. Enter your new password, then re-enter the password a second time
for confirmation. If the two entries do not match, you will be
prompted to retype your new password.

4.  Click SUBMIT. You will receive a confirmation that your password has
been successfully reset.
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4.6.1

Inventory Management

Effective inventory management plays a crucial role in the smooth and
efficient running of any organization. Inventory control for your
department, procedure suites, or facility can be performed by tracking
inventory as it is received, moved and issued. You will be able to quickly
perform physical inventory and cycle counting, or receive system alerts
when inventory levels are getting low. Track disposable supply levels and
use barcodes to expand your data entry capabilities. The entire inventory
function is seamlessly integrated within the menu structure (see section
3.3.1 ‘Charting a Procedure’). As items used are charted into a case, your
inventory is decremented automatically. The Inventory Module can
import a supplies list from an Excel file and will interface with supply
cabinets such as Pyxis and Omnicell.

Inventory Overview

The Inventory Overview screen allows you to view all active or inactive
inventory items, as well as specific information pertaining to each item,
such as part number, location, serial number, quantity at hand, barcode
value, expiration date, and so on. In this screen, you may perform
searches by multiple criteria, build and view orders, and generate preset
reports to either view on screen, print out, or export to MS Excel. To
access Inventory Overview, click MODULES > INVENTORY > OVERVIEW.

Dragging and Dropping Column Headers

You can adjust Inventory column order by clicking on a column header
and dragging and dropping it in its new location. Once you have arranged
Inventory columns, click SAVE GRID SETTINGS.

Grouping by Columns

You can drag a column header to the top of the list in order to group
items by that category. You can also drag more than one header if you
want to create subgroups. For example, if the Location column is dragged
up to this position, all items will be grouped by location. Dragging the
Mfg Name header will create a subgrouping under Location. Drag the
column headers off to the left to undo the grouping.

You can choose to hide or display particular columns within a pane.
Clicking COLUMN SELECTOR will open a list of the available columns for
the selected content. To hide a column, uncheck the box next to the
column title. To display a column, mark the box with a check. You may
also seen this feature in other modules.
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Clicking on COLUMN SELECTOR at the top left corner of the Search
Results list displays a list of available columns. Column order, column size
and contents can be arranged and saved, permitting you to organize the
display as you desire. Use the scroll bar on the right to see the complete
list of available columns. Check the column headers you wish to display,
and uncheck headers you don’t want. When you have finished, click on
the top left square of the Search Results again o hide the column list.

Click SAVE GRID SETTINGS to save changes to your column format. The
format you select will appear the next time you access the Inventory
Module. However, the Under Par Row Color is a global setting activated in
the system configuration screen. You may change the color while in
Inventory, but it will revert to the global system configuration setting the
next time you enter Inventory.

Searching Inventory

Search for items by specifying values in the Input Inventory Search
Criteria section and clicking SEARCH. You may also select the number of
items displayed in the search result by selecting a choice in the Max # of
Records drop-down list. Clicking on any column header will sort the fields
by that header. Items highlighted in red are those whose total quantities
are below their par value. To highlight these items in a color other than
red, select a different "Under Par Row Color" using the drop-down box
located directly above the search results to change the color of the
highlighted rows. You can use “Wildcard Search” when attempting to find
something. If you place a “%” before or after a partial search string and
click SEARCH, the application will search for any items that fit the criteria.
The fields and their individual functions are listed in the following table:

Field Description
Bar Code Internally generated barcode number
Mfg Bar Code Manufacturer’s barcode number

Item (Active)

Item (Under Par)

When checked, only items marked as Active are
displayed.

When checked, only items whose quantities are
below a desired quantity on hand are displayed.

Location The location where an item is stored.

Part Number A required field for each item. May be an internal
number or the manufacturer’s part number.

Mfg Part Number The manufacturer’s part number.

Expiration Date From
Expiration Date To

Serial Number

Xper Information Management System Release 2-1

Specifies a starting expiration date for a search range
Specifies an ending expiration date for a search range

Manufacturer’s serial number
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NOTE

Field Description

Lot Number Manufacturer’s lot number

Max # of Records Specifies the maximum number of results to be
displayed. Selections include 100, 500, 1000, or ALL.

Manufacturer Name Item manufacturer or vendor

Exporting to Excel

The EXPORT button will save the contents of any screen to a Microsoft®
Excel file. The default Save In location is your My Documents folder,
although you may specify any other location. Export to Excel will include
data for all selected columns and will contain all column headings.

Excel must be installed on your computer in order to use this function.

Adding and Editing Inventory Items

To add a new item, click ADD NEW. The Item Maintenance screen will
open, where you can enter information including the item name, cost,
packaging, vendor and manufacturer details as well as barcode
information. Required fields are indicated in bold print. The Quantity in
Stock field is not enabled. You will be prompted to set a Cycle Count Class
and to receive the item once you click SAVE. Receiving an item will
activate the Quantity in Stock field.

The Type designation indicates whether an item is general stock,
diagnostic equipment, or interventional equipment. If you have a Results
interface, all items in your inventory must be designated as the correct
type. If you do not have a Results interface, Type is not required, but
recommended.

To edit an existing item, double click on the item to be edited. This opens
the Item Maintenance screen for the selected inventory item. Make your
modifications and click SAVE to record or CANCEL to discard the changes.

Ordering Inventory Items

Clicking ORDER brings up the Inventory Order screen. To place an order:

1.  Enter the manufacturer name and select the part number from the
drop-down list.

2. Select the Order Unit. If you did not specify an Order Unit when
adding the item, the only option under the order unit field will be
EACH (Individual item).

3.  Order the number of items requested in the order under Order Qty.

4.  Click INSERT LINE.
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To add more orders, click CLEAR CRITERIA to reset the fields.

When you have finished placing your order, click SAVE ORDER. The
order will display in print preview.

You can select PRINT or click CLOSE to exit.

You can keep track of order information and status or modify existing
orders on the View Orders tab.

Receiving Inventory Items

You can receive items into inventory from the Inventory Overview screen
by double clicking the item to open the Item Maintenance window:

1.
2.

Click RECEIVE to begin.

Select the storage location from the drop-down list, then enter the
quantity. If you must enter a lot number and serial number for
individual items, set the quantity to 1 and enter the numbers,

If the item you are receiving is checked as an implantable item and
has an additional barcode containing information such as lot
number, serial number, or expiration date, scan that barcode into
the Attribute Bar Code field. This will ensure that, when the item is
scanned during a procedure, the correct item is removed from
inventory.

Click SAVE.

You can also indicate an expiration date. If you don’t have to enter
lot or serial numbers, enter all other information, then click SAVE.

To enter a new location:

1.

Click the ellipse button next to the drop-down list. The Location
Maintenance screen will be displayed.

Enter a location name, a brief description (optional) and section
(optional).

Click SAVE NEW.

To edit a location, highlight it in the list and click UPDATE. To delete a
location, highlight the location and click DELETE. If the location is
assigned to active inventory items, you will not be able to delete it until
you have indicated a different location for these items.

Xper Information Management System Release 2-1 4-37



4-38

4.6.2

It may also be helpful to receive items into inventory from the Orders
section so you can verify whether you received a complete or partial
shipment. If a partial shipment was received, the order can be modified.
Iltems can be placed on back order, and an expected date of delivery can
be inserted for your records. Remember to click SAVE if you have
received or modified an order.

Deleting Inventory Items

In order to delete an item, highlight the item in the Inventory Overview
list and click DELETE. You will be prompted to click YES to delete or NO to
cancel. The item record is not actually deleted, but instead has been
made inactive. You can review inactive items by unchecking the Active
box and clicking SEARCH. If you have accidentally deleted an item, you
can restore the item to current inventory by opening the item record and
rechecking Active in the Item Properties section.

Reports

The Inventory Overview screen allows you to view and print some preset
reports. Click the Reports drop-down list to specify the type of report to
be generated:

Items: Displays a report of all items in the search results list, arranged by
manufacturer.

Below Par: Displays a report of items under par, arranged by
manufacturer. Items under par are highlighted by color in the search
results.

Location Inventory: Displays a report of items arranged by location.
Items that have not been assigned a location will be displayed first on the
report.

Expiration Aging: Displays a list of items with expiration dates, arranged
by location.

To print a report, select the type, enter desired search criteria, and click
SEARCH. The PREVIEW and PRINT buttons will become active. To view the
report prior to printing, click PREVIEW. To print the report, click PRINT.

Inventory Maintenance

There are several tools available to help you maintain all aspects of your
inventory, from items to categories, manufacturers, vendors, cycle
counting, and locations. To access the maintenance screens, click
MODULES > INVENTORY > MAINTENANCE and select the appropriate
screen from the list.
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Item Maintenance

The Item Maintenance screen contains all data about a specific inventory
item. You can access the Item Maintenance screen by clicking on an item
in the Inventory Overview list. This will display the properties for that
item. The controls for performing maintenance on an item appear at the
top of the screen. The specific controls and their functions are listed in
the following table:

Button Description

Add New Adds a new item.

Edit Edit information for an existing item

Receive Activates the fields in the Receiving/Putaway section.
Transfer Activates the fields in the Transfers section.

Delete Deletes an item.

Cancel Cancels any operation without saving.

Save Saves any modifications.

Within the Item Maintenance screen, the different categories of
information are grouped into several sections. The Identification section
contains information about the item itself. The fields and their functions
are listed in the following table:

Field Description

Part Number A unique identifying number. This can be a facility-
(Required) generated number or the manufacturer’s part number.
Mfg Part Number The manufacturer’s part or catalog number
Manufacturer The manufacturer of the item

(Required)

Vendor Allows you to indicate a preferred vendor, if you do

not order an item directly from the manufacturer

Item Name (Required) The name of the item

Item Description A brief description of the item

Mfg Bar Code The manufacturer’s barcode

Bar Code An internally generated barcode

Categories Used by the Menu Builder when adding Inventory
Items to menus (see section 4.12 ‘Menu Builder).

Category List A list of all categories to which an item belongs

Type Used to specify whether the item belongs to a

General, Diagnostic or Interventional equipment
group. Default is General.
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To add a manufacturer or vendor, click the ellipse button next to the field.
This will open the Manufacturer Maintenance or Vendor Maintenance
screen. You may add a category to the Categories list, as well (see section
4.6.2 ‘Inventory Maintenance’).

The Pricing section contains information about costing. The fields and
their functions are listed in the following table:

Field Description

List Cost The manufacturer’s suggested retail price

Cost The cost to your facility

Patient Cost The cost charged to the patient

Charge Code Will appear on the patient’s bill

Chargeable Denotes whether or not an item is chargeable. If not

checked, the item will be maintained in Inventory, but
will not appear on patient bills.

Category Code (C- Device category code. Determining which category
Code) code is applicable for a specific item will be the
responsibility of the billing facility.

The Properties section contains information such as whether an item is
currently used, consignment status, etc. The fields and their functions are
listed in the following table:

Field Description

Active Item is currently in use.

Consignment Item is used on a consignment basis.

Ciritical Item is considered critical to the department and

should not go under par.

Evaluation Item is being evaluated for inclusion in active
inventory.

Investigation Item is part of a research or clinical trial.

Non Stock Item is not routinely stocked in the department and is

being used during a procedure.
Stocked in Lab Stock is kept in procedure room.
Implantable Stents, ICDs, pacemaker generators, leads, etc.
If you have assigned the Implantable attribute to an item, you will be

prompted during charting to enter the item’s lot number, serial number,
and/or expiration date (see section 3.3.1 ‘Charting a Procedure’).
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The Packaging section allows you to indicate the order unit for an item. In
many cases, items are ordered in bulk quantities, although they may be
dispensed as individual items from inventory. The fields and their
functions are listed in the following table:

Field Description

Qty Per Case Quantity of items in a case
Qty Per Box Quantity of items in a box
Qty Per Pack Quantity of items in a pack

The Print Barcode Labels section allows you to print internally generated
bar codes onto labels which can then be placed on the product. The fields
and their functions are listed in the following table:

Field Description

Labels to Print Specify the quantity and size of the labels.

Formats Specify the type of barcode that will be printed o the
labels.

To generate an internal bar code for an item, click BARCODE in the
Identification section. Once a barcode has been generated, the BarCode
Labels button becomes enabled. Clicking on this button section activates
the remaining fields in the section and causes the PREVIEW and PRINT
buttons to appear at the top of the screen. You may then specify the
quantity, size, and format of the labels to be printed. Two formats of
Avery labels are currently supported. To preview the label sheet, click
PREVIEW. To print, click PRINT.

The Inventory/Ordering section of the screen contains information such
as the quantity currently in stock, quantity on order, and the date of the
last order for that item. The Reorder Level is the level of stock at which an
item should be marked for reordering. Min Order Qty specifies the
smallest amount to order at a time when building a new order for the
item. If you know how many days it takes to fill an order, you can enter
that information in the Order Lead Time field. The fields and their
functions are listed in the following table:

Field Description
Quantity in Stock The amount of stock currently on hand.
Issue Unit Indicates the number of units issued from stock when

an item is used.
Last Order Date The most recent date the item was ordered.

Qty on Order The amount of the item currently on order.
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Field Description

Max Quantity The maximum desired amount of stock for the item.

Order Unit Specifies whether an item is ordered by Each, Case,
Box, or Pack. Refer to the Packaging section.

Order Lead Time The time in days necessary to complete an order.

Reorder Level Indicates the Par amount. When an item’s Quantity in

Stock drops below this number, the item will be
highlighted in red on the Inventory Overview screen.

Min Order Qty The smallest amount of the item that should be
ordered.

Critical Quantity The amount of an item that must be in stock at any
given time.

In the event that you perform cycle counting, the Cycle Counting section
is where you specify the cycle count class of the given item (see section
4.6.2 ‘Inventory Maintenance’). The fields and their functions are listed in
the following table:

Field Description

Cycle Count Class A, B, or C, depending on the Cycle Count frequency

Last CC by Item Displays the last time a Cycle Count by Item was
performed on the selected item.

Last CC by Location  Displays the last time a Cycle Count by Location was
performed on the selected item.

Last CC by Item w/ Displays the last time a Cycle Count by Item with
Attr Attributes was performed on the selected item.

The Receiving/Putaway section contains information regarding an item’s
storage location, serial and lot numbers, and expiration dates (see section
4.6.2 ‘Inventory Maintenance’). The fields and their functions are listed in
the following table:

Field Description

Receive Item Into Specify the location that the item will be stored.

Qty To Receive The amount being stored at the stated location.

Lot Number A number provided by the manufacturer for tracking
purposes.

Expiration Date Expiration date of the item, if applicable.

Serial Number A unique number given to an item.
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The Transfer section allows you to transfer items from one storage
location to another. The fields and their functions are listed in the
following table:

Field Description

Transfer Amount Specify whether the Entire Quantity or Partial
Quantity of an item is to be transferred

Location Qty The desired amount of items to be transferred, if
Partial is selected.

From Specify the current location of the items to be
transferred.

To Specify the destination of the items to be transferred.

The Miscellaneous section contains information about item
substitutions. The fields and their functions are listed in the following
table:

Field Description

Substitute Part Exists  Denotes whether a similar item may substituted for
the currently selected item.

Substitute Information Information regarding the use of a substitute part.

Comments Enter additional notes or comments.
Category Maintenance

Inventory categories are designed to group similar inventory items and to
link items with charting in menus (see section 3.3.1 ‘Charting a
Procedure’). Inventory items may belong to more than one category. An
item can be placed in a category in the Item Maintenance screen or
added from the Category Maintenance screen. The category is then
associated with inventory items in the menu builder (see section 4.12
‘Menu Builder’). You can create categories by vendor or size, it’s really up
to you, but keep in mind if the categories are too general they may
generate a large charting detail list (see section 3.3.1 ‘Charting a
Procedure’). You may also export your category list to Excel by clicking the
EXPORT button.

Adding, Editing or Deleting a Category

To add a category, access the Category Maintenance screen. Type a name
in the Category field and, if you want, a brief description, then click SAVE
NEW. Your new category will appear in the list.

To edit an existing category, highlight the category in the list, make
changes and click UPDATE to save the changes.
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To delete a category, highlight it in the list and click DELETE. You will be
prompted to click YES to delete the category and all associated items, or
NO to cancel. The items will not be deleted from inventory, only the
category and its associations.

Adding Items to a Category

There are two ways to add items to a category. The first is to associate an
inventory item with a category when you add the item to inventory:

1.  Click the Categories drop-down list and select the category.

2. Click the + key to associate the item with that category, which will

appear in the Categories list.

You may associate an item with multiple categories. If you find that you
need to create a new category with which to associate an item, clicking
the ellipse button will open the Category Maintenance screen.

The other option is to add items to a category from the Category
Maintenance screen:

1. Click on a category in the list to highlight
2. Click the Part Number drop-down list and select a part number.
3.  Click SAVE NEW to add the item to the category.

4.  Clicking the ellipse button next to the Part Number drop-down list
will open the Inventory Overview screen.

Once you have added items to a category through either method, you can
view the associated items by clicking the + next to each category to
expand the list of items.

Deleting Items from a Category

Deleting items from a category can also be done from the Category or
Item Maintenance screens. To delete an item from a category in the
Category Maintenance screen, expand the category items list, highlight
the item you wish to delete, and click DELETE. You will be prompted to
click YES to delete the item from the list, or NO to cancel.

To disassociate an item from a category from the Iltem Maintenance
screen, highlight the category in the Categories list and click the - key.
Click SAVE to accept the changes or CANCEL to cancel the operation.
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Cycle Counting Maintenance

A cycle count is an inventory management procedure where a small
subset of inventory is counted on any given day. Cycle counts differ from
traditional physical inventory counting in that a physical inventory count
stops operation at a facility until all items are counted, audited, and
recounted. Cycle counts are less disruptive to daily operations, provide an
ongoing measure of inventory accuracy and procedure execution, and
can be tailored to focus on items with higher value or movement.

Ranking items into A, B, and C groups—either by value or volume—
should be the basis for cycle counting schedules. As a sample
configuration, inventory items belonging to group A could be counted
once or twice a month, B items once or twice per quarter, and C items
once or twice per year. Scheduling cycle counts can be done on the
Configuration Settings screen.

Cycle Counting Overview

The Overview screen allows you to view existing cycle counts without
making changes to the data. By entering data into the appropriate search
criteria fields, you can search for certain cycle counts. To list all cycle
counts, click SEARCH without inputting any search criteria. Note that
cycle counts are not generated from the overview screen.

As is the case with many search results pages, you may group cycle
counts by any column or series of columns by clicking and dragging
column headers to the blue section labelled “Drag a column header here
to group by that column.” You can sort in ascending or descending order
by clicking the column header. The search criteria fields and their
functions are listed in the following table:

Field Description

Repository Allows you to review cycle count information for a
specific repository.

Bar Code Barcode number assigned to inventory item by the
internal barcode generation feature.

Mfg Bar Code Manufacturer’s barcode number.

Manufacturer Name Name of the manufacturer.

ltem Name of the item.

Part Number A unique identifying number. This can be a facility-
generated number or the manufacturer’s part
number.

Mfg Part Number The manufacturer’s part or catalog number.

Location The physical location where the item is stored.
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Field

Serial Number
Lot Number
Exp Date From
Exp Date To

Scheduled From

Scheduled To

Report Number

Completed From

Completed To

User Name
Max # of Records

Status

Type

Description

Manufacturer’s serial number

Manufacturer’s lot number

Specifies a starting expiration date for a search range
Specifies an ending expiration date for a search range

Specifies a starting scheduled cycle count date for a
search range

Specifies an ending scheduled cycle count date for a
search range

The cycle count report number

Specifies a starting completed cycle count date for a
search range

Specifies an ending completed cycle count date for a
search range

The user who scheduled the cycle count.

The maximum number of records that will be
returned once the Search button is clicked.

CAN (canceled cycle count)

CMP (completed cycle count)

DIS (discrepancy in cycle count)

NEW (new cycle count available)

RCT (recount scheduled due to discrepancy or ltem
attribute)

REP (report generated and available for cycle
counting)

Item (returns all items),

Location (returns all items, separated by location),
Item with Attributes (returns all items, separated by
location, lot number, serial number, and expiration
date)

To perform a search, enter the desired criteria and click SEARCH. CLEAR
CRITERIA will reset all fields.

You may print your search results as a worksheet for performing a cycle
count, or as a final report after adjustments have been made. To preview
the report, click PREVIEW, and click PRINT to print.

You may also export your search results to an Excel spreadsheet by

clicking EXPORT.
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Cycle Count Generation

You can generate cycle counts on the Generation tab. By default, the
Auto radio button is selected, so all criteria fields are inactive. To
generate a cycle count:

1.  With the Auto option selected, choose a type of report from the

Type drop-down box (Item, Location, Item w/Attr).

2. If you want to generate a cycle count for different repository than
the one you logged into, select the repository from the drop-down

menu.

3. Click AUTO GENERATE to generate the cycle counts, which will be
displayed in the lower half of the screen.

To manually generate cycle counts, click on the Manual radio button. This
will deactivate the AUTO GENERATE button and enable all of the
previously inactive Criteria fields. In addition to selecting a Type of
report, you can then specify as many additional criteria as desired to
search for the specific items you wish to count before clicking on
MANUAL GENERATE to create a filtered list of cycle counts. A wild card
can be used by inserting “%” before or after your search criteria. To
remove an unwanted item from the list of pending cycle counts, select
the row containing the item, then click REMOVE. Once all of the
unwanted items have been removed, click SAVE to save the report for use
on the Confirmation tab, or click EXPORT to save the report as an Excel
spreadsheet. The search criteria fields and their functions are listed in the

following table:

Field
Repository

Bar Code

Mfg Bar Code
Item
Location

Part Number

Mfg Part Number
Exp Date From
Exp Date To

Serial Number

Xper Information Management System Release 2-1

Description

Allows you to select a specific repository in which to
generate a cycle count.

Barcode number assigned to inventory item by the
internal barcode generation feature.

Manufacturer’s barcode number.
Name of the item.
The physical location where the item is stored.

A unique identifying number. This can be a facility-
generated number or the manufacturer’s part
number.

The manufacturer’s part or catalog number.
Specifies a starting expiration date for a search range
Specifies an ending expiration date for a search range

Manufacturer’s serial number
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Field Description

Lot Number Manufacturer’s lot number

Max # of Records The maximum number of records that will be
returned once SEARCH is clicked.

Manufacturer Name Name of the manufacturer.

Type [tem (returns all items),

Location (returns all items, separated by location),
Item with Attributes (returns all items, separated by
location, lot number, serial number, and expiration
date)

Cycle Count Confirmation

After a cycle count list has been generated and saved, you can specify
assorted criteria for retrieving available, non-completed cycle count
reports on the Confirmation tab. Clicking SEARCH without specifying any
criteria will display the complete list of available cycle counts. Click
GENERATE to create a worksheet for counting the items. The report will
contain the names and locations of each item, the expected (Original)
guantity on hand at each location, and a column where you can write the
actual (or Audit) quantity for each item.

If you find discrepancies between the expected and actual quantities of
an item:

1.  Enter the Audit quantity in the column next to the item on the
Confirmation tab.

2. When you have made all necessary adjustments, click SAVE. You will
be prompted: “Would you like to generate a report before saving
Audit Quantities?” Click YES to about the save so you can generate a
report, or NO to continue.

3. You will then be prompted: “Have you adjusted the audit quantity
on each row for discrepancies?” Click YES to continue or NO to
cancel the operation. If you have adjusted the quantity for an item,
you must proceed to the Discrepancy/Adjustment tab to complete
the cycle count.

Cycle Count Discrepancy/Adjustments

If you have found and entered audit quantities for items on the
Confirmation tab, you can check the quantities for any adjusted items
under the Discrepancy/Adjustments tab:

1.  Click SEARCH to generate a list of items that were adjusted on the
Confirmation screen. The items will appear with the original and
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audit quantities. If a particular item is stored in more than one
location, there will be a row for each location.

2. Click ADJUST to accept the adjustments and record the new
guantities to the inventory item records. The list will clear
automatically.

If you have adjusted the quantity of any item, Xper will automatically
create a recount (RCT) report for those items. To perform a recount and
complete the cycle:

1. Onthe Confirmation tab, set the Status to RCT and click SEARCH.
The items available for recount will appear in the list.

2. If necessary, adjust the quantity in the Audit Qty column.

3. If you have made the necessary adjustments, click SAVE and proceed
to the Discrepancy/Adjustments tab to complete the cycle count
(see above). Any adjusted items will once again generate a recount.

4.  If no adjustments were made, click SAVE to complete the cycle
count. Completed cycle count reports can be viewed in Cycle
Counting Overview by setting the status to CMP and clicking
SEARCH.

Manufacturer Maintenance

The Manufacturer Maintenance screen contains data about the different
manufacturers from which you may purchase inventory. Since the
Manufacturer is a required field when building inventory, you must
create a list of manufacturers prior to entering items.

To add a new manufacturer, simply fill out the fields and click SAVE NEW.
The only required field is Name, but you may complete as many other
fields as you would like. The new manufacturer record will then appear in
the list. The fields and their functions are listed in the following table:

Field Description

Name Manufacturer’s name

Contact Name Name of your sales contact

Contact Title Title of your contact

Contact E-mail E-mail address of your contact

Address 1 Address field (PO. Box, Street address, etc.)

Address 2 Additional address information

City City in which the manufacturer is located

Region State or province in which the manufacturer is
located
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Field Description

Mfg Abbreviation Abbreviation or display name (optional)

Postal Code Zip or postal code

Country Country in which the manufacturer is located
Phone Number Manufacturer’s phone number

Fax Number Manufacturer’s facsimile number

Home Page URL of the manufacturer’s website

Active Check to make manufacturer active in Inventory
Notes Comment field

To edit an existing manufacturer’s information, double click on the item
in the list, make changes at the top, and click UPDATE to save the changes
or CANCEL to discard them.

To delete a manufacturer from the list, double click on the item and click
DELETE. However, if you have active items in your inventory that are
associated with the manufacturer you wish to delete, the application will
not allow you to complete the procedure until you have deactivated or
changed the manufacturer for these items. You can deactivate the
manufacturer instead by unchecking the “Active” box and clicking
UPDATE.

You can search for a particular manufacturer by entering data in the
criteria fields and clicking SEARCH. You may preview and print a report of
manufacturer data or export the report to Excel by using the PREVIEW,
PRINT and EXPORT buttons.

Vendor Maintenance

The Vendor Maintenance screen serves much the same function as the
Manufacturer Maintenance screen. Vendors are companies or
organizations from which you may purchase items which are
manufactured by other corporations. Unlike Manufacturer, Vendor is not
a required field in item maintenance.

To add a new vendor, simply fill out the fields and click SAVE NEW. The
only required field is Name, but you may complete as many other fields
as you would like. The new vendor record will then appear in the list. The
fields and their functions are listed in the following table:

Field Description
Name Vendor’s name
Contact Name Name of your sales contact
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Field Description

Contact Title Title of your contact

Contact E-mail E-mail address of your contact

Address 1 Address field (PO. Box, Street address, etc.)
Address 2 Additional address information

City City in which the vendor is located

Region State or province in which the vendor is located
Abbreviation Abbreviation or display name (optional)
Postal Code Zip or postal code

Country Country in which the vendor is located
Phone Number Vendor’s phone number

Fax Number Vendor’s facsimile number

Home Page URL of the vendor’s website

Active Check to make vendor active in Inventory
Notes Comment field

To edit an existing vendor’s information, double click on the item in the
list, make changes at the top, and click UPDATE to save the changes or

CANCEL to discard them.

To delete a vendor from the list, double click on the item and click
DELETE. However, if you have active items in your inventory that are

associated with the vendor you wish to delete, the application will not

allow you to complete the procedure until you have deactivated or
changed the vendor for these items. You can deactivate the vendor
instead by unchecking the “Active” box and clicking UPDATE.

You can search for a particular vendor by entering data in the criteria

fields and clicking SEARCH. You may preview and print a report of vendor

data or export the report to Excel by using the PREVIEW, PRINT and
EXPORT buttons.

Location Maintenance

The location maintenance screen allows you to maintain information
the various locations in which inventory items may be stored in your

facility. The fields and their functions are listed in the following table:

Field Description

Location The name of the location

Active Check if this location is being used to store items
Description A brief description or comment (optional)
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Field Description

Section The section within a specific location in which an item
is stored (optional)

To add a new location, simply fill out the fields and click SAVE NEW. The
only required field is Name, but you may complete as many other fields
as you would like. The new location will then appear in the list.

To edit an existing location, double click on the item in the list, make
changes at the top, and click UPDATE to save the changes or CANCEL to
discard them.

To delete a location from the list, double click on the item and click
DELETE. However, if you have active items in your inventory that are
stored in the location you wish to delete, the application will not allow
you to complete the procedure until you have changed the location for
these items (see section 4.6.2 ‘Inventory Maintenance’).

The list of locations, in addition to the fields above, will also report the
date of the last cycle count performed on items stored in those locations.
You may export your location data to Excel by clicking EXPORT.

Inventory Ordering

The Inventory Order screens are used to create new orders, or to view
existing orders and back ordered items. There are two screens: Build
Order and View Orders. To access the Order screen, click MODULES >
INVENTORY > ORDER.

The Build Order tab is where new orders are created. You may
automatically build an order consisting of all inventory items whose
guantities are under par by clicking BUILD PAR ORDER. You may also
create orders for individual items. To manually create an order:

1.  Select the manufacturer from the Manufacturer Name drop-down
list or select the vendor from the Vendor drop-down list.

2. Select the part number from the Part Number drop-down list.

3. Select the appropriate unit from the Order Unit drop-down list. If
you specified an order unit on the item’s maintenance screen, it will
be automatically selected.

4. Enter the desired quantity in the Order Qty field.
5.  Click INSERT LINE to create the order.

You may continue adding parts from the same manufacturer or vendor,
or you may select a different manufacturer or vendor and create
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additional orders. You may delete any line by highlighting it in the list and
clicking DELETE. Clicking CLEAR ORDERS will clear the screen without
saving. When you are finished creating orders, click SAVE ORDER to
generate an order report, which will be automatically displayed in a
preview window from which you can print. If you placed orders with
more than one manufacturer or vendor, each order will appear on a
separate page.

The View Orders tab allows you to keep track of your orders. You may
search for orders using any combination of criteria, then clicking SEARCH
to display results. The default grouping is by Order Number, then date,
and manufacturer and order status. You can also use the filters to the left
of the SEARCH button to narrow your view. If you would like to see any
orders that are complete, have been voided, or are on back order, check
the YES box, or check the NO box to see orders that do not meet any of
these criteria. If no boxes are checked or other criteria indicated, all
orders will be displayed. Clicking PREVIEW will generate a report
displaying each order on screen along with its status. You may then print
the report by clicking PRINT.

To process incoming orders, click CONFIRM. Additional columns will be
activated on the right side of the Order Results screen. The additional
columns and their functions are listed in the following table:

Column Description

Unit Rec The received unit. Note: this should match the Order
unit of the item.

Qty Rec The quantity received (may be a partial quantity).

Complete Check if the order is completed.

Void Check if the order is voided.

Back Order Check if the order or any part of it is on back order.

Expected Date The date the remaining number of items is expected.

Modified If a row has been modified by a user, this box will be
checked.

To receive a complete order:

1. Check the COMPLETED box.

2. Select a location from the LOCATION drop-down menu.

3.  Click SAVE. The total quantity and location quantity for the item will
be updated and may be verified on the Inventory Overview screen.

To receive a partial order:

1.  Select a unit type from the UNIT REC drop-down menu.
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2. Enter the quantity to be received into the QTY REC field.
3. Select alocation from the LOCATION drop-down menu.
4.  Click SAVE.

To receive a completed order into multiple locations:

1.  Select a unit type from the UNIT REC drop-down menu.

2. Enter the quantity to be received into the QTY REC field.

3. Select a location from the LOCATION drop-down menu.

4.  Click SAVE.

5.  Click SEARCH and CONFIRM to refresh the order status.

6. Repeat as necessary for each remaining location.

You may preview, print and export order data by using the appropriate
buttons at the top of the screen.

Inventory Transactions

The Inventory Transactions screen is where you may view the log of all
actions that have taken place in the Inventory module. To access the
Transactions screen, click MODULES > INVENTORY > TRANSACTIONS.
The Transactions log tracks the following:

e Cycle Count adjustments;

e Orders placed;

e Orders received;

e Orders inserted by Inventory Import Wizard (if you had entered order
information in your import spreadsheet);

» |tems received and the location to which the items were received;

e |Items transferred and the location to which the items were
transferred.

The log will also display the user who performed each action.

To view all inventory transactions, click SEARCH, or you may filter search
results by entering criteria in the appropriate fields. Search results can be
grouped by any column header by dragging and dropping the column
header into the dark blue section of the screen located at the top of the
list. Clicking on any column header will sort the list by that data. The
results can be saved as an Excel spreadsheet by clicking EXPORT.
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4.6.5

4.7

Importing Inventory

Rather than build your inventory manually, you may import inventory
data from an Excel spreadsheet. To open the Data Import Wizard, click
TOOLS>DEVELOPMENT> DATA IMPORT. The file type, Excel spreadsheet,
is selected by default. To continue:

1.  Click NEXT >.

2. Use the ellipse button to browse to your Excel file. You may also
select ANSI or ASCII file origin.

3. Click NEXT >

4. Set any necessary data formats, such as delimiters, currency
symbols, etc.

5.  Click NEXT > to display a preview of the spreadsheet. Click on the
header of each column to select the data field to which you will
import the column data.

6. Click NEXT > to check the mapping of the spreadsheet columns to
the data fields in the inventory module (e.g., if your part numbers
are in column C of your spreadsheet, map the Part_Number
destination field to source column C).

7.  Click NEXT > to preview your mappings. If you have mapped a
column to an incorrect destination field, click < BACK to make
corrections, then NEXT > to check your mappings.

8.  Click NEXT > to view the Summary page
9. Click EXECUTE to complete the process.

Insurance Providers

For some facilities, it is necessary to assign different patient costs to
items and procedures based on a patient’s insurance provider. The
Insurance Providers module allows users to configure and maintain a list
of these providers. To access the Insurance Providers module, click TOOLS
> INSURANCE PROVIDERS. The fields and their functions are listed in the
following table:

Field Description

Insurance Company The name of the insurance provider

Name

Show deleted When checked, displays deleted providers in the list as
providers (checkbox)  well as active providers

Street Address Insurance provider’s street address

City/Town Insurance provider’s city or town
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Field Description
Zip/Postal Code Insurance provider’s zip code or postal code

State/Province/County Insurance provider’s state, province or county

PO. Box Insurance provider’s post office box number
Country Insurance provider’s country
Phone No. Insurance provider’s phone number

Contact person’s name Insurance provider contact

Email Address Insurance contact’s e-mail address

Fax No. Insurance provider’s facsimile number

Web address Insurance provider’s URL

Group No Insurance group number

Subscriber ID Insurance subscriber ID

Optional Data 1 - 4 These fields are memo fields in which a user can enter
notes

Plan Type 1 Insurance plan type

Plan ID 1 Insurance plan ID

Plan Type 2 Insurance plan type

Plan ID 2 Insurance plan ID

Tax ID Number Insurance plan tax identification number

Description A description of the insurance plan

To add an insurance provider:

1.  Enter the insurance company name (required).
2. Enter any additional data.

3.  Click SAVE NEW.

To edit an insurance provider’s information, select the provider from the
list, make the necessary changes, and click UPDATE.

To delete an insurance provider, highlight the provider and click DELETE.
Deleted providers will appear in the list with a line through the provider’s
name and information.

Query Wizard

The Query Wizard module allows users to query their data and compile
statistical reports, extract data elements to other formats (Microsoft®
Excel™ and Access™) or write more complex SQL queries. To access the
Query Wizard, click MODULES > QUERY WIZARD.
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The first step in performing a query is to specify a date range (section 1).
To set the range, you may use one of three methods:

1. Select one of the choices from the Range box (last three months, last
6 months, etc.);

2. Manually enter a From date and To date in the Exact Dates section,
or

3. Use the calendar tools to set the From and To dates.

After you have specified a date range, you may click SEARCH to find all

the patients that exist for those dates, or you may want to refine your

search to patients who match specific criteria (e.g., all patients who

received a specific medication, or all cases performed by a specific

physician). If you wish to set up additional search parameters, click NEXT

to activate the Query Parameters section (section 2).

To create a new filter (a set of search parameters):

1. Click NEW;

2. Assign a name to the filter;

3.  Click SAVE. This will activate the Parameters window.

4. Click ADD to create a search parameter. Parameters can be created
for data fields or charting elements.

To create a data field parameter:

1. Insection A, select an operator (AND, OR, NOT, AND NOT, OR NOT)
to activate the Folder list;

2. From the Folder list, select the source screen (Case Details,
Hemodynamics, etc.);

3. From the Fields list, select the desired field and click NEXT;

4. In section B, select the appropriate statement (equals, between, is
greater than, etc.);

5. Insection C, set the value to search for. If you have selected a field
that could have a high and low range (e.g., Age), you will be able to
set the high and low values.

6. Hit ENTER on the keyboard and click SAVE FILTER.

To create a charting element filter:

1. Insection A, select an operator (AND, OR, NOT, AND NOT, OR NOT)
to activate the Folder list;

1.  From the Folder list, select Charting Menus;

Xper Information Management System Release 2-1 4-57



4-58

2. Select a modality;
3. Select the menu;

4.  Chart through the entire line, then highlight key words from the
charting results and drag to the VALUE field

5. If the text you are searching for could appear in more than one
menu, check IN ALL MENUS;

6. Click SAVE FILTER.
After creating a search filter, click SEARCH. The list on the right will

populate with matching cases. You may then select an output type from
Section 3:

1.  Fixed Report, one of a number of pre-configured reports;

2. Export to Microsoft® Excel or Access;

3. View the filter’s SQL statement;

4. Import the current query statement into the Advanced query

module.

This system contains an Advanced query module where users can create
raw SQL queries, custom reports and charts. The Advanced module is
intended for users who have experience in writing SQL statements. For
more information and assistance, contact Customer Support.

You may also create a custom report incorporating a wide range of
formats and data. To create a custom report:

1.  Click the Custom Reports tab in Section 3.

2. Click ADD to open the Custom Report writer.

3. Enter a name in the field labeled “Report Layout Name.

4. Select a format (bar graph, pie chart, raw data, matrix) in step A.
5.  Click NEXT to activate step B.

Depending on the format you selected, you will now be able to identify
the data fields to be used in the report.

To create a bar graph or pie chart:

1. Select the X field (the parameter that will appear on the X, or
horizontal, axis of the graph).

2. Select the calculation to be performed. You may select Average,
Total or Difference.
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3. Selectthe field (the parameter that will appear on the Y, or
vertical, axis of the graph).

NOTE: If you selected Difference, you will be prompted to enter two fields. The first of the
two Y fields should be the larger value, and the second should be the smaller value.

4. If desired, you may select a field by which to group the results.

5.  Click NEXT. You may then save, preview and save, or cancel without
saving the report.

To create a matrix:

1.  Select up to three (3) X fields.

2. Select up to three (3) Y fields.

3. If desired, select a field by which to group the results.

4.  Click NEXT. You may then save, preview and save, or cancel without

saving the report.

To create a raw data report:

v

Hh
E’ 1. Select up to six (6) fields, clicking the ADD button after each one.

2. If you want to group by a particular field (e.g., room number), select
the field and check GROUP, then add the field.

3.  You may add a user-defined label by entering the desired text in
FIELD LABEL. The custom label will appear as the column header on
the printed reports.

4.  You can adjust the order in which the data columns will appear by
highlight a field and using the UP or DOWN arrows to move the field.

5. If you would like to customize the look of your report (e.g., change
column width, column headers, add calculations, etc.), check the
box labeled Use Custom Design, then click DESIGN to open the
custom report designer. For more information on using the custom
report designer, please contact Customer Support.

6. Click NEXT. You may then save, preview and save, or cancel without
saving the report.

Once you have created a custom report, it will be available in the Custom
Reports list to be run on demand. Simply run a search and select the

custom report you wish to run.

Batch Reporting

Batch reporting allows you to schedule reports to print automatically at a
selected interval (e.g., daily, weekly, monthly, etc.).
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Kit Builder

Kits are a special tool in this system that allows you to incorporate
inventory items, procedures, and charting elements in a “kit” that will
chart all elements with a single click. To access the Kit Builder, click TOOLS
> KIT BUILDER.

The list of current kits is at the top of the screen. You can review the
contents of a kit by clicking + next to a kit name to expand the tree view.
You can search for a particular kit or kit type using the search fields. The
fields and their functions are listed in the following table.

Field Description
Kit Name Searches for a kit by name.
Type Searches for kits that contain a particular item type

(Menu, Procedure, Inventory).
Item Searches for kits containing a specific item.

Description Searches for a kit by description.

To perform a search, enter the desired parameter and click SEARCH. To
clear the search parameters and perform a new search, click CLEAR
CRITERIA.

Creating a Kit

To create a kit:
1. Click ADD.

2.  Enter a name in the Kit Name field. You can then add one of three
types of item:

- Menu: items from the charting menus;
- Inventory: items from currently active inventory;
- Billing Procedures: active items from the Procedures table (see
section 4.18 ‘Coding’).
To add a menu item:
1. Select the modality from the drop-down list on the left.
2. Select the menu from which you want to chart.

3.  Asyou click through the menu choices, the line will be added to the
kit. You can put as many items as you wish from any menu, with the
exception of Inventory items.
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To add an inventory item:

1.  Find the item under the Inventory tab at the bottom left.

2. Double click to move the item to your kit.

You may search for inventory items in the Kit Builder just as you can in

Inventory Maintenance (see section 4.6 ‘Inventory Management’). The
search fields and their functions are listed in the following table.

Field Description
ltem Search by item name.
Part Number Search by item part number.

Mfg Part Number  Search by manufacturer’s part number.

Bar Code Search by internally generated barcode.

Mfg Bar Code Search by manufacturer’s barcode.

Location Search by inventory location.

Manufacturer Search by manufacturer name.

Category Search by inventory category.

Max Records Select the number of records to return (100, 500, 1000,
or all).

To add procedures:

1.  Click the Billing Procedures tab at the bottom left.

2.  Select the desired modality.

3. Double click the procedure you want to add.

You can search the procedures list by entering a search string in the
Procedure field and clicking SEARCH. To search a partial string, use the

“%” symbol as a wild card (e.g., “%heart” will return all procedures
containing the team “heart”).

Once you have added all necessary items, click SAVE to save the new kit,
or CANCEL to discard it. You can now create a menu item linked to the kit
that, when charted, will place all items within the kit into the appropriate
menus in a patient study (see section 4.12 ‘Menu Builder’).

Editing a Kit

To edit a kit:
1. Select the kit name in the Kit Entries list.

2. Click EDIT. You will be prompted to confirm that you have selected
the kit you wish to edit.
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3. Click YES to continue, or NO to cancel and select a different kit.
4.  Once the kit has loaded, you may add any of the three types of item.

5. You may also change the order in which items appear in the kit (and
the order in which they will be entered in charting), by using the
Move Up and Move Down arrows (see image at left).

You may also remove items. Highlight an item, then click REMOVE, or you
can remove all items from a kit by clicking CLEAR ALL.

After you have made all necessary changes, click SAVE, or click CANCEL to
discard the changes.

4.10 List Management

The List Management module allows you to import lists to be used in
charting menus (see section 4.12 ‘Menu Builder’). The list may be an
Excel spreadsheet, or it may be a CSV (comma separated values) list. To
access the List Management module click TOOLS > LIST MANAGEMENT.

To import a list:

1.  Enter a name for the list (e.g., “Interventional Physicians”).

2. If auser will be required to enter a serial number when charting
items from the list, check the box labeled “Serial Number required.”

3. Click IMPORT WIZARD.

4.  Click the ellipse button to browse to your file. You may also select
ANSI or ASCII file origin.

5. Click NEXT >

6. Setany necessary data formats, such as delimiters, currency
symbols, etc.

7. Click NEXT > to display a preview of the spreadsheet. Click on the
header of each column to select the data field to which you will
import the column data.

8.  Click NEXT > to check the mapping of the spreadsheet columns to
the data fields in the inventory module (e.g., if your part numbers
are in column C of your spreadsheet, map the Part_Number
destination field to source column C).

9. Click NEXT > to preview your mappings. If you have mapped a
column to an incorrect destination field, click < BACK to make
corrections, then NEXT > to check your mappings.
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4.11

10. Afterimporting a list, you may preview it by clicking VIEW. If you are
not satisfied with the list, click REIMPORT to repeat the process and
make any changes.

After importing a list, you may want to designate titles for the columns,
which can be used as key words when building scrapers. To rename
column headers:

1.  Highlight the name of the list and click LOAD IMPORT. The list will
appear in the Imported Table window.

2.  Click on a column to load the title into the Column Name window.
3.  Rename the column and click UPDATE.
4.  Continue until all column titles are changed.

5.  You may delete a column entirely by highlighting it and clicking
DELETE.

6. Click SAVE CHANGES to save the new titles, or click CANCEL
CHANGES to discard.

Once a list has been successfully imported, you may associate it with an
item in the Menu Builder so that it can be used when charting a
procedure (see section 4.12 ‘Menu Builder’).

If you have unwanted lists or lists you no longer want to use, you may
hide them so that they will no longer be displayed in List Management or
in the Menu Builder. To hide a list, uncheck the ACTIVE box next to the list
name. To display inactive lists, uncheck the SHOW ONLY ACTIVE box.

Registry Lists

The Registry Lists module is specifically meant to enable users to
maintain the lists utilized by the ACC Registry screens. These include
Medications, Closure Devices, Lesion Segments, and Intracoronary
Devices. The ACC updates these lists frequently, so it is important to
maintain the lists by making any necessary additions or to hide obsolete
items.

To add a new item to one of the lists:
1.  Click TOOLS > REGISTRY LISTS to open the module.
2. Select the list you wish to edit from the List Name drop-down menu.

3. Enter the description of the new item in the Display Value field.

4.  Click ADD NEW. The entry will be added to the bottom of the list.
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To update an item:

1. Select the correct list from the drop-down menu.
2. Double click the item you wish to update.

3. Make the desired change in the Display Value field.
4.  Click UPDATE to save the change.

To hide an obsolete item:

1.  Select the correct list from the drop-down menu.

2.  Double click the item you wish to hide.

3. Check the HIDDEN box next to the Display Value field.
4.  Click UPDATE to save the change.

Menu Builder

The Menu Builder utility is a powerful tool that gives you the ability to
fully customize your charting menus. You can create menu sets for each
modality, edit existing menus, copy menus from one modality set to
another, or delete unused or unwanted menus.

To access the Menu Builder, click TOOLS > MENUS BUILDER. The builder
will open in the default modality (X-Ray Angiography). To edit menusin a
different modality, click the MODALITY drop-down list and select the
modality in which you wish to work.

Menu Builder Screen

The Menu Builder screen consists of several sections:

e Main Menus list: Located on the left side of the screen, this is the list of
existing menus for the selected modality. You will also find the
command buttons to ADD, DELETE, or DUPLICATE a menu.

» Current Menu: The top center section of the screen is the section in
which you will build and edit menu entries.

¢ Fixed Items/Global Fixed Items: The bottom center of the screen
contains groups of fixed items (see below) that are used when building
or editing menus.

» Edit Tools: At the very bottom of the screen are the tools used to insert
charting statements into a menu, to save entries, or to delete existing
line items.

» Menu Characteristics: The right side of the screen contains several
tools for building special functions into your menus and to change the
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layout of the charting line items within a menu (see below). There is
also a notification message to tell you whether you have selected a
regular menu item or a fixed item in a group.

* Modality Selection List: This drop-down list allows you to select the
menu set for the specified modality.

* Menu Status: The window at the top of the screen will indicate
whether the menu can be edited, or whether it is locked by another
user. If the status window displays a “READ ONLY” message and the
menu builder title bar is highlighted in red, another user is currently
working in that menu, and you will not be permitted to make changes
until the other user has released the menu. A “READ/WRITE” status
indicates that you can make changes to the menu.

You will also notice that the left margin of the Main Menus section and
top margin of the Fixed Items section are collapsible. You can temporarily
close these sections to give yourself more room to work by clicking on
the arrows. Clicking the arrows a second time will reopen these sections.
You can also click and drag the arrows to resize these sections.

4.12.2 Creating and Deleting Menus
To create a menu:

1. Select the desired modality.

2. Click ADD at the bottom of the Main Menus section. The Current
Menu section will clear, and the cursor will flash in the MENU
DESCRIPTION field.

3. Type in the name of your new menu and select a menu icon from
the Image drop-down list.

4. Click SAVE at the bottom right. The new menu (with icon) will
appear in the list at the left. The menu title will also appear at the
top of the Current Menu section.

To delete a menu:

1. Click on the menu title in the Main Menus list.

2. When the Current Menu screen has updated to display the selected
menu, click the DELETE button at the bottom left.

3.  You will be prompted: “Are you sure you want to delete the
following menu: {Menu Name}?” Click YES to delete (or NO to
cancel). The menu will be deleted from the list.

To duplicate a menu to a different modality:

1.  Click on the title of the menu you want to duplicate.
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2. Click DUPLICATE at the bottom of the menus list.

3.  You will be prompted: “Are you sure you want to duplicate the
following menu: {Menu Title}?” Click YES to proceed.

4. You will then be prompted to choose the modality to which the
menu will be copied, and to rename the menu (if desired).

5.  Click DUPLICATE to proceed. Once the menu has been duplicated in
the selected modality, the system will report “Menu has been
duplicated.”

6. Click OK to clear the message.

7.  Choose the modality from the drop-down list. Your new menu will
appear in the Main Menus list, where you can make any changes.

Building and Editing Menus

Levels and Sublevels

Once you have created a menu, you will need to build charting
statements into it. The menu structure is a tree view, with levels and
branching sublevels.

To begin adding levels:

1.  Click on the menu title at the top of the Current Menu section and
click the ADD SUBLEVEL button.

2. Type the first line of charting into the Menu Description field.

3. Click SAVE.The line will be inserted under the menu title in the
Current Menu field. If you want to create a “remark” statement that
will be seen on screen as instructions to the users, but will not be
charted into the procedure, you must enclose it with vertical pipes (
|REMARK] ).

To add subsequent lines on the same level, click on the new line item,
then click the ADD AT CURRENT LEVEL button. Type in the next line item
and click SAVE. You will now have two line item entries in your menu.

But what if the entries you’ve added have associated sublevels? To add
sublevels:

1. Highlight the line item in the first level (not the menu title).

2. Click ADD SUBLEVEL. You can then type in the first associated entry.

3. Click SAVE. You will now see a sublevel under the “parent” line item.

4.  Continue building your menu, using either the ADD AT CURRENT
LEVEL or ADD SUBLEVEL buttons to place your entries where you
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NOTE

want them. Your menu will start to expand into a “tree” view of
levels and sublevels.

To delete a line item from any level, highlight the item and click DELETE.
You will be prompted: “Are you sure you want to delete the following
node: ...... " Click YES to delete the item, or NO to cancel.

If the item you are deleting has sublevels associated with it, they will also be deleted.
Variable Items

Variable items, when built into a menu, prompt the user to enter data
from the keyboard, such as the amount of a medication administered
during a procedure, a date, or name. The essential characteristic of a
variable item is the DATA TYPE, along with the optional elements of UNIT
TYPE and MASK. To create a variable item, you use the ADD AT CURRENT
LEVEL or ADD SUBLEVEL button and enter text into the Menu Description
field, then check the VARIABLE ITEM box. You then assign the data type
to the new item.

There are seven data types that you can assign to a variable item:

Data Type Definition

Text accepts any keyboard character, alpha, numeric, or other.

Number accepts whole numbers (see Float).

Date accepts a date. The default format is MM/DD/YYYY.

Time accepts a time. The default format is HH:MM:SS in
military time.

True/False accepts a “True” or “False” response.

Float accepts a numeric value containing decimals (see
Number).

After you’ve chosen the data type, you can use the MASK element to
change the format, if you wish. For instance, you might want to change
the date format to DD/MM/YYYY. If you want to use the default format,
you won’t need to assign a mask. You can also create your own custom
masks.

The final element of a variable item is the Unit Type. Assigning a unit type
will attach text to a variable entry typed by a user. For example, you may
create a variable item using the data type Number, “Heparin drip @,” and
assign a unit type of units/hr. When a user charts a Heparin drip and is
prompted to enter the amount, the application will attach “units/hr” to
that entry. The resulting charted entry might read: “Heparin drip @ 1000
units/hr”
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Items can be added to the Unit Type list if you need them. To do this, click
the ellipse button next to the Unit Type drop-down list. This will open the
Unit Type edit window. To add a new unit type

1. Click ADD.

2. Enter the desired text in the Display field. Enter a description in the
Description field if desired.

3. Click POST to add the new type to the list.

You can edit an existing item by highlighting it and clicking EDIT. Make the
desired changes, then click POST to save the change.

To delete an item, highlight it and click REMOVE. Click OK to save and
close the Unit Type window. Click CANCEL to exit without saving.

Fixed Items and Global Fixed Items

In some cases, you may want to use the same group of items as a sublevel
for more than one line item. While you could type in the same entries
over and over, the Fixed Items section allows you to build the group once,
and then assign it to the line items you’ve already created. If you want to
use the same group for more than one menu, you will create a Global
Fixed Items group. Either way, the process is the same.

To create a new group, click in the Fixed Items (or Global Fixed Items)
section and click the ADD GROUPS button. Type the name of your group
in the Menu Description field and hit the SAVE button. Your new group
title will appear in the list. From there, simply use the ADD SUBLEVEL
button to insert the line items within your group. It’s basically the same
process as building the menu itself. You can build sublevels and include
variable items, whatever you need to do.

Once you’ve built your group, you can add it to the line items above by
clicking on the title and dragging it up to the item or items to which it
belongs. You can even drag a group onto another, previously placed,
group item. If you find you need to make changes to a group, don’t worry.
The changes will be automatically applied to the menu items, so you
won’t have to reassign the group. To remove a group from a menu item,
highlight the item and click REMOVE FIXED LEVELS.

Global Fixed Items are built and work in the same manner. The difference
is that a global group will be available for all the menus in a modality,
whereas normal groups are available for use only in the menu in which
you created them.
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Inventory Items

Inventory items are a special function within the menus. When you
create an inventory item in a menu, you associate it with an inventory
category (see section 4.6 ‘Inventory Management’). When the item is
charted, the user will be presented with a list of the items belonging to
that category. The user can then select the correct item from the list, or
can use the barcode gun to enter the item. Once the item has been
charted into a patient record, it will be decremented from inventory, and
a charge for the item will be generated on the patient’s bill.

To create the inventory item in the menu, use the ADD SUBLEVEL button
to insert the item in the Menu Description field, then check the Inventory
Item box and select the category from the drop-down list. Typically,
inventory items are enclosed by French brackets ({Sheath}), but this is not
required.

In order to build inventory items into a menu, inventory must be present and assjgned
to a category. For more information, see the section on Inventory.

Kit Items

Kit items work in much the same way as the Inventory items. Once you
have built charting kits (see section 4.9 ‘Kit Builder’), you can enter a line
in a menu and check the Kit Item box, then associate the line item with a
specific kit using the Kit Name drop-down list. Like Inventory, you must
first build your kits before associating them with line items in a menu.

List Items

List items also work in much the same way as the Inventory items. Once
you have imported a list (see section 4.10 ‘List Management’), you can
enter a line in a menu and check the List ltem box, then associate the line
item with a specific list using the List Name drop-down list.

ACC Registry lists are not imported using the List Management module, but may still
be associated with menu items. For information on ACC Registry lists, see section
4.11 Registry Lists".

Menu Attributes
Menu attributes are special characteristics that are applied to all the

entries in a menu. The attributes and their functions are listed in the
following table:
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Attribute
Bolded

Synopsis

No Free Form

Lesion

Coronary

Peripheral

History

Monitoring

Inflate

Ext Data

Coronary Notes

Peripheral Notes

Exclude from Proc Log

NOTE

menu per repository.

4-70

Description

Displays charted items in bold text and prints charted
items in bold font in the Procedure Log.

If checked, the entries from a Synopsis menu will print
in the Case Synopsis report. If not checked, entries
from the menu will not appear on the Synopsis report.

Disables the Free Text function for the specified
menu.

Turns on automatic lesion numbering when charting in
the specified menu.

Indicates the menu in which statements from
coronary arterial trees will be inserted.

Indicates the menu in which statements from
peripheral arterial trees will be inserted.

Charting from designated History menus will populate
a study created by the Readmit function.

Indicates the menu in which statements will be placed
when using the MARK feature in monitoring.

Indicates the menu in which statements from the
Merit Intellisystem will be placed.

When checked, data from external systems, such as
Bard or GE MacLab, will be imported into the menu.

Indicates the menu in which annotations (created
using the NOTES button) from coronary arterial trees
will be inserted.

Indicates the menu in which annotations (created
using the NOTES button) from peripheral arterial

trees will be inserted.

When checked, charted items from the menu will be
excluded from the study’s procedure log.

Coronary; Peripheral, Ext Data and Monitoring attributes can be assjgned to only one
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Sedation/Reversal Scraper Attributes

There are two special attributes which can be assigned to line items
within the menu, SEDATION and REVERSAL. These attributes mark the
line items as keys that will be used in creating data mining scrapers for
sedation agents and reversal agents on the Sedation Flowsheet. The
medications must be charted in a specific order: medication name, dose,
unit of measure, route of administration (e.g., Versed 2 mg IV). If the
medication is charted in any other order (e.g., 2 mg Versed V), the
scraper will not work. For more information on building sedation and
reversal agent scrapers, see section 4.2.2 ‘Scraper Creation’.

Sedation and Reversal Agent keys should be a single word or phrase, rather than the
medication name itself. It is suggested that you create a level 1 line item, such as
{Narcotics/Sedation} or {Reversal} to be used as the scraper key.

Layout Operations

Don’t worry if you insert a line item in the wrong spot. The Layout
Operations tools will enable you to move items exactly where you want
them. If you have entered a line item that should be a sublevel of another
line, simply click on the item and drag it to the “parent” level. To move a
sublevel out from under another entry, highlight it and use the MOVE
LEFT button to place it on the correct “branch” of the menu tree.

To change the order in which items appear on any level, use the MOVE
UP and MOVE DOWN buttons. Using the MOVE UP button will move an
item as far as the top of its current level. The MOVE DOWN key will move
it down the “branch” until you’ve reached the bottom of that particular
“branch.” If an item is already at the top of its branch, the MOVE DOWN
button will be active. If it’s already at the bottom, the MOVE UP button
will be active.

Apply Changes
Once you have completed work in a menu, click the APPLY CHANGES

button to save all changes. It is also a good idea to click this button
periodically if you are making lots of adjustments to prevent data loss.
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Arterial Tree Builder

Editing an Arterial Tree Template

You can change or replace the existing templates to meet your needs by
using the tools already described. To change or replace a template, it is
best to use a test case to work with. First, select the template you wish to
change. Use the Tree Editing, Move, and Vessel functions to add, delete
or redraw vessels, and adjust their size and position. The controls and
their functions are listed in the following table:

Tree Editing Functions

Control Description

Art Label Allows the operator to change the display label (top
right corner) of a vessel.

Termination Used when creating an arterial template.

Cusp Structure Used when creating new templates to draw non-

artery structures, such as the aortic cusp or kidneys.

Move Artery Allows the operator to change the location of a
vessel.

Move Note Allows the operator to change the location of a note.

Note Used to create and place notes on a tree.

Arrow Used to draw directional arrows from one point to
another.

Vessel Artery Used to insert arteries into a template or tree.

Position Used to change the position markers (proximal, mid,

or distal) within a vessel.

Vessel Size Allows the operator to adjust the diameter of a vessel
using the scrollbar.

Undo Allows the operator to undo the previous ten (10)
operations.

Delete Used to delete vessels, arrows, and notes.

Save Template Saves changes to the selected template.

To draw a non-coronary structure (e.g, aortic cusp, kidneys, etc.), you will
use the Cusp Structure tool. Click CUSP STRUCTURE, then select the type
of structure you will draw. If you are editing a coronary template, you will
need to create an aortic cusp on which you can place saphenous vein
grafts. Use the other types (Structure 2 and Structure 3), to draw organs
or other objects.
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To add a vessel, click VESSEL ARTERY. You will be presented with a list of
vessels appropriate to the type of arterial tree you selected. Coronary
trees will have a list of coronary vessels, while the peripheral trees will
have the appropriate list of vessels for that system. Choose the type of
vessel you wish to draw, or type in your own label and hit ENTER on the
keyboard. You will then be prompted to click on the point of origin of the
new vessel. Draw the path of the new vessel, then click on the end point
to complete the drawing.

When drawing any object (i.e., vessel, arrow; etc.), do not hold down the mouse
button. Click once and release, draw the path of the vessel or object, and click a
second time to complete the process.

To delete a vessel, lesion or note, click DELETE, then click on the object
you wish to delete. If you wish to delete a note, click on the first character
of the text.

The UNDO control will reverse up to ten (10) previously performed
functions, such as drawing lesions or grafts, moving vessels, or adding
notes.

You may increase or decrease the diameter of a vessel by clicking VESSEL
SIZE. You will be prompted to select the vessel you wish to change, then
use the scrollbar to increase or decrease the diameter.

If you wish to change the length or tortuosity of a vessel, you must delete it before
redrawing it

You may move an artery, note or lesion to a different location on the tree.
To move an artery, click MOVE ARTERY. Click on the artery you wish to
move, then click on the position from which the vessel should originate.
To move a lesion, click MOVE LESION, select the lesion, and click on the
new location within a vessel or graft.

Notes are the white text on a tree. They can be vessel labels or
annotation added by a physician. To move a note, click MOVE NOTE. Click
on the first character of the note you wish to move, then click on the new
location. Be careful not to move a note to a location that obscures a
vessel or lesion, or another note.

The vessel label is the green text that appears in the top right corner
when you move your mouse cursor over the tree. You may change the
vessel label by clicking ARTERY LABEL. Click the vessel you wish to relabel,
then select from the list or type in a new description and click the vessel.
Move your mouse cursor over the vessel to confirm the change.
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Some vessels do not terminate, but are open or tapered (e.g., left main
coronary). In order to specify a different type of vessel termination, draw
the new vessel. Click VESSEL TERMINATION. You will be prompted to
choose one of three types: Closed (the default selection), Half Open, or
Open. Half Open will create a tapered vessel that is open at the end.
Open will create an open vessel. Next, click on the vessel and the
termination will change. You can then continue drawing.

Once you have completed the changes, click SAVE TEMPLATE to overwrite
the old template with the new. The new template will then be available
for use when creating arterial trees.

Custom Forms

The Field Builder is a tool that can greatly expand your data collection
and query capabilities. You can create custom data fields which can be
placed on screens (or “forms”) which you configure using the Form
Designer tool. The custom forms and fields can be accessed by operators
during a procedure, or you can build data scrapers so that the fields are
completed automatically as studies are charted. As data is collected, you
can query it and create reports (see section 4.8 ‘Query Wizard’). To access
the Field Builder and Form Designer, click TOOLS > CUSTOM FORMS.

Field Builder

The first step to customizing data collection is to create data fields. In the
Select Work Area section, choose FIELD BUILDER to open the module.

To add a new field, click ADD FIELD. This will open the Field Definition
section. Required data is marked with an asterisk. The fields and their
functions are listed in the following table:

Field Description

Field Name The name of the field in the database, used in querying
data. NOTE: field names should be one word, or be
connected by underscore (e.g., FIELD_NAME).

Display Name The title of the field that will appear on the custom
screen.

Page/Group The group to which a field belongs.

Data Type Identifies the type of data to be entered in the field.

Default Value Optional default value that will appear in the field.

Definition Optional description of the field.
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Field

Description

Active When checked, the field will be available in the Forms

Designer. If unchecked, the field will be inactive, and will
not be available for inclusion in new forms.

Creating a field is relatively simple:

1.

Enter a field name. Field names should be one word, or should be
separated using an underscore character (e.g., FIELD_NAME).

Enter a display name, or label. This is the text that will be viewed on
the screen by the operators.

Enter a Page/Group name, or select from the existing groups using
the drop-down list.

Select a data type. There are seven data types you can assign to a
field:

Data Type Definition

Text

accepts any keyboard character, alpha, numeric, or other.

Number accepts whole numbers (see Float).
Date accepts a date. The default format is MM/DD/YYYY.

Time accepts a time. The default format is HH:MM:SS in

military time.

True/False accepts a “True” or “False” response.

Float accepts a numeric value containing decimals (see

To fa
a fiel

Number).

Enter a default value, if desired. The default value will always appear
in the field, but may be changed.

Enter a definition, if desired. This may help when placing the fields
on a form.

Click SAVE to add the field to the group, or CANCEL to discard the
field.

cilitate data collection, you can also associate a list of responses with
d using the Text Properties window. The fields and their functions

are listed in the following table:

Field Definition

Valid Data List entry window for inputting list items.

Max Letters sets the maximum number of characters for a field.
Add (button) adds an item to a list.

Del 1 (button) deletes a selected item from a list.
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Field Definition

Del All (button) deletes all entries from a list.

Save (button) saves a list to a text file.

Load (button) recalls a saved list to the window.

Display Style - Drop creates a drop-down entry field that forces

Down Fixed selection from a list.

Display Style - Drop creates a drop-down entry field that allows

Down Edit selection from a list or manual entry.

Display Style - Radio creates a window containing list items displayed as
Group radio button choices.

Select Pattern allows the application of a pattern to a field (e.g.,

zip or postal code, social security number, etc.).

Sort List check box when checked, sorts a list in ascending alphabetical
order.

To create a list of responses for a field, type the desired entries into the
Valid Data List, then click ADD after each entry. You can also specify the
maximum number of characters allowed in a field using the Max Letters
setting. For example, a field set to a maximum length of 20 characters will
truncate any response over 20 characters. You may also select the display
style for a field, and sort the list alphabetically using the Sort List check
box.

If you have created a list that you may want to use for multiple fields, you
can save the list to a text file format by clicking SAVE in the Text
Properties window. You will be prompted to select a name for the list and
a location to save it. When you want to recall the list for use with another
field, click LOAD and select the location and name. The saved list will be
loaded to the window, and you can then save the new field.

To edit an existing field, select the field in the Field List on the left and
click UPDATE. You may then make any necessary changes and click
UPDATE to save, or CANCEL to discard the changes.

The Field List contains all custom fields, sorted by group. You can quickly
view a field and its attributes by expanding the tree view (click the +
next to a group or field).

As you create more groups and fields, your list may become quite long,
which can make locating fields somewhat difficult. You can easily find any
field using the Find Field Definition window. You can search for fields
using the Field Name or Definition, or selecting from the drop-down lists.
The group in which the field appears will be expanded in the Field List,
and the field attributes will appear in the Field Definition window. You
may then click UPDATE to make changes.
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Form Designer

After you have created custom data fields, you will use the Form Designer
to create screens that can be accessed by operators during a procedure,
or by data scrapers. In the Select Work Area section, choose FORM
DESIGNER to open the module. The Field List will remain on the left.

The Form Designer screen consists of four sections. The Field List, which
contains all the active custom fields available, appears on the left. The
Form Management section contains the tools used to create a form
appear at the top. The workspace is divided into two sections, the header
section at the top, and the form section beneath it.

The header section allows you to place an element that will appear at the
top of every page in your form. You can place fields, boxes, labels, or even
images. You can place the same elements in the Form section, but you
can also add pages so that you can organize your fields in a coherent
order.

Creating a New Form

To create a new form:
1.  Click LOAD. You will be prompted to enter a name for the new form.
2. Click OK to continue, or CANCEL to start over.

3.  You can now use the tools in the Form Management section to
create your form. The controls and their functions are listed in the
following table:

Control Function

Load Loads the selected form to the Designer window.

Save Saves the selected form.

Delete Deletes the selected form.

Unload Unloads the selected form from the Designer
window.

Preview Previews the form as a user would see it.

1 Page Adds a page to a form.

Box Click and drag to create a box on the form.

1 Line Click and drag to insert a divider line on the form.

Label Click and drag to insert a label on the form.

Picture Click an drag to insert a picture on the form.

Align Left =| Aligns the left edges of multiple selected items.

Align Right =| Aligns the right edges of multiple selected items.
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NOTE

Control Function

Align Center = Aligns multiple selected items on their center
~ points.
Space Equally »  Spaces multiple selected items vertically.
Vertically it
Space Equally ; Spaces multiple selected items horizontally.
Horizontally e
Align Bottom -.-_l Aligns multiple selected items along their bottom
L edges.
Align Top T Aligns multiple selected items along their top
=] edges.

Tab Order Can be used to change the order in which users
tab through the fields.

Grid Size Changes the size of the alignment grid.

Begin building your form by selecting fields from the Field List and
dragging them onto the form. You can arrange them in roughly the order
and position you wish, then use the alignment tools to refine the
appearance of the form. If you wish, you may change the grid size to
make placement easier.

To align fields on the form, you must first select the group you wish to
align. Hold the SHIFT key down and click on all the fields that need to be
aligned, then click on the appropriate alignment control (right, left,
center, top, or bottom). Depending on how you have arranged your fields
(e.g., in two columns), you may have to group the fields more than once
and in different combinations.

The top and bottom alignment tools are used to align fields horizontally across a
form, while the right, left and center alignment tools are used to align the fields
vertically.
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First Page

[Favorite color: P . Favorite music:

Field_1_37 - Field_7_43 -
- =
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Field_2_38 - Field_s_44 -
L |- .
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- -

[Favorite movie:, . | A . . Favgrite hobby:, .
Field_4_40 ~ Field_10_46 £
-
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Field_5_41 s Field_11_47 -
- 5 5

_Favqute_ car: ¥ . . .
Field_6_42 3
-

Align fields vertically using Right, Left, or Center

First Page
Favorite color: _— . Favorite music:
Field_1_37 w Field_7_43 v
- L . 5

[Favorite flavor: Favorite food:

Field_2_38 - Field_a_44 -
- -
Javorite place: . .. . . . . . . Favorite dessert: L
Field_3_39 - Field_9_45 -
-

J[Favorite movie: Favorite hobby:
Field_4_40 - Field_10_46 ~
ik . .

_Favnrlte animal: Favorite sport:
Field_5_41 - Field_11_47 ~
- - 5

[Favorite car:
Field_6_42 -
-

Align fields horizontally using Top or Bottom

Once you have aligned the fields, you can use the spacing controls to
evenly space the fields horizontally or vertically.

You can group fields on a form by using the Box or Line tool. To insert a

box around a group of fields:
1. Click BOX and drag it to the form.
2. Enter a title for the box, then click OK.

3. You can then drag the box to the appropriate place on the form and

drag the corners or sides to size it correctly around the desired
fields.
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To insert a horizontal line between groups of fields, click 1 LINE and drag
it onto the form. You can then adjust the line’s position, or adjust the
length by dragging either end left or right.

To add a label, click LABEL and drag it to the form. Enter the desired text
and click OK, then position the label wherever you want it.

To add a background image to a form:
1.  Click PICTURE and drag to the form.

2. A window will open prompting you to point to the image file you
wish to import. You may also select the image type (supported
image types are JPEG, BMP, GIF, WMF, and ICO).

3.  Once you have located the image file, click OPEN. The image will
appear on the form at the insertion point.

4.  You may then resize the image by right-clicking on the image and
selecting a percentage of the original size (100%, 50%, or 25%). You
may also resize by dragging the corners or sides.

Background images are not stored as part of the Xper SQL database. If you use an
image that is stored in a location that is inaccessible to other users (e.g, on your local
hard drive), the image will not be visible on other users’ workstations. It is
recommended that you store the images in a central location on a server that is
accessed by all Xper workstation. If an image is not available to a particular
workstation, the form will appear without the background image.

You can add pages to your form by clicking 1 PAGE. You will be prompted
to enter a title for the new page, then click OK. You may then place fields
and other objects on the new page just as on the first. You may change
the title of any page by right-clicking on the page tab, then selecting
RENAME PAGE. Enter a new title, then click OK. To delete a page, right-
click on the page tab and select DELETE PAGE, then click YES to delete it,
or NO to cancel the operation.

Creating a Header

A header is an optional feature that will appear above all pages of a form.
The Header section is located above the form section, directly below the
dark blue line. Click into the grid area below the line and drag the bottom
to resize your header section. You can then use the Form Management
tools just as you did when creating your form to add images, fields or
other elements, with the exception of pages.
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NOTE

4.16

Once you have created your form and header, click PREVIEW to see how
the form will appear to users and to check the functionality of the fields.
Click DESIGN on the preview screen to return to the Form Designer and
make any necessary adjustments, then click SAVE to save the form.

Forms Configuration

After creating a form, you must associate it with a procedure modality in
order to access the form during a patient study. On the Forms
Configuration screen, click and drag the form to the desired modality
(currently, only XA Cine Angiography is supported). The form will be
available under the SCREENS drop-down menu when a study is open.

Case Status

The Case Status screen allows users to configure procedure status
messages used by the Whiteboard viewer (see section 3.1.9 ‘Whiteboard
Viewer’). To create status messages:

1. Click into the Status Description field and enter the desired status
text (e.g., Patient arrived in Holding).

2. Select the Status Parent from the drop-down menu (Pre-procedure,
Procedure, or Post-procedure).

3. Select a status color, if desired (if no color is selected, the message
color will default to white).

4. Click APPLY.

The new status message will be available for use on the Status tab on the
Case Details screen during a procedure.

To edit a status message, select the message from the list, make any
necessary changes, and click APPLY. To delete an unwanted status
message, select the message in the list and click DELETE.

The “Removed” status message is a system message and cannot be edited or deleted.

Room Status

The Room Status screen can be used to monitor which labs are in use at
any given time. Any station can be monitored, but only hosts and Patient
Care Consoles are recommended.
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To set up room status monitoring:

1.  Click the Station ID drop-down menu and select the IDs of the
stations you wish to monitor. Host stations are typically indicated by
H (e.g., HA, HB, etc.), while Patient Care Consoles are typically
indicated by M (e.g., MA, MB, etc.).

2.  After selecting the desired station IDs, click SAVE MONITORED
STATIONS.

3.  Periodically, click REFRESH to update the screen.

4. To view a patient’s procedure log, click on the patient’s name. The
log will display in the bottom half of the screen.

The Room Status columns will populate with data which can be used to
update families, manage case flow, and even monitor a patient’s
procedure log. The columns and their functions are listed in the following
table:

Column Description

Status Empty (no patient is active on the station), or
Occupied

Station ID The unique, two-letter identifier of each Xper

workstation.

Name Name of the active patient.

Procedure Procedure 1 from the Case Details screen.
Physician Physician 1 from the Case Details screen.

Event Event from the Case Details screen (e.g., Patient In,

Setup Done, Begin Time, etc.)
Time The time stamp of the displayed event.

Case Number The case number automatically assigned by Xper
Information Management on admission of a patient
into the system.

Required Fields

The Required Fields module allows users to designate data fields and
menu items as required elements in order for a case to be printed or
closed. It ensures data integrity and more accurate query result. Required
fields may be global, for use at all workstations, or local, for use at a
specific workstation. You may also specify required fields for a particular
user type (e.g., Nurse, Circulate, Physician, etc.)
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To create a required field:

1. Click TOOLS > REQUIRED FIELDS. The Required Fields tab will be
selected by default.

2. Select the modality, if necessary.

3. Select the screen on which the required field appears. Available
screens include the Case Details screen, the Sedation Flowsheet,
and the ACC and ICD registry screens.

4.  After selecting the screen, select the field from the Field Name drop-
down menu.

5. If desired, select a resource type.

NOTE If you assign a resource type to any field, you must assign resource types to the

remaining fields in order for them to appear in patient studies.

6.

Click SAVE.

To create a required menu element:

1.  Click the Required Menus tab.

2. Select the modality, if necessary.

3. Select the menu in which the required element appears.

4. Chart the required element.

5. Inthe box below the menu, highlight the section of the line that
indicates the required element. For example, if you want to make
“Allergies” a required charting element, chart “Allergies: NKA” and
highlight “Allergies.” If you highlight the entire phrase, the entire
phrase will become the required element.

6. Drag the highlighted section to the Required Name list and release.

7. If desired, select a resource type.

NOTE If you assign a resource type to any menu element or field, you must assign resource
types to the remaining menu elements and fields in order for them to appear in
patient studies.

8.  Click SAVE.

9.

If you do not want to specify a particular line, but just want to
ensure that data is entered in the menu, click ANY DATA, then click
SAVE.
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After Required Fields have been set up, users will be prompted to
complete any missing required data elements prior to printing or closing
a study. If the user double-clicks one of the items in the list, the
application will open the appropriate screen and highlight the field in red.
When the user enters the data and hits the ENTER key, the application
will move on to the next required field.

If you have specified resource types for the required fields, the list that is
presented will be dependent on the user type(s) of the staff member who
is logged in to the workstation. For example, if the user is a physician, he/
she will be presented with fields that have been assigned the Physician
resource type. If a user has more than one type (e.g., Nurse, Recorder),
the list presented will be based on how the user has been identified in
the Resources table of the study. That is, if the user has been designated
a Nurse on the Case Details screen, he/she will see only those fields that
have been assigned the Nurse resource type. If the user has been
designated a Recorder, the list will contain only those fields that have
been assigned to the Recorder resource type.

If the user has not been assigned as a resource in the study, the user will
see all fields for his/her types (e.g., a user with both Nurse and Recorder
types will see fields assigned to both Nurse and Recorder resource types).

If the missing data is a menu item, double-clicking the required menu

item will open the indicated menu. When the user charts the required
element, that element will be cleared from the list, and the user may

move on to the next item.

After all items have been completed, the user may print or close the
study.

If the user needs to close the case prior to completion of the study,
clicking the CANCEL button on the required fields box will allow the user
to close the study and reopen it at a later time.

If you do not want users to be able to cancel Required Fields, or if you
would like users to be required to enter their usernames and passwords
in order to bypass the required fields, each Xper Information
Management workstation must be configured to disable the Cancel
button. Contact Customer Support for information and assistance in
configuring your workstations.

Closing a study using Hemodynamics > Case Tools > Close Case will automatically
bypass required fields, regardless of the workstation configuration. If you do not want
users to be able to use this method to bypass required fields, you must disable the
control in the user roles in Portal Designer (see section 4.5.1 ‘User-Centric
Navigation’).
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4.18 Coding

This system supports CPT and ICD-9 coding and Crosswalk to facilitate
proper coding and billing of procedures. To access the Coding module,
click SYSTEM > CODES. From there, you can select the particular screen
you need to work with.

4.18.1 CPT Codes

Current Procedure Terminology (CPT) codes can be imported into the
system and associated with procedures.

4.18.2 ICD-9 Codes

International Statistical Classification of Diseases and Related Health
Problems (ICD) codes can be imported into the system and associated
with CPT codes.

4.18.3 Procedures Table

The Procedures table is an integral part of the system, and is used by
many other modules, such as queries, kit building, billing, and
transcription. The procedures you enter on this screen are used on the
Case Details screen when performing studies, as well. The fields and their
functions are listed in the following table:

Field Description

Procedure The name of the procedure (required).

Modality The modality to which the procedure belongs
(required - currently, only X-Ray Angiography is
supported).

Procedure Group The group to which the procedure is assigned (see

section 4.19.7 Procedure Groups)

CPT Code The CPT code associated with the procedure.

CPT Modifier The CPT modifier associated with the CPT code.

Charge Code The charge code assigned to the procedure for billing.

Cost The cost of the procedure that will be billed to the
patient.

Provider See section 4.7 Insurance Providers’.

To enter a new procedure, type the name in the Procedure field and
select the appropriate modality. You may also enter or choose a CPT
code, CPT modifier, or charge code. The ellipse button above the CPT
code field will access the CPT Codes screen (see section 4.18.1 ‘CPT
Codes’). Click SAVE NEW to save the procedure to the list.
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4.19

To edit an existing procedure, highlight it in the list. Make the necessary
changes and click UPDATE to save the changes.

To delete a procedure from the list, highlight it and click DELETE. You may
also export the entire list to an Excel spreadsheet by clicking EXPORT. The
resulting spreadsheet will contain all data from the table.

You can use the Criteria window to search for a particular procedure or
modality. To search for a procedure, enter the name and click SEARCH. If
you don’t know the entire name, you can enter a partial string with a wild
card character (%) before or after the string, which will return all possible
matches (e.g., %catheterization, Aorto%, %gram%). You can search for all
procedures belonging to a particular modality by selecting the modality
from the drop-down list and clicking SEARCH. To clear the search results,
click CLEAR CRITERIA.

You can sort the list by clicking on the column headers, or group the list
by dragging a column header to the area at the top of the list. To undo
the grouping, drag the column header back into the list area.

Crosswalk

Crosswalk allows operators to create associations between CPT and ICD-9
codes.

User Tables

There are eleven User Tables which you can customize to meet your
facility’s requirements:

1. Conditions;

2. Contrast;

3. FFRsite labels;

4.  Peripheral site labels;
5.  Physio site labels;
6. Probes;

7. Procedure Groups;
8. Races;

9. Resource Types;
10. Rhythms;

11. Subrhythms.
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4.19.1

4.19.2

4.19.3

To access the Table Editor, click TOOLS > TABLE EDIT, and select the table
with which you wish to work.

Conditions

For each modality, users can create a list of conditions that will be used to
sort procedural data and calculations. To create a list, first specify the
modality, then enter the condition name and click SAVE. The condition
lists will then be available to operators when performing or charting
procedures in a modality.

Contrasts

The Contrasts table contains the names of the x-ray contrasts that may be
used during an invasive procedure. The contrasts will appear on the Labs/
Procedure data of the Case Details screen (Contrast Type 1 and Contrast
Type 2).

To add a contrast, click ADD. This will create a new row in the list. Type in
the name of the contrast and click SAVE. The new description will be
added to the list in alphabetical order.

To edit an existing contrast, highlight it in the list and click EDIT. Make
your changes and click SAVE to accept or CANCEL to discard the change.

To delete a contrast from the list, highlight it and click DELETE. You will be
asked to confirm the deletion. Click YES to delete the entry, or NO to
cancel.

FFR Site Labels

The FFR Site Labels list is a list of vessels that will be used during invasive
procedures to indicate where an FFR sample is collected.

To add an FFR site label:

1. Click CLEAR CRITERIA to clear the fields.

2.  Enter the desired label in the FFR Site Description field (to display
correctly, labels must be twenty (20) characters or less).

3. Click SAVE.

To edit an existing site label, highlight the label in the list, make the
desired changes, and click UPDATE.

To delete a label, highlight it and click DELETE. Click YES to delete the
label, or NO to cancel the deletion.
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4.19.5

Peripheral Site Labels

The Peripheral Site Labels list is a list of peripheral pressure site labels
that will be used during invasive procedures to indicate where and what
type of pressure sample is collected when the peripheral site list is
checked. You may also select a color for the wave form.

To add a peripheral site label:

1.  Enter the desired label in the Peripheral Site Label field (to display
correctly, labels must be four characters or less).

2. Select a type from the Type drop-down list. Types include High/Low
(H, marks the single highest and lowest points on a wave form),
Arterial (A), Venous (V), and Ventricular (E).

3. Select a color.
4. Click SAVE NEW.

To edit an existing site label, highlight the label in the list, make the
desired changes, and click UPDATE.

Click CLEAR CRITERIA to clear the fields.

To delete a label, highlight it and click DELETE. Click YES to delete the
label, or NO to cancel the deletion.

Physio Site Labels

The Physio Site Labels list is a list of cardiovascular pressure site labels
that will be used during invasive procedures to indicate where and what
type of pressure sample is collected. You may also select a color for the
wave form and a default scale setting. The default scale setting will set
the pressure scale to the indicated level when the label is applied to the
pressure channel.

To add a physio site label:

1. Enter the desired label in the Physio Site Label field (to display
correctly, labels must be four characters or less).

2. Select a type from the Type drop-down list. Types include High/Low
(H, marks the single highest and lowest points on a wave form),
Arterial (A), Venous (V), and Ventricular (E).

3. Select a color.
4. Select a default scale setting.

5. Click SAVE NEW.
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4.19.6

To edit an existing site label, highlight the label in the list, make the
desired changes, and click UPDATE.

Click CLEAR CRITERIA to clear the fields.

To delete a label, highlight it and click DELETE. Click YES to delete the
label, or NO to cancel the deletion.

If you have configured your Xper Information Management to use a
language other than English, you may map the major cardiac sites with
their English equivalent. Labels available for mapping are:

Label Description

AO Aorta

AOp Aortic pullback

FA Femoral artery

IvC Inferior vena cava

LA Left atrium

Lv Left ventricle

Lvp Left ventricular pullback
PA Pulmonary artery

PAp Pulmonary artery pullback
PV Pulmonic vein

PW Pulmonary capillary wedge
PWp Pulmonary capillary wedge pullback
RA Right atrium

RAp Right atrial pullback

RV Right ventricle

RVp Right ventricular pullback
SvC Superior vena cava

Mapping pressure sites will enable Xper Information Management to use
the customized labels in calculations, such as stenotic valve area
calculation.

Probes

The Probes list is a list of thermodilution cardiac output catheters that
will be used when performing thermodilution cardiac outputs during a
procedure.
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4.19.8

To add a probe:
1. Enter a name (e.g., “S-Tip Swan Ganz”).
2. Enter the manufacturer’s indicated constant for the probe.

3. Enter the volume of injectate that will be used for each cardiac
output recording.

4. Enter the French size of the catheter.
5. Click SAVE.

To edit an existing probe, highlight the label in the list, make the desired
changes, and click UPDATE.

To delete a probe, highlight it and click DELETE. Click YES to delete the
probe, or NO to cancel the deletion.

Procedure Groups

The Procedure Groups table enables you to create groups for your
procedures (e.g., Diagnostic, Interventional, Urgent, Elective, etc.) and to
assign a priority (high, medium or low) to each group. The priority
assigned may be used as a filter for the Waiting List to identify those
patients whose procedures need to be performed as soon as possible
(high priority), or whose procedures are less urgent (medium and/or low
priority).

To add a procedure group:

1.  Enter the desired group name in the Group Description field.

2. Select a priority from the Priority drop-down list. Priorities include
High, Med (medium), and Low.

3. Click SAVE NEW.

To edit an existing description, highlight the procedure group in the list,
make the desired changes, and click UPDATE.

Click CLEAR CRITERIA to clear the fields.

To delete a procedure group, highlight it and click DELETE. Click YES to
delete the group, or NO to cancel the deletion.
Races

The Races table is a list of races that will be used during invasive
procedures to indicate a patient’s race or ethnicity on the Case Details
screen.
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To add a race, click ADD. This will create a new row in the list. Type in the
rhythm and click SAVE. The new description will be added to the list in
alphabetical order.

To edit an existing race, highlight it in the list and click EDIT. Make your
changes and click SAVE to accept or CANCEL to discard the change.

To delete a race from the list, highlight it and click DELETE. You will be
asked to confirm the deletion. Click YES to delete the entry, or NO to
cancel.

Resource Types

The Resource Types list is a list of specialities that can be assigned to user
types (Physician, Nurse, Circulate, etc.). The specialities will be available
for selection when adding resources to a study.

To add a speciality, click ADD. This will create a new row in the list. Type in
the description and click SAVE. The new description will be added to the
list in alphabetical order.

To edit an existing speciality, highlight it in the list and click EDIT. Make
your changes and click SAVE to accept or CANCEL to discard the change.

To delete a speciality from the list, highlight it and click DELETE. You will
be asked to confirm the deletion. Click YES to delete the entry, or NO to
cancel.

Rhythms

The Rhythms table is a list of heart rhythms that will be used during
invasive procedures to indicate a patient’s rhythm on the vitals screen.

To add a rhythm, click ADD. This will create a new row in the list. Type in
the rhythm and click SAVE. The new description will be added to the list
in alphabetical order.

To edit an existing rhythm, highlight it in the list and click EDIT. Make your
changes and click SAVE to accept or CANCEL to discard the change.

To delete a rhythm from the list, highlight it and click DELETE. You will be
asked to confirm the deletion. Click YES to delete the entry, or NO to
cancel.
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If you have configured your Xper Information Management to use a
language other than English, you may map atrial rhythms with their
English equivalent (i.e., Atrial Fibrillation or Atrial Flutter). When these
rhythms are used during a procedure, A-waves will not be marked on
atrial rhythmes.

Subrhythms

The Subrhythms table is a list of heart subrhythms that will be used
during invasive procedures to indicate a patient’s subrhythm complex on
the vitals screen.

To add a subrhythm, click ADD. This will create a new row in the list. Type
in the subrhythm and click SAVE. The new description will be added to
the list in alphabetical order.

To edit an existing subrhythm, highlight it in the list and click EDIT. Make
your changes and click SAVE to accept or CANCEL to discard the change.

To delete a subrhythm from the list, highlight it and click DELETE. You will
be asked to confirm the deletion. Click YES to delete the entry, or NO to
cancel.

Patient Billing

The Patient Billing screen allows you to review billing information for
patients, to perform necessary adjustments and transmit them. To access
Patient Billing, click MODULES > PATIENT BILLING.

The Patient Billing module allows you to search billing records using
many different parameters. The fields and their functions are listed in the
following table

Field Description

Patient Last Name Searches for billing records by patient last name.
MRN Searches for billing records by medical record number.
SSN Searches for billing records by social security number
Primary Physician Searches for billing records by primary physician.
Procedure Searches for billing records by procedure.

Account No. Searches for billing records by account number.

Case No. Searches for billing records by case number

Procedure Date From Enter a start date for a billing search.

Procedure Date To Enter an ending date for a billing search.
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Field Description

Report Format Select the report format you wish to print.

To perform a billing record search, enter all necessary parameters and
click SEARCH. All records that match the given parameters will be
displayed. To perform a different search, click CLEAR CRITERIA.

You may also review a patient’s charges for a procedure from within the
case. You can open a case directly from the Billing module by double
clicking on a charge under the patient’s name. When the case opens, click
HEMODYNAMICS > CASE TOOLS > PATIENT CHARGES. There will be a
check in the PR column next to charges that have already been
processed. If a charge has been processed and you apply a credit, the
check mark will move to the CR column, and the adjustment will be
processed by the billing interface.

Insurance Providers

The Insurance Provider screen allows you to enter data for insurance
companies that can then be matched with procedures when different
patient costs are required for individual insurance providers.

Creating and Maintaining a Providers List

Click TOOLS > INSURANCE PROVIDER. The fields and their functions are
listed in the following table:

Field Description

Health Insurance Enter the name of the insurance provider.
Company Name

Show Deleted When checked, previously deleted insurance
Providers providers will be displayed in the list.

Street Address Street address of the insurance provider.
City/Town City or town of the insurance provider.
Zip/Postal Code Zip or postal code of the insurance provider.

State/Province/County State, province or county of the insurance provider.

P.O. Box Post office box number of the insurance provider.
Country Country where the insurance provider is located.
Phone No. Phone number of the insurance provider.

Contact Name of the contact person at the insurance provider.
Email address Contact’s email address.

Fax No. Fax number of the insurance provider.
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Field Description

Web address URL of the insurance provider’s website.
Group No. Insurance plan group number.
Subscriber ID Insurance plan subscriber ID number.
Optional data 1 Optional notes field.

Optional data 2 Optional notes field.

Optional data 3 Optional notes field.

Optional data 4 Optional notes field.

Description Insurance plan description.

Plan Type 1 Insurance plan type.

Plan ID 1 Insurance plan ID.

Plan Type 2 Insurance plan type.

Plan ID 2 Insurance plan ID.

Tax ID Number Insurance plan tax ID number.

To enter a new insurance provider, enter the available data and click SAVE
NEW.

To update insurance provider information:

1. Double click the insurance provider in the list.

2. Enter the information.

3.  Click UPDATE to save the changes or CANCEL to discard them.

To delete an insurance provider, highlight the provider in the list and click
DELETE. The provider will be removed from the list, but you can view
deleted providers by clicking the checkbox labelled “Show Deleted
Providers.”

Assigning Providers to a Procedure

To assign multiple providers to a procedure:

1.  Open the Procedures table and select the procedure.

2. Select the provider from the Provider drop-down menu.

3. Enter the cost associated with that provider.

4. Click UPDATE.

5. Repeat steps 2 through 4 as necessary for each provider.

You may also assign multiple providers when adding a new procedure.
Either way, it is important that you first select the provider before
entering the patient cost.
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Assigning Providers to an Inventory Item

1. InInventory Overview, double click the item to which you want to
add providers.

2. Click EDIT.

3. Click the ellipse button ... next to Patient Cost.

4. Select the provider from the Providers drop-down menu.
5. Enter the patient cost.

6. Click SAVE NEW.

To ensure that a patient is billed with the correct amount for each item,
you must assign the correct insurance provider on the Additional Data
tab on the Case Details screen.

Case Report Configuration

The Case Report Configuration module allows you to create custom case
report formats which can be selected when printing a study. For example,
you may want one format for the Holding Area and a different format for
the preliminary procedure report. To access the Case Report
Configuration module, click SYSTEM > CASE REPORT CONFIGURATION.
The fields and their functions are listed in the following table.

Field Description
Description Enter the name of a new report configuration.
Add New Click to create the new report configuration.

Configuration list ~ Drop-down window contains the list of available report
configurations.

Delete Click to delete a selected report configuration.

Print column Check the box next to the report element you want to
include in a report configuration.

Report Lists the report elements that can be included in a report
Description configuration.
Qty (Quantity) Select the number of copies of a report element

To create a report configuration:
1. Enter a name in the Description window.

2. Click ADD NEW. The name will appear in the Configuration window
below.
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3. Select the elements you want to include in the report configuration
by checking the box next to the element name.

4. You may set the number of copies of a given report element by
adjusting the quantity.

5. You may specify the number of copies of a report by setting the
Collated Copies quantity.

6.  Click SAVE.
To change the order in which report elements will print, highlight an
element and use the Up or Down arrows at the top right corner of the list

to adjust its position. The report elements and their descriptions are
listed in the following table.

Report Element Description

ACC Prints the ACC Registry screens.

Arterial Tree Prints any arterial trees generated during a case.

Blood Gases Prints any blood gases worksheets generated during a
case.

Case Details Prints all elements of the Case Details and Labs/

Procedure Data screens.

Case Synopsis Prints a report of all charted elements sorted by menu
title.

Charge Sheet Prints the list of charges generated during a procedure.

Custom Screens Prints the custom data forms for a case.

Hemodynamics Prints a report for each hemodynamic condition

recorded in a case.
ICD Prints the ICD Registry screens.
Procedure Log Prints the chronological procedure log for a case.

Sedation Flowsheet Prints the Sedation Flowsheet format of the vitals record.

Valve Prints any valve gradient samples performed during a
procedure.
Still Frames Prints any still frames captured during a case ina 2 x 2

table format.
Vitals Prints the vitals record for a case.
Wave Forms Prints recorded samples, one sample per page.
Wave Forms 6 on 1 Prints recorded samples, six to a page.

Collated Copies Specifies the number of collated reports to be printed.
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NOTE

If you wish to create an additional configuration, type a name in the box
and click ADD NEW. The previously created configuration will be saved. To
exit without saving a report configuration, click CANCEL ALL and close the
screen. Any configurations you have created in the session will be
deleted.

Level of Consciousness/Level of Pain

The Level of Consciousness and Level of Pain lists are used on the
Sedation Flowsheet to indicate a patient’s level of consciousness and
pain. You may customize these lists by clicking SYSTEM >
CONFIGURATION SETTINGS. Access the Modules tab and select LOC/LOP.
You man then add codes and descriptions. When the Auto LOC Prompt
and Auto LOP Prompt are active during monitoring, users may select an
entry from the drop-down lists. The selections will be entered in the
appropriate columns on the Sedation Flowsheet. To delete an entry,
highlight it and click DELETE.

To add an entry to the LOC or LOP list:

1. Click ADD to insert a blank row;

2.  Enter the desired data in the following format: code = description
(e.g., A= Alert and oriented);

3. Click outside of the new row.

You may sort the LOP list by using the up and down arrows to move
entries.

Patient Historical Links

When a patient has had multiple studies performed at a facility, those
studies may be linked so that the historical cases are available for review
when a new study is started. To configure historical links:

1. Click SYSTEM > CONFIGURATION SETTINGS.

2. Access the Modules tab and select Cases.

3. Check the desired criteria to create historical links.

MRN is the default setting and may only be unchecked when another item is selected,
Be careful when selecting different historical criteria. Selecting only one (e.g., middle

name) will link ALL cases in which there is a match. It is recommended that you use a
minimum of three criteria to create historical links.
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Once your criteria are established, a patient’s historical cases will be
listed on the History tab on the Case Details screen.

Multiple Performed Procedure Steps (MPPS)

Some x-ray systems are capable of sending multiple performed
procedure steps (MPPS) information. If your x-ray system sends MPPS,
you can configure Xper Information Management to display up to 25
selected MPPS messages during a procedure. To configure MPPS:

1. Click SYSTEM > CONFIGURATION SETTINGS.

2. Access the Miscellaneous tab and select HL7 / Interface.

3. Select a desired field from the Standard Data Fields drop-down.
4.  Click ADD.

5. If you want to display a custom data field from your x-ray system,
enter the x-ray system’s field name in Custom Data Field and click
ADD.

6. You may change the order in which the information is displayed by
using the up or down arrows to change the field order.

7. Toremove a field, highlight it in the list and click REMOVE.
During the procedure, the x-ray system will send MPPS data through the

Xper Connect interface. Selected fields will be displayed on the MPPS tab
on the Case Details screen.

Patient Assignment

For accounts that have integrated this system with Xcelera, the Patient
Assignment module allows users to merge studies admitted to this
system with cineangiography studies from Xcelera. To merge a patient:

1. Click MODULES > PATIENT ASSIGNMENT;

2. Select an unplaced patient from the Unplaced Studies list and click
CREATE PATIENT FOLDER (if a folder already exists for the selected
patient, skip to merging additional patients);

3. Enter any necessary data and click ADD NEW PATIENT. The selected
patient will be removed from the Unplaced Studies list.

To merge additional unplaced patients to an existing patient folder:

1. Select the additional study in the Unplaced Studies list;
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2. Select the patient folder to which the unplaced study should be
merged;

3. Click MERGE STUDIES to merge a study and to remove the study
from the Unread Studies and/or Patient Locator list;

4.  Click MERGE STUDY WITH THE FOLLOWING PATIENT FOLDER to
merge a study, but without removing it from the Unread Studies
and/or Patient Locator list.

To unlink a merged study:

1. Open the desired patient folder;

2. Highlight the study you wish to remove;

3. Click UNLINK THE FOLLOWING PATIENT STUDY.

Repositories

A repository is essentially a filter applied to menus, procedure lists, and
patient studies. Repositories allow you to separate your patients into
categories (e.g., Pediatrics, Adult, Radiology, etc.) and to maintain
separate charting menus, inventories, and procedures for each repository
within the main Xper Information Management database.

Every Xper Information Management system has a default repository. To
create additional repositories:

1.  Click SYSTEM > ADMIN > REPOSITORY MAINTENANCE.
2. Enter a three-character abbreviation and a description.

3. Enter a facility name, if desired. The facility name that corresponds
to a repository will print on case report headers and footers.

4. Click INSERT.

The new repository will now be available. Access to repositories must be
assigned to each user through the User Administration screen. When
users log on, a Repository drop-down list will be available. Users will see
only the repositories to which they have been assigned access.

Once a user has logged into a repository other than the default, the
repository abbreviation will appear next to the user name to indicate
which repository the user is logged in.

Each repository may have its own menus, inventory and list of
procedures. Studies admitted to a repository will only be accessibly when
logged in to that repository.
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5 Preventive Maintenance

5.1  Monitor Mounting INtegrity.....cccceeevvevvvvviiiieereieieiiiiceee e,

5.2 Monthly Maintenance
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Monitor Mounting Integrity

On a monthly basis, confirm monitor mounting integrity, including, but
not limited to, boom assembly mounts, wall mounts, and rolling stand
mounts.

Monthly Maintenance

On all Xper Information Management stations:

Perform Scandisk.
Perform Defrag.
Clear all Windows event log files.

Delete the contents of C:\XIMS\LOGS (excluding Xper Connect,
DataCenter, and Central Station).

Delete the contents of X:\datacenter\bin\logs (DataCenter only).
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6.2.2

6.2.3

Full System Reset

To perform a full system reset:
» Power the front end off and back on.

» Terminate the Xper Information Management application on the
workstation.

e Click START > SHUTDOWN > RESTART. Allow the workstation to reboot
into Windows.

» Log on to the workstation. If necessary, relaunch the application (it
may be set to relaunch automatically).

If problems still persist after a full system reset, contact Customer
Support.

Troubleshooting Power and Video Issues

No Power to Workstation
e Turn device on. If no response:

e Check power cord connection to the back of the unit and to the wall
receptacle.

« If the workstation will still not power on, contact Customer Support.

No Power to Monitor
e Turn monitor on. If no response:

» Check power cord connection to the back of the unit and to the wall
receptacle.

« If the monitor will still not power on, contact Customer Support.

No Display on One Monitor

If a monitor is on, but there is no display:

» Verify workstation is powered on.

e Check video cable connections on the monitor and workstation.

« If there is still no display, contact Customer Support.

If one monitor displays images, and another monitor does not:

» Verify the monitor is powered on.
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NOTE

* Swap video cable between the monitor displaying images and the
blank monitor. If the blank monitor displays an image, change the
video cable.

 If the monitor does not display an image after swapping the video
cables, contact Customer Support.

Troubleshooting Audio

If an alarm condition is displayed on the monitor, but no audible tone is
heard:

« Verify the speakers are powered on.
* Verify the volume is turned up.
» Verify the audio is not muted.

« |f the speakers are external, verify the audio cable is connected to the
correct jack (see section 2.3 ‘Warnings, Cautions and Notes’ for
assistance in identifying the audio jack).

« |f audio is not restored, contact Customer Support.
Troubleshooting Network Connection

When a workstation cannot connect to the network, a “Netfail” message
will be displayed in red. To reconnect to the network:

* Hold down the CTRL key and hit F10. When prompted, click YES to
reconnect to network.

o If connection is not restored, check the network cable. Make sure it is
connected to the network card in the workstation PC and to the
correct network wall outlet. It may be necessary to restart the
workstation to restore network connection.

e Check to see if other Xper workstations have network connectivity. If
not, your Datacenter may be down. Contact your facility’s IT
department, or contact Customer Support.

If network connectivity cannot be restored, you can still continue with a study. Data
such as charting, vital signs and waveform samples will be stored on the local
workstations, and will be automatically uploaded to the server when network
connectivity is restored. However; remote stations, such as the Nurse Station or
Central Station, will not be able to display or control patient monitoring and vitals
data if no network connectivity is available.
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Monitoring Control Screen

The Monitoring Control Screen has one error message that will display on
the Patient Monitoring screen if an error is detected.

e Error Message: OFF

This message indicates that communication with the front end device has
been lost. Verify the front end is powered on. Check for airflow from the
fan at the back of the unit. Make sure the power cord is tightly
connected. If the cord is properly connected but you can’t feel airflow or
hear the fan, contact Customer Support. If there is airflow, use the
Windows Shut Down routine to restart the Xper workstation. If signals
are still not restored, contact Customer Support.

Customer Support Contact Information

For assistance with your Xper Information Management system, please
contact your local Philips Healthcare representative.

In the U.S. and Canada, contact Philips Healthcare Customer Support:
+1.800.669.1328
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Disposal

Philips Healthcare is concerned to help protect the natural environment,
and to help ensure continued safety and effective use of this product
through proper support, maintenance and training. Therefore, Philips
products are designed and manufactured to comply with relevant
guidelines for environmental protection. As long as the product is
properly operated and maintained, it presents no environmental risks.
However, the product may contain material(s) which could be harmful to
the environment if not disposed of properly. Use of such material(s) is
essential to performing the functions of the product and to meeting
statutory and other requirements.

This section of the Instructions for Use is directed mainly at the user/
owner of the product.

These devices are computer based electronic equipment whose
components contain materials that may be harmful to the environment if
not disposed of properly.

Effective August 13, 2005, the European Union’s WEEE (Waste Electrical
and Electronic Equipment) Directive requires that the Producer
(Importer) provide financing for the collection, treatment, recovery and/
or environmentally sound disposal of all electrical and electronic
equipment. The WEEE Directive applies to these devices and additional
fees will be added to the cost of each device that is introduced into the
European Union, after the effective date, in order to offset the cost of
recovery.

Passing the Product to Another User

If this product passes to another user, it must be in its complete state,
including all product supporting documentation. Make the new user
aware of the support services that Philips Healthcare provides for
installing, commissioning and maintaining the product.

Before passing on the product or taking it out of service, all patient data
must be backed up elsewhere, if necessary, and must be unrecoverable
and deleted on the product.

It must be remembered by all existing users that passing on medical
electrical products to new users may create serious technical and legal
(e.g., privacy) risks. Such risks can arise even if the product is given away.
Existing users are strongly advised to seek advice from their local Philips
Healthcare representative before committing themselves to passing on
any product. Alternately, contact the manufacturer.
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7.1.2

WARNING

7.1.3

Once the product has been passed on to another user, a previous user
may still receive important safety-related information, such as bulletins
and field change orders. In many jurisdictions, there is a clear duty on the
previous user to communicate such safety-related information to new
users. Previous users who are not able or prepared to do this should
inform Philips Healthcare about the new user, so that PMS can provide
the new user with safety-related information.

Final Disposal of the Product

Final disposal is when the user disposes of the product in such a way that
it can no longer be used for its intended purpose.

Philips supports users in:
* Recovering reusable parts;
« Recycling of useful materials by competent disposal companies;

« Safe and effective disposal of product.

For advice and information, contact your Philips Service Organization
first, or alternately, the manufacturer.

/N

Do not dispose of any part of this product with industrial or domestic waste. The
product contains hazardous materials which require special disposal. Incorrect
disposal of any of these materials may lead to serious environmental pollution.

REACH

REACH requires Philips Healthcare (PH) to provide chemical content
information for Substances of Very High Concern (SVHC) if they are
present above 0.1% of the article weight. Components within electric and
electronic equipment may contain phthalates above the threshold bis(2-
ethyl(hexyl)phthalate) commonly referred to as DEHP, CAS nr.: 117-81-7.
The SVHC list is updated on a regular basis. Refer to the following Philips
REACH website for the most up-to-date list of products containing SVHC
above the threshold:

http//www.philjps.com/about/sustainability/reach.page
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8 Technical data
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8.2  Specifications
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8.1 System Description

The system contains a number of modules that collect and process cath
lab clinical and administrative information, making it a powerful data
management tool.

8.2 Specifications

The tables below represent the minimum specifications for the devices
described. It is not recommended that Xper Information Management be
installed on devices that do not meet the minimum specifications.

8.2.1 Xper Information Management Workstation
Specification Value
Hardware Processor: Intel Pentium IV 3.0 GHz with hyper-threading,

(minimum specifications)  or equivalent
Operating System: Microsoft Windows
Memory: 2 GB
Hard Drive: 80 GB
CD/DVD: DVD reader (read only)
Video: 1280x1024 res., 24/32-bit color (optional dual head
DvI)
Network Adapter: 10/100/1000 (may have multiple)

8.2.2 File Server
Specification Value
Hardware Processor: Dual core 1.6 GHz
(minimum specifications)  Operating system: Microsoft Windows Server

Memory: 4 GB

Hard Drive: 500 GB (may be RAID array)

CD/DVD: DVD reader (read only)

Onboard video, 800x600 resolution, 16-bit color minimum
10/100/1000 onboard network adapter

500 GB RAID 5 array
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8.2.3 Hospital Interface Broker

Specification Value

Hardware Processor: Dual core 1.6 GHz

(minimum specifications)  Memory: 2 GB
Hard Drive: 80 GB
Video: 800x600 resolution, 16-bit color minimum
Network Adapter: 10/100/1000 (minimum 2)
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9  Appendices
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9.1.1

Hemodynamic and Lab Value Conversion
Calculations

Hemodynamic Calculations

The following equations for the calculation of hemodynamic parameters
are taken from William Grossman’s Cardiac Catheterization and
Angiography, 3rd Ed., Philadelphia: Lea & Febiger, 1986.

Body Surface Area (BSA):

e BSA (m?) =0.007184 * weight %4%ke * hejght 0-725cm
Assumed 02 uptake:

e O, (assumed) = K * BSA (K derived from LaFarge table)

Where 133 is a sample value that will be input from the LaFarge tables, as
published by LaFarge CG, Miettinen OS: The estimation of oxygen
consumption, Cardiovascular Research 4:23, 1970.

In addition to the values derived from standard formulas, the Xper
Information Management and Physiomonitoring system contains a
number of computer calculated values, such as dp/dt, Vpm, Vmax, valve
mean gradient, and valve period that are the result of digital wave form
analysis. Their values are more the result of definition than equation.

Oxygen Content:
e m10,/LBlood=Hgb *1.36 * 10 * % Saturation
Systemic Venous O, (Flamm’s Equation):

¢ SVO, =(3(SVCO,)+1(IVC0,))/4

Oxygen Saturation Pressure Location Priority
Systemic Venous O,/Pressure RA (right atrium)*
RV (right ventricle)
IVC + SVC (Flamm’s equation)
IVC (inferior vena cava)
SVC (superior vena cava)
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Oxygen Saturation Pressure Location Priority

Systemic Arterial O,/Pressure FA (femoral artery)*
AO (aorta)
LV (left ventricle)
LA (left atrium)

Pulmonary Venous O,/Pressure PV (pulmonary vein)*
PW (pulmonary capillary wedge)
LA (left atrium)
LV (left ventricle)
AO (aorta)

Pulmonary Arterial O,/Pressure PA (pulmonary artery)*
RV (right ventricle)
RA (right atrium)
SVC (superior vena cava)

*Default locations used for pressure/saturation priority

If RA, RV, or PA saturation is collected and is lower than the result
produced using Flamm’s equation, the lowest saturation is used for
systemic venous O,
A-V 0, difference:

e A-VO, = systemic arterial O, content - systemic venous O, content
V-A O, difference:

e V-A O, = pulmonary venous O, content - pulmonary arterial O, content
V-V O, difference:

e V-V O, = pulmonary venous O, content - systemic venous O, content
Pulmonary flow:

« Pulmonary flow (Qp) = Assumed O,/(PV O, content - PA O, content)
Systemic flow:

« Systemic flow (Qs) = Assumed O,/(SA O, content - SV O, content)

Effective flow:

« Effective flow (Qe) = Assumed O,/(PV O, content - SV O, content)
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NOTE

Cardiac Index:

« CO/BSA

Fick Cardiac Output:

e CO;=Assumed O,/(A -V O, difference)

If CO_1 is set to Fick cardiac output or if CO_1 and CO_2 have no value,
saturation data will take precedence over other cardiac output data in
the calculation of flows, shunts, and resistances.

Left to right shunt:

e L>R(L/min) = Pulmonic Flow Qp - Effective Flow Qe

Right to left shunt:

e R> L (L/min) = Systemic Flow Qs - Effective Flow Qe

Shunts will be calculated if sufficient saturation data is present and an

oxygen saturation step of 3% to 7 % occurs, depending on the location of
the step up in oxygen content.

Oxygen Step Limits
Chamber Locations Significant O, Step
SVC to RA 7% step in O, content
RA to RV 5% step in O, content
RV to PA 3% step in O, content
PV to LA 5% step in O, content
Other locations 5% step in O, content

Shunts that constitute less than a 10% flow difference are not reported unless a
custom shunt threshold is set.

Pulmonary Vascular Resistance:

Dynes units (sec/cm?):

e PVR = ((Mean PA Pressure - Mean PV Pressure)/Pulmonary Flow Qp) * 80
Woods units (HRU):

e PVR =(Mean PA Pressure - Mean PV Pressure)/Pulmonary Flow Qp
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NOTE

Systemic Vascular Resistance:

Dynes units (sec/cm?®):

e SVR = ((Mean SA Pressure - Mean SV Pressure)/Systemic Flow Qs) * 80
Woods units (HRU):

e SVR = (Mean SA Pressure - Mean SV Pressure)/Systemic Flow Qs
Total Systemic Vascular Resistance:

Dynes units (sec/cm?®):

e TSVR = (Mean SA Pressure/Systemic Flow Qs) * 80

Woods units (HRU):

e TSVR = Mean SA Pressure/Systemic Flow Qs

Total Pulmonary Vascular Resistance:

Dynes units (sec/cm?®):

e TPVR = (Mean PA Pressure/Pulmonary Flow Qp) * 80

Woods units (HRU):

e TPVR = Mean PA Pressure/Pulmonary Flow Qp

Stroke Work Index:

e SWI=(13.6 * CO, * LVg5r0uc)/(HR * BSA)

Valve Area (mean gradient):

« A(cm?)=(CO/ (HR * PRD in seconds))/(K * ./meangradient)

Where:

1. 1. The valve constant K = 37.7 for the mitral valve and K = 44.3 for

the aortic, pulmonic, and tricuspid valves, and

2. 2. Stroke volume is defined by CO / (HR * PRD (seconds).

Cardjac Output is in millilicers (mi).
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9.1.2

Fractional Flow Reserve:

« FFR=(P,-P,)/(P,-P,)
Where:

= mean distal pressure

mean aortic pressure
= mean venous pressure

PD
PA
I:)V
Contrast Total Max field (Case Details screen):

o Contrast Total Max = 5cc x Kg of body weight/creatinine
Creatinine Clearance (Cockcroft-Gault formula for GFR estimate):

e Male GFR =((140 - age) x (weight)) / (sCr x 72)

e Female GFR = ((140 - age) x (weight)) x 0.85 / (sCr x 72)

Lab Value Conversions

The following equations for the conversion of lab values from standard
American units to standard international (SI) units are taken from
“Implementation of S| Units for Clinical Laboratory Data,” Donald S.
Young, M.B., Ph.D., Annals of Internal Medicine, Vol. 106; No. 1, January
1987.

Blood Urea Nitrogen, mmol/|

e (BUN mg/dl) x 0.357

Creatinine, umol/I

e (Creat mg/dl) x 88.4

Creatinine Clearance, ml/s

e (Creat. clearance ml/min) x 0.0167

Glucose, mmol/I

e (Glu mg/dl) x 0.0555

Hematocrit, %

e (Hct) x0.01
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Hemoglobin, g/I:
e (Hgbg/dl)x 10
Hemoglobin, mmol/I:

e (Hgb g/dl) x 0.6206
9.2 Monitoring Site Abbreviation Definitions

The following is a list of cardiac and peripheral vessel and chamber labels
used in Xper Information Management.

Abbreviation Definition

AAO Ascending aortic artery

AO Aortic artery

AOm Aortic artery monitoring

AOp Aortic artery pullback pressure
AOpo Aortic artery pullback outflow
AoRt Aortic root

Art Arterial pressure

Atrm Atrium

Azyg Azygous vein

BLAL Blalock, Taussig

C/s Coronary sinus

ComV Common venous

Cond Conduit

Cuff NIBP Cuff pressure

DAO Descending aortic artery

DLPA Descending left pulmonary artery
DMPA Descending mid pulmonary artery
DRPA Descending right pulmonary artery
FA Femoral artery

FAC Femoral artery compensation

Fv Femoral vein

GLEN Glenenatimosis

HepV Hepatic vein

HIVC High inferior vena cava

HLA High left atrium

HRA High right atrium
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Abbreviation
HRV
HSvVC
InnV
IVC
LA
LAXA
LBA
LCA
LCCA
LCIA
LEIA
LFA
LFvV
L
LIivC
LLA
LLPA
LLPV
LPA
LPOP
LPV
LPW
LRA
LRNA
LRV
LSCA
LsvC
LUPA
LUPV
v
LVA
LvO
LVp
LVpo
MIVC
MPA
MPV
MRA
MSvC

Definition

High right ventricle

High superior vena cava
Innominate vein

Inferior vena cava

Left atrium

Left auxiliary artery

Left brachial artery

Left coronary artery

Left common carotid artery
Left common iliac artery
Left internal iliac artery

Left femoral artery

Left femoral vein

Left internal jugular vein
Lower inferior vena cava
Lower left atrium

Lower left pulmonary artery
Lower left pulmonary vein
Left pulmonary artery

Left popliteal artery

Left pulmonary vein

Left pulmonary wedge
Lower right atrium

Left renal artery

Lower right ventricle

Left subclavian artery

Lower superior vena cava
Left upper pulmonary artery
Left upper pulmonary vein
Left ventricle

Left ventricular apex

Left ventricular outflow

Left ventricular pullback pressure
Left ventricular pullback outflow
Mid inferior vena cava

Mid pulmonary artery

Main portal vein

Mid right atrium

Mid superior vena cava
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Abbreviation
PA

PAp

PLPA

PMPA

PRPA

RRNA
RSCA
RSVC
RUPA
RUPV
RV
RVOT
RVp

Xper Information Management System Release 2-1

Definition

Pulmonary artery

Pulmonary artery pullback pressure
Proximal left pulmonary artery
Proximal mid pulmonary artery
Proximal right pulmonary artery
Pulmonary track

Pulmonary vein

Pulmonary venous wedge
Pulmonary wedge

Pulmonary wedge pullback pressure
Right atrium

Right atrial pullback pressure
Right arterial

Right auxiliary artery

Right brachial artery

Right coronary artery

Right common carotid artery
Right common iliac artery
Right external iliac artery

Right femoral artery

Rlght femoral vein

Right hepatic vein

Right internal carotid artery
Right internal jugular

Right internal jugular vein

Right lower pulmonary artery
Right lower pulmonary vein
Right pulmonary artery

Right popliteal artery

Right pulmonary vein

Right pulmonary wedge

Right renal artery

Right subclavian artery

Right superior vena cava

Right upper pulmonary artery
Right upper pulmonary vein
Right ventricle

Right ventricular outflow tract

Right ventricular pullback pressure
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Abbreviation Definition

SMV Superior mesenteric vein
SpO2 Pulse oximetry site
SPV Splenic vein

SubC Subcutaneous

SvC Superior vena cava
SysV Systemic venous
UA Umbilical artery
uv Umbilical vein

Ven Venous

Vent Ventricular

VenV Ventricular venous
w Venous ventricle

9.3 LaFarge Table

Reprinted from Cardiovascular Research 1970, 4, p. 27.

Age Heart Rate (beats per minute)
50 60 70 80 90 100 110 120 130 140 150 160 170

Males
3 155 159 163 167 171 175 178 182 186 190
4 149 152 156 160 163 168 171 175 179 182 186
6 141 144 148 151 155 159 162 167 171 174 178 181
8 136 141 145 148 152 156 159 163 167 171 175 178

10 130 134 139 142 146 149 153 157 160 165 169 172 176
12 128 132 136 140 144 147 151 155 158 162 167 170 174
14 127 130 134 137 142 146 149 153 157 160 165 169 172
16 125 129 132 136 141 144 148 152 155 159 162 167

18 124 127 131 135 139 143 147 150 154 157 161 166

20 123 126 130 134 137 142 145 149 153 156 160 165

25 120 124 127 131 135 139 143 147 150 154 157

30 118 122 125 129 133 136 141 145 148 152 155

35 116 120 124 127 131 135 139 143 147 150

4 115 119 122 126 130 133 137 141 145 149

Females
3 150 153 157 161 165 169 172 176 180 183
4 141 145 149 152 156 159 163 168 171 175 179
6 130 134 137 142 146 149 153 156 160 165 168 172
8 125 129 133 136 141 144 148 152 155 159 163 167
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Age
10
12
14
16
18
20
25
30
35
40

NOTE

118
115
112
109
107
106
102
99
97
94

Xper Information Management System Release 2-1

122
119
116
114
111
109
106
103
100
98

125
122
120
118
116
114
109
106
104
102

129
126
123
121
119
118
114
110
107
105

Heart Rate (beats per minute)

133
130
127
125
123
121
118
115
111
109

136
133
131
128
127
125
121
118
116
112

141
137
132
132
130
128
125
122
119
117

144
141
133
136
134
132
128
125
123
121

148
145
143
140
137
136
132
129
127
124

152
149
146
144
142
140
136
133
130
128

155
152
150
148
146
144
140
136

159
156
153
151
149
148

The LaFarge table is not intended to be used for patients over 40 years of age.

163
160
157
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